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1 Introduction 

Record and process requests quickly and efficiently with Helpdesk for CAS genesisWorld. 

Whether a customer establishes contact by phone, by e-mail or via the integrated web 

client is immaterial. All requests are recorded quickly and consistently. Ticket pools and 

ticket delegation are supported as well as an automated internal and external notification. 

The support portal Helpdesk online not only enables activated users to submit requests 

online but also provides them with a status overview for entered requests at any time. In 

addition, a public FAQ search is available here which can also be used for file downloads. 

You can control the contents comfortably and transparently via CAS genesisWorld. 

Service agreements determine your customers' entitlement to benefits as well as the 

coverage of your service costs. With Helpdesk's contract management, you document the 

product uses and individual agreements you have made with your customers including 

service levels, response times and contact persons. 

Time recording for all services and associated reports per customer, project and ticket 

guarantee a complete overview of your service management costs. 

1.1 Feature overview 

 The Desktop Client offers the full range of features. 

 Ticket management in CAS genesisWorld 

 FAQ management and powerful search in tickets and FAQ documents 

 Process management and communication via actions, e-mail templates, as well as 

internal and external automatic notfication 

 Product use and service agreement management with maintenance billing (actual 

invoicing additionally requires the Easy Invoice module) 

 Block support entitlement in all clients for companies and single contacts 

 Time recording in the background or afterwards and versatile analysis 

 Registered partners and customers may access the Helpdesk online portal. 

 Support portal with overview of all requests, online submittal and FAQ search 

 Distinction of internal and published FAQ documents for customers' online access 

 Users with sufficient rights can also access most features in the Web Client. 

 Service agreements, product uses, tickets and time records 

Additionally, the Team planning app, Timeline view and Board view are available for 

visual planning in the Web Client. 

The descriptions herein refer to the Desktop Client unless indicated otherwise. 
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1.2 Specifics with modules and integrations 

When using Helpdesk, you have to consider certain specific characteristics in combination 

with other modules and integrations. 

The most important features and limitations are described where they apply in this user 

guide, especially specifics when using CAS genesisWorld Web. 

For an overview, see the Helpdesk page under Working with several modules in the 

English version of hilfe.cas.de. 

https://hilfe.cas.de/CgW/en/Mehrere_Module_einsetzen/index.htm#mme_helpdesk_und_andere.htm
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2 Ticket management 

The following sections describe the default features for tickets in the Desktop (2.1 to 2.6) 

and Web Clients (2.7). 

 2.1 Views and features for tickets (page 9) 

 2.2 Creating tickets (page 10) 

 2.3 The data record window for tickets (page 11) 

 2.4 Ticket actions (page 23) 

 2.5 Blocking support entitlement (page 36) 

 2.6 Setting up access for Helpdesk online (page 37) 

 2.7 Tickets in the Web Client (page 40) 

Helpdesk online is described in chapter "10 Helpdesk online" on page 126. 

2.1 Views and features for tickets 

Tickets are jobs of certain types. The associated fields and features will be displayed in the 

job's data record window when a ticket type is selected. 

The following standard features are available for tickets. 

 Data record window for jobs; the General tab is replaced by the Ticket tab. When a 

job's type is changed so it becomes a ticket or isn't a ticket anymore, field contents that 

have already been provided are retained. 

 Type for marking as ticket 

 Status for the support process 

 Primary links to address, project and job, displayed in the tree view (with ticket 

icon) and in analyses 

 General links to any other data records 

 Creation with ticket type via the toolbars of the data record windows and list views for 

addresses, phone calls, e-mails and projects 

 Global search in all fields such as Subject, Customer and Submitter, configurable via 

Settings > Search; separate FAQ search for FAQ documents and tickets 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 
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2.2 Creating tickets 

You can create tickets for addresses, phone calls, e-mails and projects. 

Settings referred to here can be found in the Helpdesk area of the Management Console. 

 Create new ticket: By clicking this button in the toolbar of a data record window or a 

list you create a ticket for the selected data record. 

 Tickets for customers: For every ticket you create for an address, phone call or e-mail, 

the address for which it was created or the primary address of the associated phone call 

or e-mail will be entered as Submitter. 

The Customer link will initially be set to the associated company (alternatively, the 

submitter may also be entered as customer, see Allow tickets and service contracts 

for contact persons; adopt submitter as customer in ticket on top of page 151). 

The submitter's company will also be entered as the new ticket's primary address. Its 

primary project is set to a support project which will be created to this end if it doesn't 

already exist. This project serves as a tree view container for all tickets submitted by the 

same company. 

If required, you may change the Customer as Submitter links in the ticket. 

 Tickets for phone calls: A ticket created for a phone call will inherit the phone call's 

subject in its Subject and Request fields. The phone call's notes will be entered in 

the Internal notes or Notes field, depending on your settings (see top of page 150). 

A primary link will be created between the phone call and the associated ticket. This 

way, the phone call will be displayed in the ticket's tree view and vice versa. 

 Tickets for e-mails: A ticket created for an e-mail will inherit the e-mail's subject in 

its Subject field. The e-mail body will be entered in the Internal notes or Notes 

field, depending on your settings. For e-mails, you can also choose to enter the 

subject or body in the ticket’s Request field (see top of page 150). 

A primary link will be created between the e-mail and the associated ticket. This way, 

the e-mail will be displayed in the ticket's tree view and vice versa. 

As the sender of an e-mail isn't always known, you may admit tickets for e-mails 

without a primary address. In this case, the submitter, customer and primary links 

stay blank (see Submitter link to ticket must exist in the middle of page 150). 

 Tickets for projects: A ticket created for a project will adopt the project's Subject as 

Subject and Request. 

The project will be entered as the ticket's primary project. This way, the ticket will also 

inherit the project's primary address and will therefore be displayed in the tree views of 

both the project and its primary address. 

The project's primary address will initially also be entered as the ticket's Submitter.  

The associated company will initially be entered as the ticket's Customer. 
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2.3 The data record window for tickets 

The following sections describe the fields and features for recording tickets in the Ticket 

and Details tabs of the data record window for jobs. 

2.3.1 Ticket 

You can disable features you don't use in the Management Console under Helpdesk > 

General (see page 152). 

By default, the Use automatic time recording for tickets and Display service 

agreement features are turned off. 

 

 Subject: Tickets created manually for projects, phone calls or e-mails will adopt the 

subject of the project, phone call or e-mail as Subject and as Request. 

Tickets created automatically for inbound e-mails sent to the support account also 

adopt the e-mail's subject in the Subject and Request fields (see "12.6 Setting up a 

support e-mail account" on page 218).  
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In tickets created manually for addresses, the Subject and Request fields are initially 

empty. As long as the Subject field is empty, your input in the Request field will 

automatically be entered as Subject as well. 

Submitters creating tickets via Helpdesk online will be prompted for a Subject in 

addition to the actual Request. Both fields are mandatory in Helpdesk online. 

 Duration: For tickets created during hotline hours (according to the settings for the 

selected priority and service agreement or default settings when no service agreement 

applies), the current time will be entered as start and end. The same applies when you 

are not using service agreements. 

For tickets created outside of hotline hours, the start and end will be shifted to the next 

applicable hotline hours segment (e.g., a ticket created on Friday at 7 pm in Helpdesk 

online will start at 8 am the following Monday if that is the next start of hotline hours). 

When you save a ticket with a completion status, the end will be set to the current time. 

If this leads to the end being before the start, the end will be set to equal the start 

when saving the ticket. 

 Last change of status: Here you see the most recent change of status. 

With the Helpdesk module, whenever a ticket or another job is created as well as when 

one of the Status, Priority, Employee, Team, Responsible employee or Responsible 

team fields is changed in a ticket or another job, an individual data record of the 

Status change type will be created and linked to the associated ticket or job. 

With the Report module, you can analyze status changes in the context of the 

associated jobs or separately. 

 Start: time of the ticket's creation or the last change of status 

 End: time of the change of status 

 Status start / end: status before and after the change 

 Priority start / end: priority before and after the change 

 Employee, team, responsible employee, responsible team start / end: 

participants and groups before and after the change 

 Duration (calendar days): days between start and end 

 Duration (service hours): support availability during the total duration in hours. 

Only hotline hours according to the service agreement are considered. For tickets 

without a service agreement, the default settings are used (see "11.2.4 Service 

agreements" on page 174). 

Note 

Please note that users with a Helpdesk license or another license that unlocks Helpdesk 

features (e.g., IT Services) need at least the Insert right for the Status changes data 

record type in addition to the required job rights in order to save jobs. 
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 Respond until: Here you see the response deadline for the ticket. It will be set 

according to the ticket's Priority. Before the ticket has been responded to (as long as 

the Responded on field is empty), when you select a priority level, the associated 

response deadline will be calculated using the following data.  

 Response time and hotline schedule by priority. 

 Country and federal state of which public holidays should be considered. 

These data are taken from the selected service agreement. 

If no service agreement is selected, the response deadline will be derived from the 

settings for tickets without a service agreement in the Management Console (Helpdesk 

> Service agreements). 

This is also the case if submission permissions have been entered for a service 

agreement and the ticket's submitter has not been entered as a contact person in the 

service agreement. 

The response deadline will be shifted by one calendar day for each day entered in the 

response time. Calendar days without hotline hours will be skipped. 

 For example, hotline hours have been entered from Monday to Friday. A ticket is 

submitted on Friday. The response time entered in the service agreement for the 

ticket's priority spans 3 days. This results in a response deadline of next Wednesday, 

as Saturday and Sunday are skipped. 

Hours and minutes specified in the response time shift the response deadline by the 

same number of hours and minutes within the hotline hours. Any hours and minutes 

outside the hotline hours are skipped. 

 For example, hotline hours have been entered from Monday to Friday, 12:00 to 16:00 

respectively. A ticket is submitted on Monday at 11:00. The entered response time 

spans 8 hours. The hour from 11:00 to 12:00 is not counted since it is outside the 

hotline hours. The response deadline will thus coincide with the end of the second 

day with hotline hours after the request's start (Tuesday, 16:00). 

When no settings apply to the ticket's priority (e.g., when no response deadlines or 

hotline schedule have been entered in the service agreement or default setttings), the 

ticket's start (i.e., the date and time of its creation) will be entered here. 

 Activate: This feature is not available by default. To activate it, select Display 

service agreement and Response deadline from service agreement under 

Helpdesk > General in the Management Console. 

 Responded on: Here you see the time at which a support employee first opened the 

ticket and changed the status. The field will be filled in when the ticket is saved if it was 

previously empty and the ticket's status has changed. It will also be automatically set in 

new tickets when they are created with an entry in the Status field. 

Once the field has been entered, the response deadline can no longer change. 
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In the Management Console, under Helpdesk > General, you select status options 

whose assignment to a new or existing ticket will not cause the Responded on field to 

be set, even if it is empty (see page 149). 

Select here all status options with which tickets are created via Helpdesk online or the 

support e-mail account. This way, you make sure the Responded on field is only set 

when a support employee changes the status in CAS genesisWorld. 

 Reopened on: Here you see when the ticket was last reopened. 

This field will be set whenever the status of a ticket changes from a completed status to 

a status that doesn't mark completion (you select status options which mark the 

completion of a ticket in the Management Console under Helpdesk > General.) 

 In process for: Here you see the processing time for the ticket since its data record 

window was opened. 

 Save, close and record time: Here you save the ticket, close the data record 

window and create a time record for the time spent processing the request. 

Each user may set the time record window to open when he saves and closes a ticket 

and records time for it using this feature (Settings > Modules and Solutions > 

Open time record for tickets). 

 Activate: This feature is not available by default. To activate it, select Use automatic 

time recording for tickets under Helpdesk > General in the Management Console. 

 Links and communication 

 Parent: When you create a ticket by clicking on the Create new ticket button, the 

primary address and primary project will be entered automatically (see "2.2 Creating 

tickets" on page 10.) 

 Customer: Here you enter the affected company. 

 Search address: Here you select the customer in the Search window. Switching 

customers will reset the service agreement and product use selections. A selected 

product and area will be retained. 

 Open address: Here you open the entered address. 

 Get in touch: Here you call the customer or write an e-mail. 

 Contact person as customer: In the default setting, only companies and 

individual contacts may be entered as customers. In the Management Console, 

you may specify whether contact persons may also be entered (see "Customer 

and submitter" on page 150.) 

 Submitter: Here you specify the person who has submitted the request. 

 Search address: Here you select the submitter in the Search window. 

 Open address: Here you open the entered address. 
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 Get in touch: Here you call the submitter or write an e-mail. 

 Sales partner as submitter: If you are the manufacturer of a product and get 

requests from sales partners, specify the final customer in the Customer field. 

 Communication: For tickets created without a submitter for inbound e-mails sent to 

the support account (see "12.6 Setting up a support e-mail account" on page 218), 

the e-mail address will be stored in the Communication field. When you enter a 

submitter in any ticket, his e-mail address will be entered in the Communication 

field as well, if that field is empty. You may select the e-mail address to use here in 

the Management Console, under Helpdesk > General (see "Use the following e-

mail address of the submitter as communication address" on page 150). 

If the Communication field isn't empty and you enter a submitter with no e-mail 

address or with a different e-mail address in the associated e-mail field, you will be 

asked whether that e-mail address should be entered in the Communication field of 

the ticket or whether the e-mail address already entered in that field should be 

transferred to the associated e-mail field of the new submitter. You may deactivate 

this message, such that your selection will automatically be applied the next time 

you select a submitter (e.g., enter the e-mail address of the new submitter in the 

ticket's Communication field). You may activate the message again in the Settings 

under General > Deactivated messages. 

Changing the submitter in Helpdesk online will automatically overwrite the 

communication e-mail address with that of the new submitter. 

 Service agreement: Depending on your settings, all of the customer's or the 

submitter's service agreements will be available for selection here. Via the Use 

service agreement of customer/submitter for different customer setting under 

Helpdesk > General in the Management Console, you determine whether the 

customer's or the submitter's service agreements will be available if both differ. 

 You may enter a service agreement filter in the Management Console in the 

Helpdesk area under General in order to limit the selection (e.g., to exclude 

expired service agreements). 

 If exactly one service agreement is available for selection, it will be selected 

automatically if the Select service agreement automatically option is active 

under Helpdesk > General in the Management Console. 

 When a service agreement of the customer is selected, only product uses entered 

for that service agreement will be available in the ticket. 

 If the Response deadline from service agreement option is selected under 

Helpdesk > General in the Management Console, the selection of available 

priority levels will be limited by the service agreement. In this case, the selection 

will also be limited for tickets without a service agreement by the settings for 

tickets without a service agreement. Additionally, the selection may be limited by 

submission permissions (see "Priority" on page 18). 
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 Open service agreement: Here you open the selected service agreement. 

 Activate: This feature is not available by default. To activate it, select Display 

service agreement under Helpdesk > General in the Management Console. 

 Product use: Initially, all of the customer's active product uses are available here 

(see "Start and end of maintenance" on page 58). 

When a service agreement of the customer is selected, only product uses entered for 

that service agreement will be available in the ticket. 

With the Display serial number for product use setting under General in the 

Helpdesk area of the Management Console, you determine whether serial numbers 

of product uses, if available, will be displayed in the selection next to product names.  

In this case, the serial number will also be displayed in the Product use field once a 

product use has been selected and will be stored in this field when saving the ticket. 

When selecting a product use, the product and version will be entered automatically. 

When using the customer's service agreement (see "Service agreement" on page 

15) and there is a valid service agreement belonging to the selected product use, it 

will also be selected automatically. 

 Select related product use: Here you select a product use in the Search window. 

Only active product uses for the selected customer will be available. 

 Open linked product use: Here you open the selected product use. 

 Product: Here you select the affected product. 

 Quick search: Enter all or a part of the subject or number of the product you are 

looking for in the Product field. Use the "%" character as a placeholder. It will 

automatically be added at the end of you search term. For example, you can look 

for a product whose number contains the digits "001" using the search term 

"%001". Confirm with the [Return] key. 

If your search term can be associated with exactly one product, that product will 

be entered automatically. If multiple products were found for the entered search 

term, you will be prompted to select the desired product. 

 Select related product: Here you select a product in the Search window. 

 Open linked product: Here you open the selected product. 

Note 

Only products matching the associated filter will be found. By default, these are all 

products for which the Active option has been selected in the General tab. You can 

change the associated filter condition in the Management Console under 

Miscellaneous > Products (see "11.3.6 Products" on page 186). 
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 Version: All versions entered for the selected product are available here. 

 Qualified for support: If a version is marked as Not qualified for support, this 

will be displayed here (see "5.1.2 Version" on page 52.) 

 Area: Here you select the affected feature area. 

You may enter areas and sub-areas in the Management Console, in the Database 

area, as input help items for the Area field of products (see "11.1 Settings in the 

Database area" on page 147). In the General tab of a product, you may assign an 

area to that product (see "5.1.1 General" on page 50). 

If you enter a feature area assigned to a product in a ticket, that product will also be 

entered automatically, and vice versa, if the target field was previously empty. 

 Type and Status: In the Management Console, under Helpdesk > General and under 

Helpdesk > Helpdesk online, you enter settings for the type and status of tickets. 

 Type: You may use different types for tickets. When you create a ticket using the 

Create new ticket button, the default type for tickets will be selected. 

You may select different types for tickets created in Helpdesk online.  

 Status: The status indicates the ticket's current process stage. The following status 

options are available by default. 

 Open: New tickets are considered open until they are taken note of. 

Use this status for new tickets created by partners or customers in Helpdesk 

online and for tickets created for inbound e-mails sent to the support account. 

By default, this is the only status that will not set the ticket's Responded on field 

(see pages 13 and 149). 

 Accepted: New tickets you create in CAS genesisWorld are created with this 

status. It indicates that an employee has accepted the request. 

Tickets that are created by customers in Helpdesk online or via the support 

account are only considered as accepted after this status has been entered by an 

employee, indicating that the ticket has been reviewed. 

 Completed: This status indicates that the request has been solved. 

Setting this status will set the ticket's End to the current date and time. 

Setting another status after this will set the ticket's Reopened on field to the 

current date and time. 

Which options are available is determined via the input help for the Status field of 

jobs, which you can edit in the Database area of the Management Console (see 

"11.1 Settings in the Database area" on page 147). 

Also in the Management Console, under Helpdesk > General, you select status 

options indicating that a ticket has been accepted or completed (see "11.2.1 

General" on page 148). 
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If you are using Helpdesk online, also make sure that the correct status options have 

been entered for request presettings and for list filters in the Management Console 

under Helpdesk > Helpdesk online (see "11.2.2 Helpdesk online" on page 154.) 

 Number: When a ticket is created, the next free number will be generated and entered. 

 When e-mails are archived with a ticket, the number will be used to automatically 

assign the e-mail to the associated ticket. 

 Classification 

 Priority: Here you assign a priority level to the ticket. 

 You may specify available priority levels via the input help for the jobs' Priority 

field in the Management Console's Database area. 

 If the Display service agreement and Response deadline from service 

agreement options have been selected in the Management Console under 

Helpdesk > General, the selection of available priority levels will be limited by 

the associated service agreement. In this case, only priority levels which have 

been cleared in the selected service agreement will be available for selection. 

When no service agreement is selected, all priority levels that you have cleared 

for tickets without a service agreement under Helpdesk > Service agreements 

in the Management Console will be available for selection. 

 If submission permissions are also used and have been entered in the selected 

service agreement, only priority levels permitted for the entered submitter in the 

service agreement will be available for selection. 

 You may determine the priority for new tickets in the Management Console 

under Helpdesk > General. This presetting will only be adopted if it is included 

in the selection of available priority levels. 

 Origin: Here you see which medium was used to submit the request. The E-Mail, 

Personal, Phone call, and Web options are available by default. 

 E-Mail: preselection in tickets for e-mails 

 Personal: not selected automatically 

 Phone call: preselection in tickets for addresses and phone calls 

 Web: automatic selection in tickets created in Helpdesk online 

 Ticket type: Here you classify the request for support. The Question, Error and 

Improvement options are available as input help items by default. 

You may enter the preselection for this field in the Management Console under 

Helpdesk > General.  

 Error cause: Here you record the error after completion of a ticket concerning an 

error. This field is only available for Ticket type values selected as error ticket types 
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in the Helpdesk area of the Management Console under General. By default, only 

Error is selected here. If required, you may add other ticket types for errors. 

When the Error cause field is enabled for the selected ticket type, the Product 

error, Application error and Consultation error options are available by default. 

For Ticket type values for which the Error cause field isn't enabled, the Ticket type 

value (e.g., Question) is repeated in the Error cause field. 

 Satisfaction: Here you specify the submitter's level of satisfaction with the 

processing of a ticket once it is completed. The Friendly, Neutral and Unfriendly 

options are available as input help items by default. 

You can edit the available options via the input help for the Satisfaction job field in 

the Database area of the Management Console. 

If you are using Helpdesk online, you can set up an automatic request for feedback 

in order to query the submitter of a ticket about his satisfaction once the ticket is 

completed (see "12.4 Setting up a request for feedback" on page 209.) 

 Request: Here you specify the customer's original request. 

When you create tickets for projects, phone calls and e-mails, the respective subject will 

automatically be transferred to the ticket's Subject and Request fields. 

This also applies to tickets created automatically for inbound e-mails sent to the 

support account (see "12.6 Setting up a support e-mail account" on page 218). 

In tickets created for addresses, the Subject and Request fields are initially empty. As 

long as the Subject field is empty, your input in the Request field will automatically be 

entered as Subject as well. 

For tickets created via Helpdesk online, both the Subject and the actual Request are 

separate fields, and are both mandatory there. 

 Edit request: Here you open the description in a separate window. 

 Send e-mail: Here you send an e-mail to the ticket's submitter or the affected 

product's manufacturer, selecting from e-mail templates created for tickets (see "4 

Using e-mail templates" on page 47.) 

 Create task: Here you create a task for the ticket. In the Management Console, 

under Helpdesk > Tasks for tickets, you specify the type and status of new tasks 

per ticket type. You also specify there whether tasks should be assigned to the 

associated ticket via a primary link. 

 FAQ search: Here you open the FAQ search (see "3.1 FAQ search and creating FAQ 

documents" on page 41.) 

 Solution: Here you record the request's solution. 

 Edit solution: Here you open the description in a separate window. 
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 Save request and solutions as FAQ: Here you create an FAQ document for the 

ticket (see "3.3 Creating an FAQ document" on page 44.) 

 Participants and groups: Instead of the Participants field, which you will usually find 

in CAS genesisWorld, tickets display four drop-down menus. 

You can use these to assign each ticket to a support Team, a support Employee, a 

Responsible team and a Responsible employee.  

After selecting the respective Team, all members of the selected group will be available 

for selection as Employee.  

You select groups which will be available for selection as teams for each of both team 

fields respectively in the Management Console. For members of the groups you have 

selected for the Team field, you can also enter a preselection for that field. In new 

tickets, the selected group will then automatically be entered in the Team field and the 

user will be entered in the Employee field (see "11.2.6 Groups" on page 177). 

To enter users and groups or access their tickets, a user also needs at least reading 

access to their jobs via group membership or external access: 

 If a user is a member of a group, the assigned access level for jobs applies to the 

group and all of its members. 

 If a user has external access to a group, the assigned access level for jobs applies to 

the group and all of its members. 

 Additionally, you may grant users external access rights to jobs of select users. 

The selected groups and users are participants of the ticket and will not only be 

entered in the associated text fields but also the Participants field when the ticket is 

saved. If all four fields are left blank, the user who has created the ticket will be entered 

as participant. Please note that any users and groups already entered as participants 

will overwritten when saving the ticket. 

 Participants of online tickets: For tickets created via Helpdesk online, you may 

enter preselections for all four participant fields in a request type's definition (see 

"Requests" on page 156). Request types for which all four fields are left blank will be 

created as public. 

 Internal notes: An additional notes field for internal notes is available in tickets. You 

can toggle its display in the Management Console under Helpdesk > General. 

 Notes: A ticket's Notes field is used for any comments on status changes and for 

communicating with the customer. 

 When a ticket is created for a phone call or e-mail, either manually or automatically 

via the support account (see "12.6 Setting up a support e-mail account" on page 

218), the phone call notes or e-mail body will be written in the ticket's Notes field. 

 In the default setting, when you save a ticket after entering anything in the Notes 

field, you will be prompted to state whether the submitter should be notified. If 

notification has been set up in the intended default configuration and you answer to 
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the affirmative, the submitter will receive a status report including the notes (see 

"12.3 Notifying the submitter about changes in a ticket" on page 205). 

 In Helpdesk online, notes for a ticket will be displayed in the detail view. Comments 

that portal users enter for a ticket will also be written into the notes. 

 Automatic notification of the submitter: When you save a new ticket or when you 

save a ticket after changing the Notes or Solution field, you will be asked whether the 

submitter should be informed. If you confirm and the E-mail (business) address has 

been entered for the submitter, the ticket will be marked for notification. 

 Setting up the notification: Notification of the submitter will be taken care of by 

the notification and action service if suitable rules have been entered (see "12 

Notification and support account" on page 195). 

 Turning off the prompts for notification: You may disable the prompts in the 

Management Console under Helpdesk > General. You may find the associated 

settings to the lower right, under Miscellaneous (see page 151).  

If the prompt about new tickets is turned off, new tickets will not be marked for 

notification. 

If the prompt about changes is turned off, tickets will be marked for notification 

whenever the notes or solution change. 

Note 

You can notify the submitter and apply changes to the ticket at the same time via ticket 

actions (see "2.4 Ticket actions" on page 23). If one of the Notes or Solution fields is 

changed by a ticket action, the ticket will not be marked for automatic notification. 
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2.3.2 Details 

In the Details tab of the data record window for jobs, additional ticket fields are available 

under Ticket details. 

 

 Reference (Submitter): If partners forward tickets to you, you may record the ticket 

number in the submitter's system here. 

 Reference (Manufacturer): If you forward tickets to the manufacturer, you may record 

the ticket number in the manufacturer's system here. 

 Service level: If a service agreement is selected in the ticket, its service level will be 

displayed here. 

The Activity status, Comment, Remind and Set time fields can also be found in the 

Details tab in tickets. These are standard fields that are available for all jobs. 
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2.4 Ticket actions 

The following sections describe the features for ticket actions: 

 2.4.1 Using ticket actions (page 23) 

 2.4.2 Specifying ticket actions (page 28) 

 2.4.3 Editing a ticket action (page 29) 

2.4.1 Using ticket actions 

You may use ticket actions to execute one or more of the following work steps. 

 Notifying participating agents via e-mail (internal and external) 

 Archiving sent e-mail with the ticket 

 Updating ticket field values and forwarding the ticket internally, if applicable (Type, 

Status, Ticket type, Error cause, Priority, Solution, Team, Employee, Responsible 

team and Responsible employee) 

 Adding entries to the Internal notes and Notes fields 

 Creating a task for the ticket 

 Recording time 

 Closing the ticket's data record window 

Notes 

Ticket actions are not available in the Web Client. 

Before ticket actions are available, you must specify them under Settings > Ticket 

action (see "2.4.2 Specifying ticket actions" on page 28). This requires the Helpdesk: 

Edit ticket actions right, which you may assign to users the Management Console, in 

the User Management area. Select it in the properties of a user under Other rights. 

In the Management Console, under Helpdesk > Notification and languages, you 

specify the e-mail account to use and select the languages availabe for actions (see 

"11.2.7 Notification and languages" on page 178). 

Ticket actions with e-mail notification can only be executed if the e-mail field selected 

for each recipient (To field) isn't empty. 

Missing e-mail addresses in the CC and BCC fields will be ignored. 

The validity of the e-mail addresses is not checked before the e-mails are sent. 

However, you will be warned when trying to save an invalid e-mail address in the CAS 

genesisWorld Desktop Client. 
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Selecting an action 

In the Action menu in the toolbar of the data record window for tickets, entered actions 

will be available for selection. 

All actions are available here, 

 ... whose filter conditions apply to the current ticket and 

 ... which have been made available to the current user. 
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Executing an action 

Selecting an action will open a window where you make additional entries. 

 

 External comment and Internal comment: Enter your request or message here. The 

external comment is provided for the Notes field and external e-mail and can be preset 

(see "More steps" on page 35). The internal comment is provided for the Internal 

notes field internal e-mail. When using multiple languages for notes fields or e-mails, 

select the tab for each language for which you want to enter comments (see below). 

Note 

The comment fields will only be available if the associated text variables are used in the 

action's template. Please note that the internal comment could also appear in external 

e-mail and external notes, depending on where it is used in the template.  

Where exactly the text is entered depends on the template (see "Subject and body" on 

page 32 and "More steps" on page 35). 
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 Overview of work steps: Here you see the changes to apply to the ticket as well as the 

e-mails to send. If a task should be created, it will also be displayed here. The Status 

field is always displayed. Here you see the ticket's status after the action is executed. If 

multiple types are used for tickets, the ticket's new Type is also displayed. When an 

action doesn't modify the status or type, the target values are displayed as grayed out. 

 Select language: You may select the desired language for e-mails and notes if the 

associated templates have been entered in more than one language. The language 

defaults to the setting you have made in the Management Console under Helpdesk 

> Notification and languages. E-mails will preferably use the recipient's Preferred 

language entered in the associated address in the Details tab if available for the 

ticket action. When using multiple languages, you may enter individual comments 

for each language, which you may select via the tabs on top of the window. 

 Display preview: Here you open a preview of the e-mails and notes. 

In the e-mail preview, you may add additional recipients in the To, CC and Bcc fields. 

Separate multiple recipients in a field with a semicolon (";"). 

Via the Add attachment menu, you may add attachments from files or archived 

documents. You may also archive files as documents and attach them here. 
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 Change field values: Fields of the ticket for which this has been set up in the action 

template may be modified in the overview of work steps 

 Create time record: The time record for the action is displayed here. If desired, modify 

the displayed values. 

 Execute action: By clicking OK in the lower right you confirm the execution of the 

action. All provided works steps will now be executed: 

 Send e-mail and archive it with the ticket 

 Make changes to the ticket 

 Create a task 

 Create a time record 
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2.4.2 Specifying ticket actions 

You specify ticket actions under Settings in the Ticket action tab. 

 

The list supplies a quick overview about which actions are available for which tickets: 

 The action will be displayed in the Action menu under its Subject. 

 Type, Ticket type, Status, Team and Responsible team are filter values. The action 

will be available for all tickets whose type, ticket type, status, team and responsible 

team are listed here. Additionally, you may filter by the Error cause and Priority fields. 

 The Target status will be set in the ticket when the action is executed. 

 Under Changed by and Changed on, you can see who last changed the action when. 

 

For creating and editing actions, the following features are available here. 

 New: Here you create a new action. 

 Edit: Here you edit the selected action. 

 Duplicate: Here you create a copy of the selected action. 

 Delete: Here you delete the selected action. 

 Import: Here you import previously exported actions. 

 Export: Here you export all selected actions. 
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2.4.3 Editing a ticket action 

For creating or editing a ticket option, this window will open. 

 

Here you enter the following settings for the action. 

Name and description 

At the top, you name the menu item for Helpdesk users working with ticket actions. The 

description is optional and is only displayed here. 

You may enter the name and description of an action in all client languages which are 

installed and have been selected for Helpdesk (see "11.2.7 Notification and languages" on 

page 178). 

Here you enter the name or description. 

Ticket filter 

Here you limit the tickets for which the action will be available via filters. 

You may filter by the Type, Ticket type, Status, Error cause, Priority, Team and 

Responsible team fields. 

Via More filters, you may enter a formula of the Boolean value type. Here, you have 

access to any fields available for jobs as well as input help variables, which will be replaced 

by the correct values in the currently used language in a multi language system. 

 Edit filter: Here you open a selection of entries available for the associated field. Under 

More filters, you open the formula editor here. 
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Team 

Here you select the users and groups for which the action will be available. 

 

Send e-mail 

Here you enter templates for e-mails which will be sent when the action is executed. 

 

To create and edit e-mail templates, the following features are available here. 

 New: Here you create a new e-mail template. 

 Edit: Here you edit the selected e-mail template. 

 Duplicate: Here you create a copy of the selected e-mail template. 

 Delete: Here you delete the selected e-mail template. 
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Edit e-mail 

For creating or editing an e-mail template, this window will open. 

 

 Sender: Here you select whether the system account or the user executing the action 

will be specified as sender. In addition, you may enter a different sender name and a 

different reply-to address. 

 Recipients: Clicking one of the To, Cc or Bcc buttons will open the Select recipients 

window. Here you select the desired recipients from addresses linked to the ticket as 

well as the ticket's participants. 

In addition, you may read user names and e-mail addresses from a text field. 

You may also enter permanent recipients in the To, CC and Bcc fields directly in the 

Edit e-mail window. Separate multiple recipients in a field with a semicolon (";") 
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 Addresses: Select here all linked addresses that should receive a copy of the e-mail. 

For each selected address, you will be prompted to select the e-mail field to use. 

 Participants: Specify here whether participants of the request should be notified 

and select the desired fields. The e-mail will be sent to the e-mail addresses entered 

in the User Management area of the Management Console for the selected CAS 

genesisWorld users or for the members of the selected groups. 

 E-mail address from field: Select here a job text field in which recipients will be 

specified (e.g., select Communication instead of the Submitter link if you are using 

the support e-mail account as described in section 12.6 on page 218).  

Multiple recipients can be entered in the selected field, separated by commas (",") or 

semicolons (";"). 

E-mail-addresses and CAS genesisWorld user names may be specified as recipients. 

 Subject and body: In the lower half of the window, you enter the subject and body of 

your message. You may enter the template in all client languages selected for Helpdesk 

(see "11.2.7 Notification and languages" on page 178). 

You may use the following text variables. 

 Response 

 User description and User name: The user executing the action 

 Date and time: Time at which the action is executed 

 External comment and Internal comment: Entries made by the user when the 

action is executed 

 Link to Helpdesk online (ticket view): See "Sending links for opening the detail 

view" on page 139 

 Link to Helpdesk online (request for feedback): See "12.4 Setting up a request 

for feedback" on page 209 

 Name of response (ticket action) 
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 Ticket: Ticket fields 

 Submitter: Submitter's address fields 

If e-mails created from the template and replies to them should be linked with the 

associated ticket when the e-mails are archived, enter the key defined in the 

Management Console into the subject line (see "11.3.4 E-mail" on page 183). 

Please note that a blank space must be entered before the key field (e.g., when no 

prefix was defined and Number was selected as field, the key will be "# Number#"). 

Note 

In order to use links to Helpdesk online in e-mails, you must enter the associated link in 

the Management Console (see "Link" on page 155). 

 

 Attachments 

 Add attachment: Here you may Add existing documents via the search window or 

archive a new file and add it via Create and add new document. 

 Edit: Here you edit the selected document in its data record window. 

 Remove attachments: Here you remove the selected documents. 

 Send ticket as GBT file: Select this option to include a copy of the ticket as an 

attachment in the CAS genesisWorld transfer file format. 

 Archive e-mail: Select this option if the e-mail should be archived with the ticket and 

all addresses selected as recipients after sending. 

Change field values 

Here you specify which fields of the ticket should be changed by the action. 

 

Select the desired Value for each Field you wish to change. 
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Select the Can be changed by user option if the user executing the action should have 

the possibility to modify the value. 

The Can be changed by user option also allows an action to be executed when the field 

value selected here is not available in a ticket. With this option, the first available value will 

be selected for the associated field and may be changed by the user if more values are 

available. If a field value selected here is not available in a ticket and the Can be changed 

by user option has not been selected for the field, the action will be cancelled when it is 

selected and the field and missing value will be displayed. 

When you select the Can be changed by user option for the Solution field, a separate 

field for entering the solution will be displayed when the action is executed. The field will 

automatically adopt a solution that has already been entered in the ticket and will be 

transferred back to the ticket's Solution field as displayed when the action is confirmed. 

The selection for the fields available here can be limited as follows in a ticket: 

 The selection in the Status field may depend on the Type (MC > Database > Jobs > 

Type/Status > Input help). When multiple types are used for tickets (MC > Helpdesk > 

General) and no type is selected here, all status options for all ticket types will be 

available for selection. In this case, if you select a status here, the action will only be 

executable in tickets for whose type the selected status is available. 

 You may only select an Error cause if that field has been cleared for the selected Ticket 

type (MC > Helpdesk > General). When you select a Ticket type for which no error 

cause can be specified, it will automatically be transferred to the Error cause field. 

 The selection in the Priority field is limited by the service agreement or by the default 

settings for tickets without a service agreement if response deadlines are used (see 

"Priority" on page 18). 

 The selection in the four participant fields Team, Employee, Responsible team and 

Responsible employee may be limited by access permissions, as is usual in CAS 

genesisWorld. 

In the team fields, only groups in which the user is a member with at least reading 

permissions or to which she has external access will be available for selection. 

In the employee fields, all members of the group selected as the respective team will be 

available for selection. 



Helpdesk   Ticket management 

35 

More steps 

Under More steps, you specify entries for the notes fields. You decide whether a task 

should be created, whether time is to be recorded automatically for the action and 

whether the ticket's data record window should be closed after the action is executed. 

 

 Internal note and External note: Here you specify entries to insert at the beginning of 

the Internal notes and Notes fields. As for e-mails, you have access to Response, 

Ticket and Submitter field text variables, see "Subject and body" on page 32). 

The Internal notes field will only be available if you have set it to be displayed in 

tickets in the Management Console (see "Notes" on page 150). 

 External comment: Here you may preset the external comment, with access access to 

Ticket, Customer and Submitter field text variables. 

Users who execute the ticket action may simply accept, modify or supplement the 

preset external comment. 

 Create task: Here you specify whether a task should be created for the ticket. 

If desired, select a template to use via the search.  

Also state whether the ticket's subject should be adopted as the new task's subject and 

whether the task should open automatically in the associated data record window once 

the ticket action has been executed.  

 Create time record: Here you specify whether time should be recorded for the action 

automatically. In the default setting, the ticket's subject will be adopted as the time 

record's subject. Alternatively you may enter a different subject for time records for the 

selected action.  

In addition, you select here the desired type and status of the time record. 

 Close the data record window of the ticket: Here you specify whether the data 

record of the ticket should be closed automatically after the action has been executed. 
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2.5 Blocking support entitlement 

You can block the support entitlement for companies and individual contacts in Details. 

When you block a company, the block also applies to all associated contact persons. 

 

 Support block in CAS genesisWorld (Desktop Client & Web Client): If you open or 

create a ticket for a blocked address or enter a blocked address as a ticket's customer 

or submitter, you will be notified of the block. 

Tickets can then still be created or edited and saved.  

 Support block in Helpdesk online: Contacts belonging to a blocked company as well 

as blocked single contacts can no longer log on to Helpdesk online. 

You may store the associated message in different languages in the Management 

Console under Helpdesk > Helpdesk online. 

Blocked customers are no longer available for selection by their supervising partners for 

new inquiries in Helpdesk online (see "This request is for" on page 141). 
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2.6 Setting up access for Helpdesk online 

To permit access to a company contact or a single contact, enter a password and select an 

access level in the Details tab. 

 

 Enter password: Click Reset to enter a password or change the stored password. After 

saving, it will be displayed encrypted as ⚫⚫⚫⚫⚫, regardless of its length. 

Customers can also set their own passwords in Helpdesk online via the Activate 

account link on the login page. 

Section "12.1 Helpdesk online account enabling notification" on page 195 describes 

setting up a notification rule for sending customers a direct link to the activation page 

when their access is enabled by selecting an access level in the Helpdesk online field. 

In the Helpdesk area of the Management Console, under Helpdesk online > General, 

you can specify a minimum length and other requirements for passwords. All of these 

requirement will be checked when setting or changing the password in an address 

record in the Desktop Client as well as in Helpdesk online by a customer (see Activate 

password guideline for portal users on page 155). 

 Via an Action, you may enable Helpdesk online access for multiple contacts at once, all 

of which will be invited for activation via the notification rule (see section "Activating 

Helpdesk online access for multiple contacts via an action" on page 39).  
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 Assign Helpdesk online password: Once the account has been activated by entering a 

password, either by the customer himself in Helpdesk online or by an employee in the 

Desktop Client, the the Assign Helpdesk online password field is set to "true". 

This field isn't displayed in the data record window but may be used for filtering.  

 Helpdesk online: For new contacts, no access level is initially selected. New contacts 

therefore have no access to Helpdesk online, just like with the No access level. Select 

the desired access level here to grant contacts access to Helpdesk online. Please note 

that the account will only be activated after entering a password (see previous page).  

The access level controls which tickets the user may see in Helpdesk online. 

 No access: The contact hasn't been granted access to Helpdesk online. 

Select this option to indicate that access has been actively denied to a contact in 

order to distinguish it from contacts for which no access level has been selected yet. 

 Own requests (submitter is this contact): The contact has access to all requests in 

which he has been entered as submitter. 

 Company requests (submitter belongs to company): The contact has access to all 

requests in which he or another contact of the same company has been entered as 

submitter. 

 All requests (submitter is part of company structure): The contact has access to 

all requests in which he or another contact of the same company has been entered 

as submitter. The contact also has access to all requests in which a contact of 

another company has been entered as submitter if that company has been assigned 

to his company via a Parent/Child link, either directly or indirectly, and therefore 

appears in the Company structure view of his company. 

As individual contacts are treated like a company and contact in one data record in 

CAS genesisWorld, a contact with this access level can also see requests from 

individual contacts which appear in his company's Company structure view. 

If this access level is assigned to an individual contact, he will be able to see, in 

addition to his own requests, any requests from companies and individual contacts 

which appear in his own Company structure view. 

Requests from company contacts which have been assigned to the company of a 

contact with this access level or to an individual contact with this access level via a 

Parent/Child link, directly or indirectly, in the Company structure view, will not be 

displayed in Helpdesk online unless their associated company also appears in the 

Company structure view. 

With the Has ticket access link, you can additionally display tickets submitted by other 

addresses (see "11.3.5 Links" on page 185). 

Those will then be displayed in Helpdesk online to users with either of the Company 

requests or All requests access levels (see "Submitter" on page 137). 
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 Creating tickets for customers: The Has ticket access link also enables creating 

tickets for linked addresses via request types with a customer selection (see "This 

request is for" on page 141). 

Additionally, using such request types, Helpdesk online users may also create tickets for 

addresses assigned to the own company via the Customer link (company to company). 

Users with the All requests (submitter is part of company structure) access level 

may also create requests of such types for any company linked to a company that is 

part of their own company’s Company structure via the Customer link. 

In addition to companies, links to individual contacts are also supported here. 

 Activating Helpdesk online access for multiple contacts via an action 

 Select the desired addresses in a list view (e.g., a list of search results). 

 In the Action menu in the toolbar, select the Other actions… item. 

 As Table field, select the Helpdesk online field. 

 As Value of change, select the desired access level. 

 Click Execute action, to change the access level for all previously selected contacts. 

Please note that the selected contacts will only be automatically invited to activate their 

accounts if you have configured an appropriate notification rule (see "12.1 Helpdesk 

online account enabling notification" on page 195). 
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2.7 Tickets in the Web Client 

With the Tickets app in the Service and support app group, you can see and edit existing 

tickets. To create new service tickets, please use te action menu in the detail view for the 

associated data record. 

 

 In the app start for the Tickets app, you have access to your tickets and job views. 

 Click on the eye icon to create a new ticket list view. 

 Click on a ticket to open the detail view. You can also edit or delete the ticket here. 

 If the automatic notification has been activated and configured (see "Miscellaneous" 

on page 151), the ticket's submitter will be informed when the ticket is created or when 

the notes or solutions are changed. This requires confirmation by the user. 

 Additionally, you can create tickets for addresses, phone calls and e-mails. 

To do this, in the associated detail view, open the action menu with the three dots [...] 

and select Create > Ticket. 

Click on the question mark at the top right to open the online help pages for more details. 
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3 FAQ management 

The following sections describe the default features for FAQ documents: 

 3.1 FAQ search and creating FAQ documents (page 41) 

 3.2 Views and features for FAQ documents (page 44) 

 3.3 Creating an FAQ document (page 44) 

 3.4 The data record window for FAQ documents (page 45) 

 3.5 FAQ documents in Helpdesk online (page 46) 

The FAQ search in Helpdesk online is described under "10.7 FAQ search" on page 134. 

3.1 FAQ search and creating FAQ documents 

The FAQ search finds FAQ documents and tickets in the selected area. In addition to the 

area selection, a product and version filter are available. 

 

You may also create new FAQ documents for a selected area. The selected product and 

version will not be transferred to the new FAQ document. 

 Opening the FAQ search: The FAQ search is available in the main window's Search 

window with Helpdesk. While the main window is active, you can also open the FAQ 

search directly via the [F6] key. 
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 FAQ search: You can also open the FAQ search from any ticket using this button to the 

lower right next to the Request and Solution fields. 

In the FAQ search, you have the following options. 

 Search: Here you determine which data records and fields should be searched. 

 Select fields: All text and notes fields are available for selection here. 

 Only complete tickets: With this option, only tickets marked as completed via the 

status will be found. 

 Search item(s): Only hits in which each search item appears at least once will be 

displayed. Use quotation marks to search in a field in exact order (e.g., "Management 

Console"). 

 Only complete words: If you are using the full text search, all words beginning with 

your search item will be regarded as hits. Select this option if only those words 

which precisely match your search items should be regarded as hits. 

 Search: Click here to start the search. 

 Filter: You may filter the search by product, version and area. In the Management 

Console, you specify under Helpdesk > General whether the product, version and area 

should be adopted from the ticket when the search is opened. 

Via the area selection you may also create new FAQ documents for the selected area. 

The selected product and version will not be transferred to the new FAQ document. 

 Search product: Here you select a product in the Search window. 

 Delete product filter: Here you reset the filter to All products. 

 Version: For versioned products, you may select the version here. 

 Select area: Select an area here. Items below the selected item will also be found. 

You may enter areas and sub-areas in the Management Console, in the Database 

area, as input help items for the Area field of products (see "11.1 Settings in the 

Database area" on page 147). In the General tab of a product, you may assign an 

area to that product (see "5.1.1 General" on page 50). 

 Ignore subareas: Select this option to only find entries in the selected area. In 

this case, items below the selected item will not be found. 

 New FAQ entry: Here you create a new FAQ document for the selected area. 

The selected product and version will not transferred to the new FAQ document.  

However, when selecting an area with a product assignment (see "5.1.1 General" on 

page 50), the assigned product will also be applied automatically. 
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 Search results: Found search results will be displayed in a mixed list. The contents of 

the Request, Solution and Notes field will be displayed at the bottom. Your search 

items will be highlighted in red. 

  

 Transfer solution: Here you overwrite the Solution field of the ticket from which 

you opened the search with the displayed solution. 
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3.2 Views and features for FAQ documents 

FAQ documents are documents of a certain type. The associated fields and features will be 

displayed in the document's data record window when the FAQ type is selected. 

The following standard features are available for FAQ documents. 

 Data record window for documents; the FAQ tab is available in addition to the 

standard tabs for documents. 

 Type for marking as FAQ item 

 Status for publishing in Helpdesk online 

 Primary links to address, project and job, displayed in the tree view and in analyses 

(with Report module) 

 General links to any other data records 

 Creation with FAQ type from tickets or from the FAQ search 

 Global search in all fields such as Subject, Product and Area, configurable via 

Settings > Search; separate FAQ search for FAQ documents and tickets 

 Views in the program navigator (list, dossier, tree) and in the link navigator (link list) 

3.3 Creating an FAQ document 

In every ticket, the Save request and solutions as FAQ button is available to the right of 

the Request and Solution fields. 

You may also create FAQ documents directly for a specific area via the FAQ search (see 

"3.1 FAQ search and creating FAQ documents" on page 41). 

 Save request and solution as FAQ: Here you create an FAQ document as a short note. 

The following fields will be transferred from the ticket, if available. 

 Subject 

 Product 

 Area 

 Request 

 Solution 

If an FAQ document has already been created for the ticket, you may open it in the 

document window by clicking on the FAQ button. 
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3.4 The data record window for FAQ documents 

 

 Subject: The subject will be transferred from the ticket. 

 Version from / to: Select here the first and last associated version. You may enter the 

available items for the selected product (see "5.1.2 Version" on page 52). 

 Product: Select here the associated product. Selecting an area assigned to a product 

(see "5.1.1 General" on page 50) will select that product. 

 Area: Select here the area to which the FAQ relates. 

If applicable, the associated product will also be selected. 

You may enter areas and sub-areas in the Management Console, in the Database area, 

as input help items for the Area field of products (see "11.1 Settings in the Database 

area" on page 147). In the General tab of a product, you may assign an area to that 

product (see "5.1.1 General" on page 50). 

 Request / Solution: As in a ticket, you open the descriptions in separate windows by 

clicking on the buttons next to the fields. 

 Type: The FAQ type will be entered automatically. You select the type to use in the 

Management Console under Helpdesk > General (see "11.2.1 General" on page 148). 

 Status: When the FAQ search in Helpdesk online is active, you may publish FAQ 

documents in Helpdesk online via the status (see following section). 
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3.5 FAQ documents in Helpdesk online 

Depending on your settings, an FAQ search is also available in Helpdesk online (see "10.7 

FAQ search" on page 134). You can find the associated settings in the Management 

Console under Helpdesk > Helpdesk online > FAQ (see "FAQ" on page 170). 

When the FAQ search is active, any document with the FAQ type and a publishing status 

will be displayed in Helpdesk online. 

3.5.1 Document language and language selection 

In the Helpdesk area of the Management Console, under Helpdesk online > FAQ, you 

may activate a language selection in the FAQ search in Helpdesk online (see "Language 

filter for FAQ entries" on page 171). 

If you do, all languages will be available for selection there which have been selected for 

the Document language field in the General tab of any displayed FAQ document: 

 

3.5.2 Downloads for FAQ documents 

With the default setting, all documents assigned to an FAQ document via general links will 

be available for download in the associated FAQ view in Helpdesk online. 

You may turn off this feature or limit it by entering filter settings in the Management 

Console under Helpdesk > Helpdesk online > FAQ (see "Documents referring to FAQ 

document" on page 171). 
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4 Using e-mail templates 

E-mail templates are available for tickets. Various types of information from the ticket may 

be embedded dynamically. Documents you link with templates will be copied when using 

the template and attached to the e-mail. 

E-mail templates are also available directly for contact persons and individual contacts. 

Note 

The e-mail template selection for tickets offers only E-mail campaign documents with 

the Ticket e-mail template category. 

The e-mail template selection for addresses offers any E-mail campaign documents 

with the E-mail template and Ticket e-mail template categories. 

Document templates will not be available. 

 

In tickets, the Send e-mail button is available next to the Request field. 

 Click Send e-mail to select the desired recipient from the available e-mail addresses of 

the submitter. 

If a product with a manufacturer link is selected, the manufacturer's e-mail address will 

also be available for selection here (see "5.1 Products" on page 50.) 

 Select the desired recipient. 

 Select the desired template. 

The e-mail will be generated from the selected template, addressed to the desired 

recipient and opened. You may now edit or extend it, send it and archive it as you wish. 

E-mail templates are also available in the contact menus for the customer and submitter. 

 Get in touch: Here you open a menu of phone numbers and e-mail addresses 

available for the customer or submitter. In the sub-menu for sending an e-mail, you 

access stored e-mail templates. 

E-Mail templates are also directly available in addresses.  

 Via the E-mail templates button in the toolbar of a contact person's or individual 

contact's data record window you open the selection of templates. 

Creating ticket e-mail templates  

You create ticket e-mail templates as documents using the E-mail campaign template. 

The Ticket e-mail template category in the document marks it as an e-mail template and 

makes it available in the e-mail template selection. 
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 Select New > Document from the File menu or select Document from the New menu 

in the main window to create a new document. 

 Select the E-mail campaign default template and click OK to confirm. 

 The data record window for e-mail campaigns will open. 

 

 Subject: The document's subject will be displayed in the template list. 

 E-mail subject: Enter the subject for the e-mails to create from the template here. 

Click on the arrow button at the lower right to access address fields, which you may 

insert via the Recipient list.  

To use field variables defined for tickets in the subject line, put them in angle brackets 

(e.g., <TicketNummer> for the ticket number.) 

If e-mails created from the template and replies to them should be linked with the 

associated ticket when the e-mails are archived, enter the key defined in the 

Management Console into the subject line (see "11.3.4 E-mail" on page 183).  

Please note that a blank space must be entered before the key field (when no prefix 

was defined and Number was selected as field, the key is "# <TicketNummer>#"). 

 Body: Use the CAS genesisWorld text editor to create the e-mail body. 

Click on the arrow button at the lower right to access address and ticket fields.  

 Insert address fields via the Recipient list. 

 Insert ticket fields via the Field variables list. 
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 Field variables in the subject and body: When you activate Helpdesk, field variables 

for the following ticket fields will be created: Solution, Notes, Number, Priority, 

Request, Product, Reference number, Status, Subject and Participants. 

If you need additional field variables for tickets, you may create them in your user 

settings in Documents > Field variables.  

 Adding field variables for tickets: Enter as Name the desired name for the item in 

the field variable list. 

Enter as Value the key TASK:Field, where Field is the desired field's internal 

name. For example, TASK:KEYWORD refers to the ticket's subject. 

 Adding field variables for linked data records: Via field variables, you may also 

embed fields of unambiguously linked data records, such as customer and submitter 

in the following way: Table:Field:Link type 

You may, for example, refer to the customer's company like this: 

ADDRESS:COMPNAME:L2UTicketPart 

The internal field names are listed in the Database area of the Management Console. 

The internal link type names are listed in the Management Console under 

Miscellaneous > Links > Link types. 

Notes 

The field variables for ticket fields will only be correctly replaced in e-mail templates for 

tickets. Use the field variables for the primary job to embed ticket fields in word 

documents. 

 

 Add attachments: Click on the arrow button at the lower left to display the attachment 

list. Then click on the Attachments button next to that list to edit it. 

 Click Add attachment to access the document archive via the global search. 

 Click Add new attachment to create a new document and add it to the e-mail 

template as an attachment. 

 Click Remove attachment to remove the selected attachment. 

 Data in the Advanced tab: In e-mail campaign templates, nearly all fields that you 

usually edit in the General tab can be found in the Advanced tab. 

 Mark as e-mail template: Switch to the Advanced tab and select the Ticket e -mail 

template category to add the document to the selection of e-mail templates. 
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5 Product use and service agreement management 

The following sections describe features for product uses and service agreements: 

 5.1 Products in the Desktop Client (page 50) 

 5.2 Product uses, service agreements and maintenance billing (page 54) 

 5.3 Product uses in the Desktop Client (page 56) 

 5.4 Service agreements in the Desktop Client (page 64) 

 5.5 Product uses and service agreements in the Web Client (page 80) 

5.1 Products in the Desktop Client 

The Helpdesk features for products are only available in the Desktop Client: 

 5.1.1 General (page 50) 

 5.1.2 Version (page 52) 

5.1.1 General 
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Differing price information entered in the General tab (prices in other currencies) will be 

available in product uses when the product and currency are selected there. You may 

enter differing prices here if this feature has been activated in the Management Console 

(see "11.3.6 Products" on page 186). 

With Helpdesk, the following additional fields are also available here: 

 Producer: If you specify a company as manufacturer here, it will be available in tickets 

linked with the product as a recipient for e-mails that you create from templates. 

 Maintenance item: If you are a reseller of service agreements, specify the product 

representing the service agreement here. In the maintenance item, you specify the 

Purchase price for one year of service. The Contribution margin results from the 

difference between the purchase price and the maintenance amount for the serviced 

product (calculated on the basis of the product price and maintenance amount). Other 

information entered for the maintenance item will not be considered in the calculation. 

When you create maintenance bills with Easy Invoice using the example configuration, 

the line items for products will be described with the product‘s Subject. For products 

with a maintenance item, the maintenance item's Subject will be quoted in the bill 

instead (see "5.4.5 Maintenance billing with Easy Invoice" on page 72). 

 Area: Here you can assign a feature area to each product. 

You can configure the hierarchic input help for this field in the Database area of the 

Management Console, under Products, for the Area field (see "11.1 Settings in the 

Database area" on page 147). 

The assignment is valid for the selected area and any of its sub-areas which haven't 

been assigned to a different product. 

When a feature area with a product assignment is entered in a ticket or FAQ item, the 

product will also be entered there automatically. 

Likewise, the selection of a product to which a feature area has been assigned will also 

automatically select the associated feature area. 

In Helpdesk online, for new requests and in the FAQ search, all first level areas and all 

sub-areas assigned to products will be available for selection as products. 
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5.1.2 Version 

In the Version tab, you may enter versions with a name or number and release date and 

specify whether the version is supported. 

When a product is selected in a ticket, product use or faq document, the versions entered 

for that product will be available there. 

Note 

New versions, deletions and any changes made to the version list will only be applied 

when the product is saved. If you close the data record window without saving changes, 

the version list will be reset. 

This also holds for adopting versions from another product. 

 

 

Add new version: Here you create a new version for the product. 

 Version name: Enter the desired name for the version here. 

 Release date: Specify the release date here. 

 Qualified for support: Remove the check mark for unsupported versions. Such 

versions will be marked as Not qualified for support in the ticket's version list. 

 Delete version: Here you delete the selected version. Prior to deletion you will be 

prompted to confirm. After saving the product, the version will no longer be available 

in tickets and product uses. Data records in which the version has already been entered 

will retain the entry at first. When you open the data record in its window, the Version 

field will be reset. If you proceed to save the record, the version will be dropped. 

 Sort list: Use the arrow buttons to change the order of list items. 
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 Adopt product versions: If you wish to use an existing version list for the current 

product, specify here the product whose versions you wish to use.  

The selected product's versions will be displayed in the current product and may be 

modified here. Changes will directly affect the other product's version list. 

 Open product: If a product was entered, you open its data record window here. 

 Search product: Here you select a product in the Search window. Select the desired 

product in the list and enter it by clicking Accept & Close. 

 This feature is not available in products whose versions have already been 

adopted by other products. 

 Products that already adopt another product's versions will not be found. 

 If versions have already been entered, they will be deleted. In this case, you will 

be asked for confirmation before the version list is adopted. 

 Delete link: Here you delete the link to the version list. Afterwards, you may record 

separate versions for the product. 
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5.2 Product uses, service agreements and maintenance billing 

Product uses and service agreements are available in all tickets created for a customer. 

Maintenance fees are calculated on the basis of the product price and maintenance rate.  

With Easy Invoice, you can create maintenance bills and transfer them to your ERP or 

financial accounting system. 

 A product use assigns a product to a customer and states the applied quantity and 

version. You also specify whether the product was adapted for the customer. 

 In a ticket, the product and version are automatically entered when a product use is 

selected. 

 Service agreements cover a customer's product uses. 

In the Management Console, you can activate response deadlines and submission 

permissions for contacts by priority. Both are recorded in the service agreement. 

 When you are using response deadlines, those are displayed in the ticket depending 

on its priority. 

 When you are using submission permissions, the selection of available priorities 

depends on the submitter. 

 You may only create or change the special links between a service agreement and the 

associated product uses via the product use list in the service agreement or via the 

Service agreement link field in a product use. 

Via the Link with and New link features in the toolbar of the data record windows and 

lists for service agreements and product uses, you can only create general links. 

Product uses linked to a service agreement only via a general link will not be displayed 

in the list of associated product uses in the service agreement and will not be included 

in maintenance bills (see next section). 

This limitation preserves the consistency of the data for maintenance billing. Only if the 

data records are linked via the product use list in the service agreement or via the 

Service agreement link field in the product use it can be ascertained that the service 

agreement and all product uses have the same currency (see next section). 

 Maintenance billing for service agreements is optional, as is the use of response 

deadlines and submission permissions. 

 The maintenance amount is calculated from the maintenance rate as a proportion 

of the prices of the products linked via product uses. You can enter default values 

for the maintenance rate for agreement types (service level) and billing interval in 

the Management Console. You can also specify a discount per agreement. 

 When you are reselling maintenance agreements, you can have the contribution 

margin calculated in the product use. To do this, enter the purchased service 

agreement as a product and assign it to the serviced product in the General tab via 

the Maintenance item link field (see "Maintenance item" on page 51). 
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In the maintenance item, you specify the Purchase price for one year of service. The 

difference between the maintenance amount for the product use and the 

maintenance item's purchase price yields the contribution margin. 

 You may specify a different maintenance rate, price, discount and contribution 

margin per product use. 

 You determine the Currency of a service agreement and any associated product 

uses in the Maintenance tab of the data record window for the service agreement. 

Product uses with a different currency are not possible. 

You can change the currency of a service agreement and associated product uses via 

the Tools menu of the service agreement if this feature has been activated in the 

Miscellaneous area of the Management Console unter Products. To do this, select 

the desired currency and, if desired, specify a conversion rate. 

 With the Easy Invoice module, you can create maintenance bills and transfer them to 

your ERP or financial accounting system (see section "5.4.5 Maintenance billing with 

Easy Invoice" on page 72 of this manual and the Easy Invoice manual available in the 

CAS genesisWorld knowledge hub under https://hilfe.cas.de/index-en.html). 

https://hilfe.cas.de/index-en.html
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5.3 Product uses in the Desktop Client 

In product uses, you record which customer utilizes which product in which quantity and 

version, and whether the product has been modified. 

The following sections describe the features for product uses: 

 5.3.1 Views and features for product uses (page 56) 

 5.3.2 Creating a product use (page 56) 

 5.3.3 The data record window for product uses (page 57) 

 5.3.4 Automatic update of the service agreement (page 61) 

 5.3.5 Updating prices (page 61) 

 5.3.6 Automatically applying a changed product price (page 63) 

5.3.1 Views and features for product uses 

The following standard features are available for product uses. 

 Data record window with General, Maintenance, Change log and Dossier tabs. 

 Currency for maintenance billing, is copied from the service agreement. 

For service agreements with product uses, you can change or convert the currency 

via the Tools menu in the service agreement's data record window if this feature has 

been activated under Miscellaneous > Products in the Management Console. 

 General links to any other data records 

 Creation in the New menu, in the toolbar of data record windows and list views as well 

as via the Product uses list in a service agreement 

 Global Search in all fields such as Customer, Product and Serial number. 

Configurable via Settings > Search; search toolbar abbreviation PU 

 Views in the program navigator (list, dossier) and in the link navigator (link list) 

5.3.2 Creating a product use 

Proceed as follows to create a new product use. 

 In the New menu, select the Product use item. Then enter the associated customer 

and, if applicable, the service agreement via the search. 

 Via the New link menu, you can create a product use directly for a customer or service 

agreement. In the service agreement's data record window, you may also use the New 

link button above the Product uses list. 
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5.3.3 The data record window for product uses 

In the General tab, you record the core data of the product use. In the Maintenance tab, 

you supply information for maintenance billing. 

 

General 

 Customer: Specify the customer here. When you create a product use for a service 

agreement or an address, the customer will be entered automatically. 

 Search address: Here you select the customer in the Search window. 

 Open address: Here you open the entered address. 

 Contact person as customers: In the default setting, you may only enter companies 

and individual contacts as customers. Creating a product use for a contact person 

will enter the associated company as customer. You may change this to allow 

contact persons as customers (see "Customer and submitter" on page 150.) 
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 Service agreement: Here you specify the service agreement for the product use. When 

you create a product use for a service agreement, it will be entered automatically. Once 

a product use has a currency, the service agreement's currency must match. 

 Search service agreement: Here you open the Search window for selection. Only 

service agreements with matching currency will be available for selection. 

 Open service agreement: Here you open the entered service agreement. 

 Delivery on: State here when the product was delivered to the customer. 

 Start and end of maintenance: In product uses for service agreements, you specify 

here from when to when the customer is entitled to support for the product. 

A product use is active as long as it is already valid (Start of maintenance <= 

"Today") and not yet expired (End of maintenance > "Today"). 

If you leave one of the fields blank, the associated condition is also considered to be 

fulfilled. A product use in which both fields are blank is always active. 

Only active product uses will be available in the ticket form as well as in Helpdesk 

online and will be considered in the calculation of the Maintenance amount and 

Contribution margin when the associated service agreement is updated. (see 

"Maintenance" on page 70. 

Maintenance bills created with Easy Invoice will also only include active product uses 

(see "5.4.5 Maintenance billing with Easy Invoice" on page 72.) 

 Terminated on: If the customer has terminated the associated service agreement, 

specify the termination date here. 

 Product: Here you specify the used product. 

Note 

Only products matching the associated filter will be found. 

By default, these are all products for which the Active option has been selected in the 

General tab. You can change the associated filter condition in the Management Console 

under Miscellaneous > Products (see "11.3.6 Products" on page 186). 

 

 Quick search: Enter all or a part of the subject or number of the product for which 

you are looking in the Product field. Use the "%" character as a placeholder. It is 

automatically added at the end of you search term. For example, you can look for a 

product whose number contains the digits "001" using the search term "%001". 

Confirm with the [Return] key. If your search term can be associated with exactly 

one product, that product is entered. If multiple products were found for the entered 

search term, you are prompted to select the desired product. 

 Search product: Here you select a product in the Search window. 
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 Open product: If a product was entered, you open its data record window here. 

 Number: When a product is entered, its product number will be entered here. 

 Quantity: Here you specify the quantity of product units the customer utilizes. 

 Adaptation exists: Here you specify whether the product was modified for the 

customer. 

 Version: All versions recorded for the selected product are available here. 

 Serial number: Where applicable, enter the product's serial number here. The serial 

number will be displayed along with the product description when selecting the 

product use in a request. 

 Maintenance status: For product uses in service agreements, you specify here whether 

the customer is currently entitled to support for the product. 

The Active and Cancelled options are available as input help items.  

 Notes: Here you record notes for the product use. 
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Maintenance 

 

 Maintenance rate and discount 

 Maintenance rate in % from the service agreement. Via Differing mainentance 

rate in % you may enter a different maintenance rate for this product use. 

 Discount in % from the service agreement. Via Differing discount in % you may 

enter a different discount for this product use. 

 Product and maintenance charge 

 Price from the product, if a price in the service agreement’s currency has been 

entered for it. Otherwise, no price is adopted. Via Differing price you may enter a 

different price for this product use. 

 Currency from the service agreement. All product uses for a service agreement 

share the same currency. Product uses with a different currency are not possible. 

You can change the currency of a service agreement and associated product uses via 

the Tools menu in the service agreement's data record window if this feature has 

been activated in the Management Console under Miscellaneous > Products (see 

"11.3.6 Products" on page 186). 

To do this, select the desired currency and, if desired, specify a conversion rate. 

 Quantity for the product use as specified in the General tab. 

 Maintenance price: Maintenance price per piece for the product, according to the 

Price, Maintenance rate in % and Discount in %. 

 Product: maintained product. You may open it here. 

 Maintenance charge: Sum of maintenance costs (Quantity * Maintenance price). 
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 Contribution margin and maintenance item 

 Contribution margin in %: the contribution margin’s proportion of the 

maintenance charge. 

The contribution margin is the difference between the maintenance charge and the 

purchase price for maintenance, which can be entered per piece via a maintenance 

item. If no purchase price is specified via a maintenance item, the contribution 

margin amounts to 100%. 

Via Differing contribution margin in % you may specify a different contribution 

margin for this product use. You may then edit the Contribution margin in %, 

Purchase price and Contribution margin fields. If you edit any of these fields, the 

other two fields will be calculated based on the field you changed, potentially 

overwriting a purchase price entered via a maintenance item. 

 Purchase price from the maintenance item or calculated purchase price if a 

Different contribution margin in % has been entered. In this case, the purchase 

price will be calculated by dividing the Contribution margin by the Quantity. 

 Contribution margin: Contribution proportion of the Maintenance charge, whose 

amount corresponds to the Contribution margin in % (e.g., Contribution margin 

in % = 40, Maintenance charge = 200, yields a Contribution margin of 80). 

 Maintenance item: When you are reselling service agreements, you can record the 

purchased service agreement as maintenance item of the serviced product to 

calculate the contribution margin (see "Maintenance item" on page 51). 

If a maintenance item has been entered and is displayed here, you may open it here. 

 Description: Enter a text for maintenance billing here. 

5.3.4 Automatic update of the service agreement 

When you save a product use, the Maintenance charge and Contribution margin fields 

of the associated service agreement will be updated automatically in the following cases: 

 Maintenance charge or Contribution margin of the product use have changed (e.g., 

due to a change of the maintenance rate, discount, price, quantity or contribution 

margin in the product use). 

 The service agreement of the product use was changed via the associated link field in 

the General tab. In this case, the previous and the new service agreement of the 

product use will be updated when the product use is saved. 

5.3.5 Updating prices 

When you save a product for which product uses exist after changing the price, or when 

you change the purchase price in the associated maintenance item, a list of the associated 

product uses will be displayed. 
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The list will only display such product uses for which the changed price or purchase price 

wasn’t overwritten via the Differing price or Differing contribution margin in % option. 

 

The product uses will not be updated automatically. 

To update the displayed product uses, select them and click on the Update prices button. 

Alternatively, you may select the product uses to update, right-click to open the context 

menu and select its Update prices option. 

 

This option is always available in the context menu for product uses. 
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5.3.6 Automatically applying a changed product price 

If you open the Maintenance tab of a product use belonging to a service agreement after 

the price of the associated product or the purchase price of the associated maintenance 

item has been changed, when the prices of the product use have not yet been updated via 

the Update prices option and have not been overwritten via the Differing price or 

Differing contribution margin in % option, you will be asked whether the new price 

should be applied. 

 

If you select the Keep current price information unchanged option for the product 

price, the Differing price option will automatically be selected in the product use. 

If you select the Keep current price information unchanged option for the purchase 

price of the maintenance item, the Differing contribution margin in % option will 

automatically be selected in the product use. 
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5.4 Service agreements in the Desktop Client 

In service agreements, you record products utilized by the customer as well as the 

associated agreements for response times, availability and contact persons. 

The following sections describe the features for service agreements: 

 5.4.1 Views and features for service agreements (page 64) 

 5.4.2 Creating a service agreement (page 64) 

 5.4.3 The data record window for service agreements (page 65) 

 5.4.4 Update service agreements (page 71) 

 5.4.5 Maintenance billing with Easy Invoice (page 72) 

5.4.1 Views and features for service agreements 

The following standard features are available for service agreements. 

 Data record window with General, Response time, Contact persons, Maintenance, 

Change log and Dossier tabs 

 Currency for maintenance billing, is copied to associated product uses. 

For service agreements with product uses, you can change or convert the currency 

via the Tools menu in the service agreement's data record window if this feature has 

been activated under Miscellaneous > Products in the Management Console. 

 General links to any other data records 

 Creation in the New menu and in the toolbar of data record windows and list views 

 Global Search in all fields such as Subject, Customer and Number. Configurable via 

Settings > Search; search toolbar abbreviation SA 

 Views in the program navigator (list, dossier) and in the link navigator (link list) 

5.4.2 Creating a service agreement 

Proceed as follows to create a new service agreement. 

 In the New menu, select the Service agreement item. Then enter the associated 

customer and, if applicable, other contacts. 

 Via the New link menu, you can create a service agreement directly for an address. 

When you do, you will be prompted to select the desired link type, e.g., Customer. 

To save a service agreement, you need to specify a customer. You may enter other 

contacts in the service agreeement's data record window. 
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5.4.3 The data record window for service agreements 

In the General tab, you record core data for the service agreement. The Response time 

and Contact persons tabs are for recording agreements concerning tickets. Information 

for maintenance billing goes to the Maintenance tab. 

Note 

The Response time and Contact persons tabs as well as the Product uses list are only 

displayed after you have saved the service agreement. In addition, the tabs are only 

displayed if the associated features are switched on (see "Use service agreements, 

response deadlines and submission permissions" on page 152.) 

General 

 

 Subject: Specify here a subject to display in lists and for searching. 

 Number: Here you generate the next free number. You enter numbering settings jin 

the Management Console under Miscellaneous > Numbering. 
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 Service level: Here you record the type of agreement. The options Gold, Silver and 

Platinum are available via an input help. You may store presettings for response 

deadlines and hotline hours by service level in the Management Console under 

Helpdesk > Service agreements (see "11.2.4 Service agreements" on page 174.) 

 Country and federal state: Specify here the country and federal state in which the 

service agreement is valid. You may see and modify the presettings for those two fields 

in the Management Console under Helpdesk > Service agreements. 

In tickets, the country and federal state are used to determine the public holidays to be 

accounted for in the calculation of the response deadline.  

You can add other countries by importing holidays as .hol files in the Management 

Console under Miscellaneous > Activities > Calendar (see "11.3.1 Activities (holidays 

for service agreements)" on page 180). 

 Status: Here you specify whether the service agreement is currently valid. The options 

Active and Cancelled are available as input help items. 

 Terminated on: For terminated service agreements, enter the termination date here. 

 Area: Here you distinguish service agreements for different business areas. 

 Customer: Specify the customer here. When you create a service agreement for an 

address, the customer will be entered automatically. You need to enter a customer to 

save the service agreement. 

 Search address: Here you select the customer in the Search window. If product 

uses have been entered, you will be asked whether the new customer should also be 

updated in the product uses. 

 Open address: Here you open the entered address. 

 Contact person as customers: By default, only companies and individual contacts 

may be entered as customers. Creating a service agreement for a contact person, 

will enter the associated company instead. In the Management Console, you may 

enable contact persons as customers (see "Customer and submitter" on page 150.) 

 Contact person (general / delivery): Here you may specify customer contacts. 

 Search address: Here you select the contact person in the Search window. 

 Open address: Here you open the entered address. 

 Identical contact person for delivery: Select this option to have the general 

contact person double as delivery contact person. 

 Billing address: Specify here the recipient of maintenance bills. 

 Search address: Here you select the billing address in the Search window. 

 Open address: Here you open the entered address. 

 Start and end of maintenance: Here you record the agreement's validity period. 
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If you don't enter your own filter for service agreements in the Management Console 

under Helpdesk > General, a default filter by these two fields applies to tickets created 

in Helpdesk online (see "Filter for service agreements" on page 152). No default filter 

applies to tickets created in the CAS genesisWorld Desktop or Web clients. 

 Notes: Here you record notes for the service agreement. 

 Product uses: The Product uses list will be displayed after saving. Here you can see all 

product uses for the service agreement. They will be displayed in the ticket and 

accounted for in maintenance billing. 

 Refresh: Here you refresh the list to apply changes made to the product uses. 

 Link with: Here you select product uses in the Search window. Only product uses 

with matching currency will be available for selection. 

 New link: Here you create a new product use for the service agreement. 

 Remove link: Here you remove the selected product uses from the service 

agreement. The product uses will not be deleted by this. 
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Response time 

In the service agreement's Response time tab, you clear priority levels and enter agreed 

response times and hotline hours for each level. 

You may edit the available priority levels via the input help for the job's Priority field in 

the Database module of the Management Console. 

The priority levels and associated settings can be preselected for new service agreements 

depending on the Service level in the Management Console under Helpdesk > Service 

agreements. There you also enter other presettings and clear priority levels for requests 

without a service agreement (see "11.2.4 Service agreements" on page 174). 

When a service agreement is selected in a request, only priority levels that have been 

cleared in the service agreement will be available for selection. 

 

 You clear a priority level and enter a response time and hotline hours for it as follows: 

 Select the desired Priority level in the associated menu. 

 Click Add. 

 Enter the maximum response time. 

 Select the associated hotline hours. 

 Display hotline hours: Here you display the selected hotline hours. 

 Remove priority level: Here you remove the priority level from the selection. It will no 

longer be available in a request when this service agreement is selected. You may clear 

the priority level again at a later time. 
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Contact persons 

In the Contact persons tab, you specify which contact person has submission permissions 

for which priority levels. Once you have selected at least one contqact here, only selected 

contacts are permitted to submit requests. The service agreement will then only be 

available for selection for requests in which one of the contacts selected here has been 

entered as submitter. 

 

 Select contact persons from linked company: Here you select contact persons of the 

customer company to give them submission permissions. 

 Select any contact person: Here you select contact persons of other companies to 

give them submission permissions. 

 Remove contact person from list: Here you remove contact persons you have already 

selected. Clicking on the button opens the Remove contact person from list window, 

in which you select the contact persons to remove. 

 Give contact persons submission permissions: Enter the desired submission 

permissions via the table. 

By clicking a field in the All row or column, all associated fields will be selected 

automatically. Please note that this only affects explicitly selected contacts and doesn't 

entail submission permissions for contacts that have not been selected or priority levels 

added at a later time. 
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Maintenance 

 

 Maintenance charge and contribution margin: If product uses exist, these fields are 

calculated based on all active product uses linked to the service agreement and the 

associated products (see "Start and end of maintenance" on page 58). You can find 

details about the calculation of the maintenance charge and contribution margin for a 

product use under "Maintenance" on page 60. 

When the automatic calculation is active and the user has writing permissions for the 

service agreement as well as service level reading permissions for product uses and 

products, the two fields are updated automatically with the data of the associated 

product uses when the Maintenance tab is first opened and when the service 

agreement is saved. 

After changing the service agreement links of product uses, any affected service 

agreements will be updated when one of them is saved. 

You may also have the fields recalculated by selecting the Update service agreements 

option from the context menu of the the service agreement list. Only product uses and 

products for which you have reading permissions will be considered and only active 

product uses will be included. 

If no product uses exist or the automatic calculation has been deactivated, the two 

fields may be edited freely. You may activate or deactivate the automatic calculation in 

the Management Console under Helpdesk > Service agreements. 

 Maintenance charge: The maintenance fee billable per year, quarter or month. 

When product uses exist, this fee is calculated from the maintenance rate, the prices 

of products assigned via active product uses as well as the discount, if specified. 

 Contribution margin: When reselling service agreements, enter the purchase price 

of the service agreement for a product via a maintenance product. The contribution 

margin is automatically calculated for all active product uses from the purchase 

prices of the maintenance products entered for billed products and displayed here. 
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 Maintenance rate in %: The Maintenance rate may be preallocated depending on the 

billing period and service level. 

If the Maintenance rate in % field is empty, when you select a service level in the 

General tab and a billing period in the Maintenance tab, the associated mainenance 

rate will be entered automatically. Determine the preallocations in the Management 

Console under Helpdesk > Service agreements > Default by service level. 

Changes of the maintenance rate will be applied to all associated product uses for 

which no differing maintenance rate has been specified. 

 Discount in %: If applicable, enter an agreed discount here. 

Changes of the discount will be applied to all associated product uses for which no 

differing discount has been specified.  

 Currency: Here you select the currency of the service agreement as long as it doesn't 

have linked product uses. The selected currency will automatically be inherited by any 

product uses created for the service agreement. Product uses with a different currency 

are not possible. 

For service agreements with product uses, you can change the currency of the service 

agreement and associated product uses via the Tools menu in the service agreement's 

data record window if this feature has been activated in the Management Console 

under Miscellaneous > Products (see "11.3.6 Products" on page 186). 

To do this, select the desired currency and, if desired, specify a conversion rate. 

 Last bill: When the service agreement is billed via the service agreement list, the 

current date is automatically set to be the date of last billing. 

 Next billing: The next billing date is calculated from the last billing date and the billing 

period when the service agreement is billed. 

 Bill per: Select the billing period Month, Quarter or Year. It serves for calculating the 

Next billing date. You can use it for automatic notification about due bills. 

5.4.4 Update service agreements 

Via the context menu for the service agreement list, you can have the maintenance 

amount and contribution margin recalculated: 

 Update service agreements: Select this to recalculate the Maintenance charge and 

Contribution margin fields for all selected service agreements. 
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5.4.5 Maintenance billing with Easy Invoice 

With Easy Invoice, a freely configurable billing of service agreements is available. 

Configuration 

You can configure the maintenance billing under Extended receipt creation in the Easy 

Invoice area of the Management Console. Click New to create a new configuration and 

enter the following settings: 

 In the Receipt creation tab, select the data records to bill, receipt type, links for the 

customer and invoice recipient as well as settings for the date and print documents: 

 

 Select Product uses as data records to bill. 

 Under Name, name the menu option for billing. Via the associated button, you can 

enter translations for other languages. 

 Select the desired Receipt type. 

 Under Create receipt per, select whether to create an invoice per receipt recipient, 

product use or service agreement. This selection affects the following other settings: 

 The selection of address links for the receipt (Customer and Differing recipient). 

 The selection of fields in formulas for receipt fields under Default value receipt. 

 The selection of fields to set for the data records to bill under Set field values. 
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 Under Customer link, select the desired customer link or determine it via a formula. 

Depending on your selection under Create receipt per, you have access to address 

links of the billable product use (create receipt per receipt recipient or product use) 

or of the billable service agreement (create receipt per service agreement) in the 

drop-down menu and in the formula. 

 Under Conflicting recipient, select the desired link for a differing recipient or 

determine it via a formula. 

With the default setting, Customer address invoice recipient, the address that has 

been assigned to the selected Customer link address as Invoice recipient, if that 

link has been set, will be linked with the receipt as Differing recipient. 

Depending on your selection under Create receipt per, you have access to address 

links of the receipt recipient (create receipt per receipt recipient), of the product use 

(create receipt per product use) or of the the service agreement (create receipt per 

service agreement) in the drop-down menu and in the formula. 

 Under Date, determine whether the current date or a user entered date should be 

entered as receipt date. 

 Under Bill in advance, specify whether and how many days ahead billing should be 

possible without asking for confirmation. With this setting, a warning is displayed 

when trying to bill a service agreement at an earlier time. The service agreement can 

still be billed in this case. 

 Under Print documents, specify whether print documents should be created right 

away. Otherwise, a print preview is initially available for each receipt. 

You can then create the print documents via the associated button in the data 

record window for a receipt or via the context menu for receipt lists. 

After all receipts have been created, they will be displayed in a result list. You can 

immediately create the print documents here via the associated context menu. 
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 In the Item creation tab, you configure the creation of receipt items for the product 

uses to bill. 

 

Per product use, you may create any number of receipt items. 

With the Aggregate identical items option, all receipt items for the same product will 

be combined to one common item automatically. This setting will affect items created 

for the same product use as well as items created for different product uses. 

 

Specify a product for each receipt item to create. 

Enter a formula for the product to bill that returns one of the Record ID or Product 

number fields of the product. 

Via Create an item optionally, you can enter a condition for creating this receipt item 

as a formula. In this case, the item will only be created when the condition is satisfied. 

Under Default value, you can preconfigure other fields of the receipt item. 
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To this end, you have access to fields of the product use, the maintained product, the 

maintenance item, the associated service agreement and addresses as well as other 

linked data records. 

If users are prompted to enter a receipt date, it is available as a variable under User 

input. Variables for international input help items are available under Values from 

input help options. You can use these to include input help items in your formulas 

regardless of the user language. 

You can use the AddInterval date function to specify the paymend period depending 

on the receipt date and the service agreement's billing interval (Bill per field). 

Please note that the accepted intervals of the AddInterval function are limited to 

Month, Quarter, Half year, Year and associated translations. 

The strings accepted in a client language are displayed in the formula editor in the hint 

for this function when running the client in that language.  

By default, the Bill per field of service agreements comes with the Month, Quarter, 

and Year values and corresponding translations for all installed languages. 

You can find an example configuration for billing the period entered in a service 

agreement in the "Example configuration" section on page 77. 

 In the Default value receipt tab, you can preconfigure field values for the receipts to 

create via formulas. 

 

Depending on your selection for the Create receipt per setting, you have access to 

fields and links of the customer address (create receipt per receipt recipient), the 

product use (create receipt per product use) or the service agreement (create receipt 

per service agreement). 
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 In the Set field values tab, you can change product use fields or, when receipts are to 

be created per service agreement, service agreement fields. By default, this serves for 

setting the Last bill and Next billing fields. 

 

Depending on your selection for the Create receipt per setting, you have access to 

fields and links of the product use to bill (create receipt per receipt recipient or per 

product use) or of the service agreement (create receipt per service agreement). 

When you are creating one receipt per service agreement, you can use the AddInterval 

date function once more for entering the next billing date based on the receipt date 

and the service agreement's Bill per field (e.g., one year after the receipt date). 

Please note that the accepted intervals of the AddInterval function are limited to 

Month, Quarter, Half year, Year and associated translations. 

The strings accepted in a client language are displayed in the formula editor in the hint 

for this function when running the client in that language.  

By default, the Bill per field of service agreements comes with the Month, Quarter, 

and Year values and corresponding translations for all installed languages. 
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Example configuration for billing per service agreement 

The following configuration supports billing the period entered in a service agreement 

and setting the service agreement's Next billing field based on the receipt date entered 

by the user and the service agreement's billing period. 

Item creation Formula 

Product IF {#Product.Maintenance item.Record ID} <> "" THEN 

{#Product.Maintenance item.Record ID} ELSE 

{#Product.Product.Record ID} 

Description "Maintenance for " + {Product use.Product} + "\n" + 

ToString(Round({Product use.Maintenance rate in %},2)) + "% / " + 

{#Service agreement.Service agreement.Bill per} + " of " + 

ToCurrencyString({Product use.Price}) + " " + IF {Product 

use.Currency} = "EUR" THEN "€" ELSE {Product use.Currency} 

Discount relative (%) {Product use.Discount in %} 

Price {Product use.Maintenance price} 

Purchase price {#Product.Maintenance item.Purchase price} 

Quantity {Product use.Quantity} 

Unit IF {#Product.Maintenance item.Record ID} <> "" THEN 

{#Product.Maintenance item.Unit} ELSE {#Product.Product.Unit} 

 

Default value receipt Formula 

Additional billing text "Licensee: " + {#Address.Customer.Company} + "\n\n" 

+ "Dear Sir or Madam,\n\n" + "for the software service agreement " 

+ {Service agreement.Service level} + " with the number " + {Service 

agreement.Number} + 

", we would like to charge the following for the period from " + 

ToString({@Receipt date}) + " to " + 

ToString(AddInterval({@Receipt date}, {Service agreement.Bill per}) - 

1) + ":" 

Paymend period (start) {@Receipt date} 

Paymend period (end) AddInterval({@Receipt date}, {Service agreement.Bill per}) - 1 

Subject "Maintenance bill " + ToString({@Receipt date}) + "-" + 

ToString(AddInterval({@Receipt date}, {Service agreement.Bill per}) - 

1) + " for " + {#Address.Customer.Company} 
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Set field values Formula 

Last bill {@Receipt date} 

Next billing AddInterval({@Receipt date}, {Service agreement.Bill per}) 

Billing service agreements 

As soon as a configuration for billing service agreements has been entered, every use who 

has been assigned an Easy Invoice license may bill service agreements or associated 

product uses via the context menu of the respective list. 

With a configuration entered for product uses, the associated option will be available in 

the Create receipt sub-menu of the context menu for the product use and service 

agreement list. 

When a service agreement is billed, all associated product uses will be considered. 

Updating the service agreement before billing is not required. 

 

Selecting a date 

Depending on your settings, the current date is entered or you will be prompted to enter 

the desired receipt date. When creating multiple receipts, the current or selected date will 

be entered for all receipts that are created. When a maximum of days before the start of 

the payment period has been configured, before which no receipts may be created, and 

the start of the payment period is farther in the future, a warning will be displayed. Billing 

will still be possible. 
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Result list 

After billing, a window with multiple tabs will be displayed. 

Depending on whether billing was successful, not all tabs will always be present. 

 Unbilled service agreements 

 Billed service agreements 

 Unbilled product uses 

 Product uses with invalid maintenance period (see note below) 

 Billed product uses 

 Receipts 

 Print documents 

 Receipts without a print document (the receipt was created without a print document 

or the creation of the print document failed due to lack of working memory. This can 

occur when processing a very large number of data records. Via the context menu for 

the receipt list, you may immediately create print documents for selected receipts.) 

Under Unbilled service agreements and Unbilled product uses, the reason why the 

records couldn't be billed are displayed when selecting an item: 

Note 

Please note that the maintenance start and maintenance end of service agreements are 

never checked and the maintenance start and maintenance end of product uses are 

only checked if you start billing via the context menu for service agreements. 
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5.5 Product uses and service agreements in the Web Client 

With the Service agreements and Product uses apps in the Service and support app 

group, you can see and edit existing service agreements and product uses as well as 

create new service agreements and product uses. 

 

 In the app start for the Service agreements or Product uses app, you have access to 

your service agreements or product uses as well as associated views. 

 Click on the eye icon to create a new service agreement or product use list view. 

 Click on a service agreement or product use to open the detail view. You can also edit 

or delete the service agreement or product use here. 

 Click on the plus [+] icon to create a new service agreement or product use. 

 Alternatively, you can create linked service agreements and product uses in the detail 

view of a contact or service agreement. 

 Service agreement for contact: […] > Create > Service agreement 

 Product use for contact: Link with > Product use > [+] 

 Product use for service agreement: [+] above the Linked product uses list 

 Please note that maintenance billing details will be displayed as read-only in the Web 

Client, and only if they have been calculated and saved in the Desktop Client. 

You can't calculate or update maintenance billing data in the Web Client. 

Click on the question mark at the top right to open the online help pages for more details. 
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6 Time records and reports 

The following sections describe the features for time records and the associated reports: 

 6.1 Time records in the Desktop Client (page 81) 

 6.2 Time records in the Web Client (page 95) 

 6.3 Reports (page 98) 

6.1 Time records in the Desktop Client 

The following sections describe the features for time records: 

 6.1.1 Views and features for time records (page 81) 

 6.1.2 Creating time records (page 82) 

 6.1.3 The data record window for time records (page 83) 

 6.1.4 Time record calendar (page 86) 

 6.1.5 Billing time records (page 90) 

 6.1.6 Defining hourly rates for addresses and projects (page 92) 

 6.1.7 Time record details in projects and jobs (page 93) 

 6.1.8 User settings for time records (page 93) 

6.1.1 Views and features for time records 

The following standard features are available for time records. 

 Data record window with General, Tree, Change log and Dossier tabs 

 Type for categorization 

 Status for billing and approval processes 

 Primary links to address, project and job, displayed in the tree view and in analyses 

 General links to any other data records 

 Creation in the New menu, the toolbar of data record windows and list views, the tree 

view and the time record calendar 

 Global search in all time record fields such as Subject, Start and End. Configurable via 

Settings > Search; search toolbar abbreviation TR 

 Views in the program navigator (list, dossier, calendar) and in the link navigator (link 

list, calendar) 

 Time zone support (Start and End fields in client time zone with Timezone module) 
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6.1.2 Creating time records 

You can create time records for addresses, appointments, documents, e-mails, holiday 

entries, jobs, opportunities, phone calls, projects and tasks. 

 Create time record: To create a time record for another data record, click on the 

Create time record button in the toolbar of its data record window or a list. 

 Start recording time: To start recording time in the background, proceed as follows. 

 Open the desired data record in the data record window or mark it in a list view. 

 Click on the little arrow next to the Create time record button to open the 

associated menu. 

 Select the Start recording time option in the menu. 

The data record window for a new time record opens. 

The To and Actual fields are updated automatically. 

A little green man next to the clock in the tray to the bottom right displays that time is 

being recorded. 

 Exit: By clicking this button next to the To field you stop the counter. You may now 

edit and save the time record. If you close the data record window without saving, 

the time record is dropped. 
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6.1.3 The data record window for time records 

 

 The time record's Subject will initially be transferred from the associated data record. 

As for any data record, you may modify it as desired. 

 User: Each time record has exactly one participant. When you create a time record, you 

will be entered here. After saving, the participant can no longer be changed. 

 The Type specifies the activity and determines internal and external hourly rates. 

 The time record type for tickets is selected in the Management Console under 

Helpdesk > General. By default, the Support type is used.  

 When you create a time record, the type of the associated data record is adopted if 

a time record type with the same exists. 

 The type may be modified as long as the time record has not been billed. 

 You may use the Status to implement billing and approval processes.  

 Start and End date: You may modify the start date as long as the time record has not 

yet been billed internally. 

The end date is adjusted automatically. You can not change it manually.  

In time records spanning two calendar days (e.g., from 6:00 PM to 2:00 AM), the end 

date is set to the following day. 
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 The Actual working time, which will be billed internally, is determined by the time 

record's duration that you enter via the date and the From and To fields. 

 Granularity and minimum: In the Management Console, you specify the time 

record granularity between 1 second and 1 hour. This is the precision of the From, 

To and Actual fields and therefore the smallest recordable period. 

 Maximum: The Actual working time to be recorded in a time record may amount to 

a maximum of 24 hours minus the granularity, spanning up to two calendar days. 

 Rounding: Time records below the specified granularity will automatically be 

corrected to the smallest admissible value. For example, with a granularity of 1 

minute, entries of 1 second will always be set to 1 minute. Above the specified 

granularity, time records are rounded commercially (e.g., with a granularity of 1 

minute, an entry of 0:01:30 will be rounded up to 2 minutes).  

 Start and end of new time records: Time records for appointments, phone calls 

and holiday entries will adopt the start and end of the associated data record. 

When you record time in the calendar, the marked interval will be adopted. 

Otherwise, the end of your previous time record will be entered as start and the 

current time will be entered as end. The first time record of the day will adopt the 

start of your working hours as start. 

 Working hours: The working hours are read from the settings provided in the 

Management Console under Time record > Working hours. 

For users for which no working hours have been entered there, the working hours 

stored in the user settings in the Calendar tab will be applied. 

 Person days (PD): In the default setting, a person day spans 8 hours. You may 

change this in the Management Console under Time record > General. 

 Overlap check: If overlaps with other time records are detected while trying to save 

a time record, a list of the overlapping time records is displayed. You can turn the 

overlap check off in the Management Console under Time record > General. 

 Charged: In addition to the Actual working time, each time record has an externally 

billable Charged order value. This is initially zero and may differ from the actual hours 

or be set equal to it. The order value isn't limited to 24 hours. 

 Apply Actual as Charged: Here you transfer the Actual value to the Charged field. 

 The Parent field displays as in other data records the time record's primary links. If 

desired, you may change the primary links using the associated features. 

 Internal and external description: Record here additional notes for the time record. 

The external description is provided for work reports. 

 Copy external or internal description: Here you overwrite the associated notes 

field with the content of the respective other field. 
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 To destination, from destination and break for appointments: Each user may 

activate the recording of trips to and from the destination and of a break for 

appointments (see "6.1.8 User settings for time records" on page 93. 

 

Select the respective option in the data record window. 

 To record the trip to the destination, enter the start or duration of the trip. 

 To record the trip from the destination, enter the end or duration of the trip. 

 If the trips to or from the destination should be billed externally, enter the billable 

period in the Charged field or apply the duration as order value by clicking on the 

Copy duration to charged time button. 

 To record a break, enter the start and end of the break. In the default setting, the 

pause stretches from 12:30 to 13:30. 

Trips to and from the destination will be created as separate time records when you 

save the record. If available, the Travel time type will be assigned automatically. If you 

specify a break, two time records will be created, one before and one after the break. If 

the total of Charged hours exceeds the Actual hours of the first record, the remainder 

will be booked on the second record. The Internal text and External text fields and all 

fields placed with Form Designer will be transferred to all time records created this way. 



Helpdesk   Time records and reports 

86 

6.1.4 Time record calendar 

You access the time record calendar via the program navigator, in the dossier and in the 

Time records tab of data record windows. 

 Program navigator and dossier: The calendar is available in both the program 

navigator's view wizard and the dossier's view wizard as Calendar for time recording. 

 Data record windows: The calendar is available in the Time records tab of the data 

record windows for addresses, projects, jobs, tasks, appointments, documents, phone 

calls and holiday entries. 

 Settings: In your user settings, under Modules and Solutions, you specify whether 

the Time records tab is displayed in data record windows. Here you also specify the 

view's presettings (see "6.1.8 User settings for time records" on page 93.) 

 

 Free time and working hours: Free time and working hours are displayed with the 

same colors as in the calendar view for appointments, holidays, jobs and phone calls. 

You may change the colors in the Settings under Calendar > Colors. 

Other color settings of the default calendar won't be used. 

If available, the current working hours as entered in the Management Console under 

Time record > Working hours are used. For users having no working hours set there, 

the working hours stored in the Settings in the Calendar tab are displayed. 
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 Colors 

 Yellow: linked time record 

 Blue: unlinked time record 

 Red: time record for current data record (in data record windows) 

Note 

Please note that a time record's associated data record can not be changed at a later 

time if it stands below the job level. A time record created for an appointment, for 

example, stays associated with that appointment, even if the time record's primary links 

change or a general link between the time record and another data record is created. 

Time records created for an address, a project or a job, as well as time records which 

were not created for another data record, may be assigned to another address, project 

or job by changing their primary links. 

 

 Select start date: At the top right, you select the view's start date. 

 Statistics: The statistics display information about your working hours and your time 

records in the displayed period and in the current month. 

 Working hours: your working hours in the displayed period. Below it, your total 

working hours in the selected month are given. 

 Recorded time: the total duration of your time records in the displayed period. 

Below it, the total duration of your time records in the current month is given. 

 Time records: the number of your time records displayed in the calendar. Below it, 

the number of displayed time records without an associated data record is given.  

 Select user: Here you access other users' calendars. 

 Close shared calendar view: Here you reset the view to display your own time 

records again. 

Creating and editing time records 

The following sections describe the features for creating and editing time records in the 

time record calendar. 

 Create new time record: Here you create a time record in the marked interval. 

Alternatively, you create a time record in the marked interval by right-clicking and 

selecting the Create new time record option in the calendar's context menu. 

 Create new time record from history: Select this from the context menu to create 

a new time record for one of the data records for which you have last recorded time. 

Only the primary links and the type of the original time record are adopted. 
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 Fill gaps: If you mark a period in which time records and gaps alternate and create a 

time record from history, each gap in the marked period will be replaced by a 

corresponding time record. 

This also applies when overlap checks are disabled for time records.  

 Create new time record for the corresponding record: Open a time record's 

context menu and select the Create new time record for the corresponding 

record option to create a time record for the same data record. 

 Change link: You may relink time records via the history. To do this, open the context 

menu by right-clicking on the time record whose link you wish to change. Select the 

desired option in the Change link sub-menu. 

 Open corresponding record: Here you open the data record for which the time record 

was created. 

 Open time record: Here you open the selected time record. Alternatively, you open 

time records by double-clicking on them or via the context menu. 

 Delete time record: Here you delete the selected time record. Alternatively, you delete 

time records via the context menu. Before the time record is deleted you are asked for 

confirmation. 

 Record appointments: Here you record time for all appointments in the displayed 

period. If there is a time record type of the same name, the type of each appointment is 

adopted as the type of the associated time record. 

 Record phone calls: Here you record time for all appointments in the displayed period. 

If there is a time record type of the same name, the type of each phone call is adopted 

as the type of the associated time record. 

 Record holiday: Here you record time for holiday entries in the displayed period. In 

the process, a separate time record is created for each day off, spanning from start to 

end of the participant's working hours. 

This operation will be available even if part of the holiday entry to record is farther in 

the future then time records may be created (see "Time window for the creation and 

editing of time records" on page 187) if time is to be recorded for a current holiday or a 

holiday starting on the next work day in the time record calendar. 

Note 

In the Management Console, under Time record > Calendar, you specify which 

appointment phone call and holiday types may be recorded here (see "11.4.3 Calendar" 

on page 190). 

If you wish to group holiday records by projects in reports, you may also select projects 

there for which leaves should be recorded. If a participant of such a project records his 

leave by clicking Record holiday in the calendar, the holiday records will be 

automatically assigned to the project. 
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 Print: Here you print the displayed calendar page. Please note that the Print option in 

the File menu is not supported here. Use the Print button in the view's toolbar. 

 Refresh view: Here you apply changes made to time records while the view was open. 

 Change points of time: move time records or change the duration via drag-and-drop. 

 Move time record 

 Click on the time record's start and hold the mouse button. 

 Holding the mouse button, move the pointer to the desired start time. 

 Change duration 

 Click on the time record's end and hold the mouse button. 

 Holding the mouse button, set the desired duration by moving the mouse. 

Creating a time record calendar in the program navigator 

You insert the view in your program navigator in the following way. 

 Right-click on the desired place to call up the context menu. 

 Select Create new view. The view wizard opens. 

 Select Calendar for time recording. Then click Next. 

 Enter the desired name for the view. Then click Next. 

 Start date 

 Today: In the default setting, the view displays the current date. 

 Previous week: With this option, the previous week will be displayed. 

 This date: With the Use current month or Use current year options, the current 

month or year is substituted. 

 Display mode: Select here whether the day or week display should be used and specify 

the desired detail level (hours, half hours, quarter hours or 5 minutes). 

 User: Select here the user whose time records should be displayed. Resources are also 

available for selection. 

 Complete the creation by clicking Finish. 
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6.1.5 Billing time records 

In a time record's data record window and in the list's context menu, you may bill time 

records internally or externally or undo billing. 

 Internal billing: When a time record is internally billed, the following information is 

written in the associated time record fields. 

 Internally billed by: user 

 Internally billed on: date and time 

 Internal hourly rate: the current internal hourly rate for the user and type 

 Actual costs: internal hourly rate times Actual; values are stored with up to 4 

decimals and displayed in lists and report views rounded to 2 decimals. 

In internally billed time records and without reading rights for the Billed internally by/ 

on fields, the Type, From, To, Actual and Start fields may no longer be edited. 

 External billing: When a time record is externally billed, the information is written in 

the associated time record fields. 

 Externally billed by: user 

 Exernally billed on: date and time 

 External hourly rate: the current external hourly rate for the user and type 

 Actual turnover: the external hourly rate times Charged; values are stored with up 

to 4 decimals and displayed in lists and report views rounded to 2 decimals.  

In externally billed time records and without reading rights for the Billed externally 

by/on fields, the Type and Charged fields may no longer be edited 

 Billing in the time record list: In the context menu for the time record list, you may 

access the Bill sub-menu. 

The Apply Actual as Charged and Set Charged to Null options are only available with 

writing permissions for the Charged field. Additionally, reading permissions for the 

Actual field are required for the Apply Actual as Charged option. 

The options Bill externally and Reset the bill externally option are only available 

with writing permissions for the Externally billed on and Externally billed by fields. 

The options Bill internally and Reset the bill internally option are only available with 

writing permissions for the Internally billed on and Internally billed by fields. 

You also need reading permissions for all time record fields in order to bill time 

records. 

 Apply Actual as Charged: Here you overwrite the Charged field with the Actual 

value in all selected time records. 

 Set Charged to Null: Here you reset the Charged field in all selected time records. 
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 Bill internally: Here you internally bill all selected time records. 

 Reset the bill internally option: Here you cancel internal billing. 

 Bill externally: Here you externally bill all selected time records. 

 Reset the bill externally option: Here you cancel external billing. 

 Billing in the data record window: In the lower third of the data record window for a 

time record, you can see the Internally billed by, Internally billed on, Externally 

billed by and Externally billed on fields. 

 Bill internally: Here you bill the time record internally or cancel internal billing. The 

button is only available with writing rights for the Internally billed on and 

Internally billed by fields. You also need reading rights for all time record fields in 

order to bill time records. 

 Bill externally: Here you bill the time record externally or cancel external billing. The 

button is only available with writing rights for the Externally billed on and 

Externally billed by fields. You also need reading rights for all time record fields in 

order to bill time records. 

 Billing in the report view: In the Billing tab of a report view's properties, you can turn 

on the billing features in the view: 

 Display button to internally bill time records 

 Display button to externally bill time records 

You can access the billing features via the Billing menu in the report view's toolbar.  

First select the desired time records in the view. The select the desired billing action in 

the Billing menu. This works like in the time rcord list. The same restrictions also apply. 

 Specify external billing date: With the Bill externally setting under Time records > 

General in the Management Console, you determine whether the external billing date 

may be modified. In this case, you can edit the Externally billed on field in the data 

record window and will be prompted to enter the billing date when billing time records 

externally via the time record list or report view. 
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6.1.6 Defining hourly rates for addresses and projects 

In the toolbars of the data record windows for each addresses and projects, the Hourly 

rates button is available. Here you define hourly rates for a customer and thereby for all 

associated projects or hourly rates for a project. You may specify different hourly rates for 

a company and associated contact persons. 

You may enter global hourly rates in the Time record area of the Management Console 

under Hourly rates. There, you also specify whether individual internal hourly rates may 

be entered for addresses and projects. By default, only individual external hourly rates may 

be entered for addresses and projects (see "11.4.4 Hourly rates" on page 191). 

Entering hourly rates for addresses and and projects requires the Time record: hourly 

rates right. You can assign it in the Management Console under User Management in the 

Other rights tab of the user's Properties dialog. 

Hourly rates for an address take precedence over global hourly rates. 

Hourly rates for a project take precedence over hourly rates for an address. 

 Hourly rates: Here you open the hourly rates view. 

 

 Transfer hourly rates: When internal hourly rates for addresses and projects have 

been activated in the Management Console, you may overwrite any values entered in 

the current view that are displayed in black with the respective values from the other 

view, Internal or External. This will also empty fields if the respective fields in the other 

view are empty. You may apply this change with OK or revert it with Cancel. 

 Select participants: Here you select the users and resources you wish to enter hourly 

rates for. Users and resources for which hourly rates have already been entered for the 

current address or project will be selected automatically. When entering hourly rates for 

a project, any other project participants will also be seelected. 

When you remove a participant with hourly rates entered in the current view (address 

or project) that are displayed in black, these will be deleted after confirmation.  

 Global hourly rates will be displayed in red. They are still valid for all users and types 

for which you have not specified different hourly rates. 
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 Hourly rates for the address will be displayed in blue when entering hourly rates for a 

project. They are valid in all projects for the address for all users and types for which 

you have not specified different hourly rates. 

 Entering hourly rates: See page 192 for details. 

 OK: Here you apply any changes you have made to the database. 

 Transferring changes made to the company to contact persons: If you change 

the hourly rates for a company, you will be asked whether the changes should also 

be transferred to the associated contact persons. In this case, the previous hourly 

rates for the contact persons will be overwritten. 

 Cancel: Here you revert any changes. 

6.1.7 Time record details in projects and jobs 

In the Details tab of the data record window for projects, you may lock the project for 

time recording (see "0 The Board view supports the following interactions. 

 Open radial menu by right-clicking on a card. 

 Change field value (group) by dragging a card to another column and dropping it. 

 Create data records by clicking on the plus button. 

Project details" on page 114). 

 Lock for time recording: When this option is set in a project, time records can no 

longer be created for that project. The Actual field in existing time records assigned to 

locked projects can no longer be modified. 

Note 

The flexible job hierachy isn't considered here. 

Sub-tasks of locked tasks won't be locked automatically as well. 

6.1.8 User settings for time records 

In your Settings, you configure the time record calendar in data record windows, time 

records for appointments and time records for tickets. These settings only affect you. 

To open your Settings, select the associated option from the Tools menu in either of the 

main or Search window or in any data record window. Then switch to the embedded Time 

records tab of the Modules and Solutions tab to edit time record settings. 
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Time record calendar in data record windows 

 

 Start date: Here you specify the start date of the time record calendar in the Time 

records tab of data record windows and in the dossier. 

 Display mode: Select here whether the day or week display should be used and specify 

the desired detail level (hours, half hours, quarter hours or 5 minutes). 

 User: Select here the user or resource whose time records should be displayed. 

 Show 'Time records' tab in data record windows: Display the Time records tab for 

addresses, projects, jobs, tasks, appointments, documents, phone calls and holidays. 

 For appointments, show time to and from destination: Here you specify whether 

panels for recording the time to and from your destination and a break will be 

displayed when you record time for appointments. 

 Open time record for tickets: In the default setting, time records created for tickets 

using the associated button in the top right of the ticket's data record window are 

created automatically, not requiring any additional user action. Select this option to 

open time records you create for tickets this way in their data record window instead. 
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6.2 Time records in the Web Client 

In the Web Client, you may record time via the following apps under Service and support. 

 6.2.1 Time record calendar (page 95) 

 6.2.2 Time records (page 97) 

6.2.1 Time record calendar 

With the Time record calendar app in the Service and support app group, you can see 

and edit time records for the current day or week. 

 

 Click on the associated tile to open the app. 

 

 The calendar can display time records, appointments, holiday entries and phone calls. 



Helpdesk   Time records and reports 

96 

Optionally, public holidays are also displayed. 

To select the data records to display and whether public holidays are displayed, click on 

the Settings button with the slider icon. 

 The statistic, like in the Desktop Client, displays your recorded time and working hours 

in the displayed period and in the current month. 

 Select a period or click a data record to create a time record. 

 When selecting a period, a history is available.  

 When clicking on on an out of office appointment, you can enter travel times to and 

from the destination and a break. 

 The Quick entry record past appointments, holiday entries and phone calls in the 

displayed period, including data records that are not currently displayed. 

Click on the question mark at the top right to open the online help pages for more details. 
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6.2.2 Time records 

With the Time records app in the Service and support app group, you can see and edit 

existing time records as well as create new time records. 

 

 In the Time records app start, you have access to your time records and associated 

views. 

 Click on the eye icon to create a new time record list view. 

 Click on a time record to open its detail view. You can also edit or delete it here. 

 Click on the plus [+] icon to create a new time record. 

 Additionally, you can create time records for most other data records. 

To do this, in the associated detail view, open the action menu with the three dots and 

select Create > Record time. 

Alternatively, you can record time via the radial menu for a data record in a list. 

Click on the question mark at the top right to open the online help pages for more details. 
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6.3 Reports 

With Helpdesk, you jave access to the Time records report for addresses, projects and 

jobs. Additionally, the Crystal Reports design Work report is available. 

 6.3.1 Time record report for addresses (page 98) 

 6.3.2 Time record report for projects (page 100) 

 6.3.3 Time record report for jobs (page 101) 

 6.3.4 Working with reports (page 102) 

 6.3.5 Editing reports (page 102) 

The reports will be added to the favorites of each user who is licensed for the Helpdesk 

module and has been granted the other right Time record: analysis. This way, they will be 

available in the associated menus for addresses, projects and jobs respectively, which you 

open by clicking on the little black arrow on the right side of the Report... button. 

 

Note 

You assign the required Time record: analysis right to users and groups in the User 

Management area of the Management Console, in the Other rights tab of the user's or 

group's Properties. 

6.3.1 Time record report for addresses 

The Time records report for an address displays all time records stored with the address 

as well as the associated projects and jobs. 
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Note 

The address report's default link mode is Overall dossier. In addition to directly linked 

records, all records linked to the same company or one of its contacts will also be 

displayed. You may change this setting (see "6.3.5 Editing reports" on page 102). 

 

 

 Other rights: Time record: analysis 

 Display fields: Actual, Charged, Actual costs, Actual turnover 

 Grouping row: Address, Project, Job, User, Type 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Work report 
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6.3.2 Time record report for projects 

The Time records report for a project displays all time records stored with the project as 

well as the associated jobs. 

 

 Other rights: Time record: analysis 

 Display fields: Actual, Charged, Actual costs, Actual turnover 

 Grouping row: Address, Project, Job, User, Type 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Work report 
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6.3.3 Time record report for jobs 

The Time records report for a job displays all associated time records. 

 

 Other rights: Time record: analysis 

 Display fields: Actual, Charged, Actual costs, Actual turnover 

 Grouping row: Address, Project, Job, User, Type 

 Grouping column: Start (Years), Start (Months) 

 Crystal Reports design: Work report 
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6.3.4 Working with reports 

In the table view, you may access nearly all features for processing your data that are 

available with a Manager license for the Report module, such as: 

 Filter via the arrow down button on the associated field 

 Add and remove display values; change the calculation function (Sum, Minimum, 

Maximum, Average) via the associated context menu 

 Add and remove grouping fields; regroup via drag-and-drop of fields 

 Change the sort order via the context menu for a grouping field (by group name or by 

display value) 

 Display as bar, area, pie or line diagram 

 Prepare for billing, billing and vendor credit notes (see Project user manual, "7.8 Billing 

in reports (Desktop Client only)"). 

 Export to Microsoft Excel or Microsoft Access, as an xml or html file 

 Create a report with Crystal Reports 

 

You can find details about the available features in the user guide for the Report module. 

The user guide's current version is available for download under the following URL: 

https://hilfe.cas.de/index-en.html. 

6.3.5 Editing reports 

You can edit most settings for the reports listed here. While you can't add or remove data 

record types via link queries, the following settings are editable: 

 Remove or add fields 

https://hilfe.cas.de/index-en.html
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 Reset Overall dossier mode to Normal for address reports in order to only display 

data records that have been linked directly. 

 Select more data (e.g. User data tab for time records and expenses) 

 Activate preparation for billing, vendor credit notes and billing features (Billing tab) 

 Preselect display and grouping fields (Visualization tab) 

 Select a Crystal Reports design 

 Enter Crystal Report Viewer settings for exporting and archiving created reports as 

documents in CAS genesisWorld (Crystal Reports tab) 

 

You can find details about the available features in the user guide for the Report module. 

The user guide's current version is available for download under the following URL: 

https://hilfe.cas.de/index-en.html. 

With a Report Manager license, you can duplicate the reports. The duplicates may then be 

edited freely, including adding or removing data record types via link queries. 

https://hilfe.cas.de/index-en.html
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7 Planning views in the Web Client 

In the Web Client, you have access to the following planning views with Helpdesk: 

 7.1 Team planning (page 104): Scheduling for teams 

 7.2 Timeline view (page 109): Chronological order of data records 

 7.3 Board view (page 112): Group data records by field values 

7.1 Team planning 

The Team planning app is available under Service and support in the Web Client: 

 

Instead of clicking on the associated tile, you can also open the app out of a ticket: 

 

The app will then display the ticket's subject and highlight associated appointments. 

Appointments created in the app will adopt the ticket's subject and be associated with it. 

The option to add participants from the parent project is ignored here. 
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The following sections describe the presentation and features of the Team planning app. 

 7.1.1 Presentation and editing of appointments (page 105) 

 7.1.2 Change display mode and focus (page 106) 

 7.1.3 Change display date (page 107) 

 7.1.4 Change view settings (page107) 

 7.1.5 Display in map (page 108) 

 7.1.6 Create appointment (page 108) 

 7.1.7 Collapse or expand user list (page 108) 

7.1.1 Presentation and editing of appointments 

The app displays a row for each selected user. Appointments (blue) and holiday entries 

(grey) are displayed per user and day on a timeline. Hints display appointment and holiday 

entry details. Public holidays are displayed with red captions. 

  

 Click an appointment to open the associated editing view.  

 Drag an appointment within a row to move it on the timeline. Please note that this is 

only possible for appointments that are completely displayed. 

  Drag an appointment's left or right edge within a row to change its start or end. 

 Drag an appointment between rows to replace a participant by another one (e.g., drag 

from a placeholder resource to a user to assign that user to the appointment, see 

"Resource as placeholder" in section "7.1.4 Change view settings" on page 108). 

 Select a period to create a new appointment. Alternatively, click on the plus icon at the 

top right to create an appointment (see "7.1.6 Create appointment" on page 108).  

 Holiday entries are displayed as grey bars and can't be opened or edited in the app. 
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 Overlaps are displayed as light grey bars. Click on the grey overlaps bar or the arrow at 

the left edge of the associated row to expand all overlapping appointments and 

holidays.  

 Icons displayed for appointments indicate various properties:  

 Recurring (part of a series) 

 Private 

 Confidential 

 Out of office 

 One or more external participants 

 One ore more participating groups 

7.1.2 Change display mode and focus 

The view displays the appointments of a day, week or month. 

Click Day, Week or Month to change the view mode: 

 Day 

 The timeline displays the day above and hours below. 

 The precision for displaying and editing appointments are quarter hours.  

 Initially, the first displayed hour is focussed and displayed with a greater width. 

Click on the column header of another hour to switch the focus. 

 Week 

 The timeline displays the days of the selected week. 

 The precision for displaying and editing appointments are hours.  

 Initially, the current day (or Monday if the current week is not displayed) is focussed 

and displayed with a greater width. 

Click on the column header of another day to switch the focus. 

 Month 

 The timeline displays weeks above and days below. 

 The precision for displaying and editing appointments are days.  

 Initially, the current week (when opening the view) or the first displayed week (after 

switching the date) is focussed and displayed with a greater width. 

Click on the column header of another hour to switch the focus.  
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7.1.3 Change display date 

In addition to the view mode, you can select a date via the buttons at the top left: 

 Click Today to jump to the current date. 

 Click this to select a date in the calendar. 

 Alternatively, use the timeline below the view to switch to another date. 

7.1.4 Change view settings 

Using the slider, filter and user icons, you can change various view settings. 

 Click this to change view settings: 

 Visibility of weekends 

 Working hours to be displayed (start and end); please note that you can't drag 

appointments starting or ending outside displayed working hours. 

 User employee address filter field (via filter icon at top right, see below); requires 

users to be linked with employee addresses. 

Any fields with multiple selection (checkbox list) input helps will be available. 

 User employee address grouping field (users will be grouped by this field); requires 

users to be linked with employee addresses. 

Any fields with single selection input helps will be available. 

 Resource as placeholder (displayed in a separate row to schedule appointments not 

yet assigned to a specific user. Drag such an appointment to the desired user to 

assign that user to that appointment). 

 Color classification (select a field with a single selection input help to assign colors to 

field values. You may select the Type and Status fields individually or in 

combination. Select the Type / Status item to assign a color to each type and each 

type/status combination). 

Changes will only be applied after confirming your selection by clicking Apply both 

in the Color classification and View properties windows. 

Please note that, with a color classification by fields values, appointments for a ticket 

for which you opened the team planning view will no longer be highlighted by color. 

 Click this to filter the displayed users by the employee address filter field selected in 

the settings. Selecting multiple items will filter the view such that only users with all of 

these items will be displayed. For instance, if you filter users by language and select 

multiple languages, only users knowing all selected languages will be displayed. 

  Click this to select the users to display. 
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7.1.5 Display in map 

Click on the map icon to display all appointments with a georeferenced primary address in 

the map view. 

 Click this to display the appointments of the team planning view in the map view. 

 On the right hand side, a list of the appointments is displayed. 

 Click on the location of one or more appointments to filter the list. 

 Click on the location again to display all appointments again. 

 Click on an appointment in the list to show its location on the map and other details. 

 For locations with only one appointment, details of that appointment will also be 

displayed when you hover over the location.  

 Use the toolbar to change the period or participants of the appointments to display.  

7.1.6 Create appointment 

Click on the plus icon or select the desired period (see "7.1.1 Presentation and editing of 

appointments" on page 105) to create an appointment. 

 Click this to create an appointment. Initially, you will be entered as participant. If a 

planning resource is selected, it will initially be entered as participant instead. 

7.1.7 Collapse or expand user list 

Click on the left arrow button above the user list to collapse it. The list will be displayed 

with a smaller width, showing only the user images stored in the associated employee 

addresses. 

Click on the button again to display the user list with full width again, showing user 

images, names and descriptions. 

 Click this to collapse or expand the user list. 
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7.2 Timeline view 

The following sections briefly outline the availability, visualization and features of the 

Timeline view, which is available in CAS genesisWorld Web with Helpdesk. 

 7.2.1 Licensing (page 109) 

 7.2.2 General (page 109) 

 7.2.3 Options (page 110) 

 7.2.4 Interactions (page 111) 

7.2.1 Licensing 

When Report, Project or Helpdesk is licensed, the Timeline view is available in the Web 

Client (for Project and Helpdesk, activation in the Mangement Console isn’t required). 

7.2.2 General 

The Timeline view displays the chronological order of data records with a start and finish. 

 

With either of the associated licenses, you may open the view out of saved list views for 

any type of data records with a start and finish. 

Other than the standard data records type with a start and finish in CAS genesisWorld, the 

view will display any data record type with date fields named START_DT and END_DT. 

 To open a Timeline view for the data records displayed in a saved list view, click on the 

three horizontal bar at the top left to open the view menu and select Timeline view. 
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Notes 

This feature is only available for saved list views listed under Views in the associated 

app. It isn't available for combined list views, list views with a link filter or list views that 

are currently filtered via the Search... field. 

The opened view always contains all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

All settings will be restored when next opening the view. Configurations are saved per 

list view and user, such that other users can’t overwrite your view settings. 

 

7.2.3 Options 

In the Timeline view, you have the following options. 

 Interval: Days, Weeks or Months. 

 Start date: Today, selection in the calendar or via the time bar below the view. 

 Settings 

 Visibility of weekends (Visible/Not visible). 

 Working hours to be displayed (start and finish for each day). 

 Number of columns in day, week and month view. 

 Use field for the grouping. 

 Use field for the color classification and select colors for field values. 



Helpdesk   Planning views in the Web Client 

111 

7.2.4 Interactions 

The Timeline view supports the following interactions. 

 Open data record via left-click on a bar. 

 Change start and/or finish via drag-and-drop. 

 Create data records with the plus button or by selecting a period with the mouse 

while holding the left mouse button. Not supported for all data record types. 
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7.3 Board view 

The following sections briefly outline the availability, visualization and features of the 

Board view, which is available in CAS genesisWorld Web with Helpdesk. 

 7.3.1 Licensing (page 112) 

 7.3.2 General (page 112) 

 7.3.3 Settings (page 113) 

 7.3.4 Interactions (page 114) 

7.3.1 Licensing 

When Report, Project or Helpdesk is licensed, the Board view is available in the Web 

Client (for Project and Helpdesk, activation in the Mangement Console isn’t required). 

7.3.2 General 

The Board view displays the grouping of data records by input help items of a field. 

 

With either of the associated licenses, you may open the view out of saved list views for 

any type of data records that have at least one field with input help items. 

The view is available for both standard and custom data record types. 

 To open a Board view for the data records displayed in a saved list view, click on the 

three horizontal bar at the top left to open the view menu and select Board view. 
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Notes 

This feature is only available for saved list views listed under Views in the associated 

app. It isn't available for combined list views, list views with a link filter or list views that 

are currently filtered via the Search... field. 

The opened view always includes all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

Only assignments of field values that are available as input help items will be displayed. 

Data records with field values which are not or no longer available as input help items 

will be displayed as Not assigned. 

All settings will be restored when next opening the view. Configurations are saved per 

list view and user, such that other users can’t overwrite your view settings. 

 

7.3.3 Settings 

The following Settings are available for the Board view. 

 Use the following field for grouping: Select here the field whose values will be 

displayed as columns for grouping the data records. 

 Use the following type for grouping by Status: If you select the Status field for 

grouping and the status depends on the type, status assignments will only be 

displayed for a specific type, which you select here in this case. 

Items with other values in the Type field will not be displayed in this case. 

 Display the following column values of the grouping: Display or hide columns for 

specific field values here. 
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 Use the following field for the sorting: Select here the sorting field for records within 

a column. In addition to fields of the displayed data record type, you may sort by the 

first or second row as defined for that data record type in the App Designer with the 1. 

row and 2. row items. 

Sorting by the second row is always supported regardless of whether it is actually 

displayed in the board view (see Also display the following field on the card). 

 Use the following field for the sum row: Select the number of cards or a field to 

display as sum in the header row here. 

 Offer currency fields in the base currency: When you select a currency field for the 

sum row (e.g., Total for opportunities), this option will be available for converting data 

records with foreign currencies to your base currency and summing up column totals. 

This requires entering conversion rates from the base currency to the currencies of all 

displayed data records in the Miscellaneous area of the Management Console under 

Currencies (see "11.3.2 Currencies" on page 181). 

Note 

This feature isn't supported for fields of the money data type. 

Such fields will always be displayed in the base currency. 

 

 Also display the following field on the card: The first row on each card can't be 

configured and is defined by the associated App Designer setting for the displayed 

data record type. For the second row, you may select between the App Designer 

configuration (default setting 2. row) and fields of the data record type. 

 Use the following field for the color classification: Select a color classification field 

here. This can be the grouping field or another field with input help items. Once you 

have selected a field, you can also select colors for individual field values. 

 Use the following field for the user picture: Select a user field here to display the 

associated picture on each card. 

7.3.4 Interactions 

The Board view supports the following interactions. 

 Open radial menu by right-clicking on a card. 

 Change field value (group) by dragging a card to another column and dropping it. 

 Create data records by clicking on the plus button. 
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8 Project details 

With Helpdesk, different features are available in the Details tab of the data record 

window for projects than those available there by default. 

 

The calculation displayed here by default is dropped, since reports based on time records 

are available in the Report menu with the Helpdesk module. 

The following features supplement the Details tab with Helpdesk. 

 Project management 

 Project status / Explanation: The project status is available in the General tab 

without Helpdesk as well with CAS genesisWorld Premium. With the Helpdesk 

module, the project status is also displayed in the Details tab. Here you can also 

store a comment about the project status in the Explanation field. 

 Lock for time recording: When this option is selected, no additional time records 

can be created for the project and the Actual field in existing time records for the 

project can no longer be modified. 

 Project manager (customer): Link the customer company's project manager here. 

 Responsible (comm.): Sales executive. 

 Project directory: Directory for documents or other additional information for the 

project. You can display this directory in the project's tree view.  

 Last contact 

 Last contact on / Contact person / Last contacted via: These fields are available 

here without Helpdesk as well with CAS genesisWorld Premium. The information is 

updated when certain appointments, phone calls, e-mails and documents are 

created for the project. In the Management Console, under Miscellaneous > Last 

contact, you specify in which cases a contact is recorded. 
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9 Using project and job templates 

The following sections describe the features for project and job templates: 

 9.1 Using project templates (page 116) 

 9.2 Editing a template (page 118) 

 9.3 Editing a project in the data record window (page 123) 

 9.4 Adding or continuing a workflow (page 124) 

 9.5 Using job templates (page 124) 

9.1 Using project templates 

When you create a project, the selection of project templates opens first. 

 

Under All templates, you can see all templates to which you have access. Select a folder 

in order to only display the templates it contains. 

 Continue with selection: Here you create a project from the selected template. 

 Continue without a template: Here you create a project without a template. You can 

add a template later (see "9.4 Adding or continuing a workflow" on page 124). 

 Always create projects without a template: Select this option to disable template 

selection. You can reactivate in your settings (General > Deactivated messages). 

 Cancel: Here you close the template selection without creating a project. 

In the User Management area of the Management Console, you can assign permissions 

for reading, inserting, changing and deleting of project and job templates. 



Helpdesk   Using project and job templates 

117 

9.1.1 Creating and editing templates 

For creating and editing templates, the following features are available here. 

 Create new template: Here you create a new template in the template editor. 

 Import project as a template: Here you open a list for selecting the project to import. 

The selected project is loaded into the template editor with its tree structure. 

 Edit template: Here you open the selected template in the template editor. When you 

click OK in the template editor, changes are saved and you get back to the template 

selection. 

 Delete template: Here you delete the selected template. The Continue workflow 

feature will then no longer be available for associated projects (see "9.4 Adding or 

continuing a workflow" on page 124). 

 Duplicate template: Here you create a copy of the selected template. 

 Change access rights for template: New templates are initially owned by the user 

who created them. Here you open the Select team window in order to set access 

permissions to the template. The Standard permission is used. 

9.1.2 Organizing templates in folders 

For organizing your templates in folders, the following features are available here. 

 Create folder: Here you create a new folder. 

 Move template to folder: Hold mouse button while dragging a template to a folder. 

 Detach template from folder: To detach a template from a folder, open the folder 

and hold the mouse button while dragging the template to the All templates entry. 

 Rename folder: To rename a folder, select it and click it again. 

 Delete folder: Here you delete the selected folder as well as any contained folders,  

project and job templates. Please note that the same folders are used for project and 

job templates, so it's possible to delete templates not visible in the current view. 

 Change access rights for template: New folders are initially public. Here you open the 

Select team window in order to set access permissions to the folder and all subfolders. 

This permission only entitles users to see the folder structure. Separate permissions are 

distributed for the contained templates. 
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9.2 Editing a template 

In the template editor, you create and edit project and job templates. 

The template editor opens when you create a new project or job from any template in 

which the Create template directly option is not selected. 

 

 Create template directly: Select this if projects created from this template should 

open the template editor first. 

 OK: Create the project from the template (Create project window), confirm creating 

additionally selected project steps (Continue workflow window) or save changes in the 

template and get back to the template selection (Edit template window). 

 Cancel: Cancel creating or extending the project or editing the template without 

committing your changes. 

9.2.1 Editing a project in the tree view 

The following features are available in the tree view and the associated toolbar. 

 Insert data record: Click on the symbol of a data record type to create a new data 

record of this type for the selected data record. 

 Jobs are created in the project or in another job. 

 Tasks are created in the project or in a job. 

 Appointments are created in the project or in a job. 
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Note 

Creating appointments via project and job templates isn't supported when you are 

using the Exchange sync module. 

 

 Phone calls are created in the project or in a job. 

 Documents are created in the project or in a job from templates. Select a template 

and click OK. Click Edit template in the data record editor to the right in order to 

open the document template in the associated data record window. 

 Exclude data records from creation: In the box next to each data record, you control 

whether the data record will be created along with the project or job. 

 Continue workflow: Data records that were excluded from creation at first can later 

be added by clicking on the Workflow button in the toolbar of the data record 

window for projects (see "9.4 Adding or continuing a workflow" on page 124). 

 Automatic creation: In the Automatic creation tab, to the right of the template 

editor, you select status options whose assignment to the project causes the data 

record selected to the left to be created automatically (see "Automatic creation by 

status" on page 122). 

 Modifying links and order of data records: Via drag-and-drop, you can change a 

data record's association or the data records' order. To do this, click on the entry to 

move and, while holding the mouse button, drag it to the desired place. 

 Change association: Drag a data record on the project or on another job. 

 Change order: Drag a task, an appointment, a phone call or a document to another 

data record of one of these four data record types to insert the first after the latter. 

 Association and order of jobs: If you move one job onto another, a menu opens. 

Here you select whether the moved job should be inserted before, after or in the 

target job as its sub-job. 

 Deleting data records from the template: You delete the selected data record from 

the template by clicking on the Delete button in the toolbar, by pressing the [Del] key 

or via the context menu. Before deletion you are asked to confirm. Like all changes, the 

deletion is only applied when the template is saved. 

 Open tree: Here you expand all branches. 

 Close tree: Here you close all branches. 

 Save changes in the template: When creating or editing a template, clicking OK saves 

the template. When creating a project or job from a template, changes are not saved 

automatically. In this case, click Save changes in the template to save the changes. 

 Check time relations: Here you check the consistency of entered time relations (see 

"Entering time relations" on page 120.) Any insosistencies will be displayed. 
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9.2.2 Editing data records in the data record editor 

In the default setting, the data record editor is displayed to the right. Via the General and 

More tabs you access any preallocatable fields. 

Note 

Input helps of the Selection tree type are not fully supported in the Category field. If 

such an input help has been entered for this field, only top level items will be available 

for selection. 

 

The following sections describe special features of the data record editor. 

 Transfer participants: This is available for jobs, tasks, appointments, documents and 

phone calls. Here you assign to the selected data record the participants and resources 

as well as the Maximum external access right of its parent data record. 

 Using roles as placeholders: By clicking on the Participants button you open the 

selection of participants. In addition to users and resources, roles are available here. 

These are replaced by users and resources when the project is created. Via the list to 

the left you create roles, delete or rename existing roles. Via the Rights button you 

limit data record access for the user assigned in a role. The External access menu is 

synchronous with the Maximum external access right menu and serves for limiting 

external access rights of other users to data records of the future participant. 

 Entering time relations: When a project is created from a template, the current point 

of time is inserted as the project start. The project end results from the duration which 

you specify in the template. The project start and end may be modified in the project's 

data record window when it is created. 

When you save the project, all other data records will be created. You either specify 

associated dates as fixed dates to be entered when the project is created from the 

template or as time relations depending on the project start or end. 

 Specifying the project duration: Click on the Project end button to open the 

Enter time relation window. 
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Select Query date when creating new records if users should be prompted to 

enter the project end whenever a project is created from the template. Under 

Default value, you may also enter a default value for the project end.  

Select Enter a date in relation to a fixed time (days, months and years) in order 

to enter the project's duration instead of the project end. The Ignore weekends and 

holidays option only affects the days specified. The options for other points of 

reference are disabled when entering the project end as you can only refer to the 

project start here. 

 Specifying the start and end of other data records: Select a data record in the 

tree view. Then click on the button with the date you wish to specify in the data 

record editor. The Enter time relation window opens. 

 

Select Query date when creating new records if users should be prompted to 

enter the date whenever a project is created from the template. Under Default 

value, you may also enter a default value for the date. 

Select Enter a date in relation to a fixed time (days, months and years) in order 

to enter the date in relation to a point of reference. Like when entering the project 

end, the Ignore weekends and holidays option only affects the days specified.  

Then select the desired point of reference. 

With the Current date option, you may refer to the respective date of creation for 

data records you exclude from creation at first in order to add them later via 

Automatic creation by status or Continue workflow. 

Moreover, the beginning and end of the project as well as the beginning and end of 

any other associated data records are available for selection unless a time relation 

referring to the current record has already been entered for them. When you enter 

the end date, you may also refer to the beginning of the data record itself like when 

entering the project end. 

 Set time: For jobs, tasks, appointments and phone calls, you set the reminder time 

in relation to the data record's start or end. 

 Variables for address fields, project subject and roles: The following sections 

describe the inclusion of placeholers in data record fields. 
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 References to fields: You may refer to any fields of all parent data records in the 

Subject and Notes fields. References will be replaced when the record is created if 

the required links are present (e.g., the project has a primary address). 

The references must be of the form [Data record:Field]. 

For example, [Address:Company] will be replaced by the company name of the 

primary address. 

 Roles in text fields: Roles created in the team selection may be embedded in text 

fields (e.g., to enter the selected project manager in the Person responsible field). 

The references must be of the form #Role#Name. 

For example, #Role#Project manager will be replaced by the user selected for 

the Project manager role. 

 Automatic creation by status: Data records initially excluded from creation may be 

created automatically when the project is saved with a status for which this is intended. 

If roles are included, the user is asked to select participants and resources. 

If you have assigned a type to the project in the data record editor, the associated 

status options will be available for selection for other data records in the Automatic 

creation tab. Here you select the status options whose selection in the project should 

cause the selected data record to be created automatically. 

 Create with all subordinate data records: Select this option if the automatic 

creation of a job should include the creation of its subordinate data records. 
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9.3 Editing a project in the data record window 

After selecting a template and specifying any additional information that may be required, 

the project opens it its data record window. 

 

 Adjust start and end: The current date is automatically entered as start. The end is 

defined by the duration entered in the template and may only be modified after saving. 

If you modify the start prior to saving, the end is shifted accordingly. 

 Save project: If desired, make further entries for the project. Save it in a final step by 

clicking Save or Save&Close. 

Any other data records in the template that were not excluded are now created. 
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9.4 Adding or continuing a workflow 

Using the Workflow button in the toolbar of the related data record window, you extend 

a project in the template editor. To do this, the project template that was used must still 

exist. For projects not created from a template or whose template was deleted in the 

meantime, the template selection opens first. 

The template editor opens in the Continue workflow mode in any case. 

 Data records that were already created can no longer be modified here. 

 All data records that have not yet been created or that have meanwhile been deleted 

are available for creation. 

 Data records under a job cannot be created without the associated job. The same holds 

true for items in item groups. 

 All features of the template editor are fully accessible in this view. However, changes 

made to the template cannot be saved. 

 Select the data records to create by clicking in the boxes next to them. 

 Confirm the project's extension by clicking OK. 

If you have selected data records for creation to which roles have been assigned, you are 

now asked to select the intended participants and resources. 

9.5 Using job templates 

For job templates, the same features are available as for project templates. 

9.5.1 Project and job templates 

The following segments briefly describe the interaction, differences and similarities of 

project and job templates. 

 Job templates in projects: You may use job templates in different projects regardless 

of the use of project templates. When a process changes, you only need to adjust one 

job template instead of several project templates. 

 Job templates without projects: Jobs from templates may also be used without an 

associated project. 

 Turning off the template selection: The template selection for jobs may be turned off 

independently from the template selection for projects. 

 Continue workflow: In the toolbar of the data record window for jobs, the Workflow 

button is available as it is for projects. Click this to extend a job created from a template 

or to add a template to a job which was initially created without using a template. 
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9.5.2 Specifics when using job templates 

The following specifics apply to job templates. 

 

 Template folders for projects and jobs: The same folders are used for project and job 

templates. Deleting a folder will also delete any project and job templates it contains. 

Please note that you may delete templates not currently visible this way. 

 Job is point of reference for all time relations: When you enter time relations, the 

topmost job is the point of reference for any other data records. You therefore start by 

entering the job's duration. All other data records relate to the job or to other data 

records associated to the job. 

 Not available for tickets: Job templates aren't available for tickets. The Type selection 

for a job template is filtered such that it doesn't include ticket types. 
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10 Helpdesk online 

The following sections describe the installation, configuration and usage of the Helpdesk 

online support portal: 

 10.1 Installing Helpdesk online (page 126) 

 10.2 Configuring Helpdesk online (page 127) 

 10.3 Cookies (page 128) 

 10.4 Invocation and language selection (page 129) 

 10.5 Logging on, activating the account and logging off (page 129) 

 10.6 Personal area (page 133) 

 10.7 FAQ search (page 134) 

 10.8 Request lists (page 137) 

 10.9 Detail view and actions (page 138) 

 10.10 Creating a request (page 141) 

 10.11 User menu (page 144) 

 10.12 Modifying the appearance (page 145) 

 10.13 Log file (page 146) 

10.1 Installing Helpdesk online 

A separate setup is available for Helpdesk online. You can find it on the CAS genesisWorld 

DVD or in the respective download in the "Portals" folder. 

To install Helpdesk online, start the setup and execute the following steps. 

 The setup first checks whether the CAS genesisWorld client and server as well as the 

.NET Framework 4.6.2 are installed. This is required for installing Helpdesk online. 

If not all required components are present, click Cancel, click Yes to confirm, then click 

Finish to abort the installation. 

Install the missing components and restart the setup. 

 Confirm the message saying that the required components are available. 

 Confirm the license agreement. 

 You will be prompted to select the desired database and log on with a CAS 

genesisWorld user with Administrator permissions. 

 When Helpdesk online is accessed via the associated URL, the application will 

connect with the database specified here. 
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 You can switch Helpdesk online to another database. To do this, start the setup 

again and select Change. Confirm the individual steps of the wizard and select the 

desired database. 

 After the database has been adapted, you will be prompted to specify the desired web 

page and the associated virtual directory. 

 You will be  prompted to enter the installation directory. 

Note on Microsoft IIS 

Helpdesk online requires Microsoft IIS (Internet Information Services) as web server. 

Other web servers are not supported. If the IIS Windows features aren't active, they will 

be activated automatically when Helpdesk online is installed. 

 

 Helpdesk online will now be installed. After successful installation, the application will 

be available in the selected virtual directory on the computer, on which you have 

installed Helpdesk online. 

10.2 Configuring Helpdesk online 

You configure Helpdesk online in the Management Console. 

The most important settings are under Helpdesk > Helpdesk online: 

 Under Requests, you enter one or more types of new requests like "Change request" or 

"Question". In the process, you specify precisely which data the user may or must enter. 

 Also under Requests, you enter actions that allow users to modify a request in 

Helpdesk online. Filters make sure that the selection of available actions matches the 

type and status of the request. 

 Under Lists, you enter an arbitrary number of list views. Filters specify which requests 

are displayed in each list. 

 Under Detail view, you specify whether documents stored with requests are available 

online and whether a service agreement is displayed in the detail view. 

 Under FAQ, you activate or deactivate the FAQ search and enter settings for it. 

 Under Personal area, you may enter a web page with additional information that will 

be accessible as the first or last navigation item in Helpdesk online. 

Other Management Console settings for Helpdesk online: 

 The language selection under Helpdesk > Notifications and languages is regarded in 

Helpdesk online. With the associated language resources, Helpdesk online will be 

available in all languages selected there. The language resources must be installed on 

the application server used for Helpdesk online. 
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 Sending e-mails for the Forgot your password feature on the logon page as well as 

requires the configuration of a system e-mail account (Management Console Rules > 

Server settings). 

 Additionally, most other settings in the Helpdesk area of the Management Console 

affect Helpdesk online. 

The configuration of Helpdesk and Helpdesk online in the Management Console is 

described in chapter "11 Management Console settings" on page 147. 

Section "2.6 Setting up access for Helpdesk online" on page 37 provides details about 

setting up access and about address links relevant for Helpdesk online. 

10.3 Cookies 

Helpdesk online stores the following cookies on the client side: 

 ASP.NET_SessionId (temporary, when logging on): Controls the active session. 

This cookie will be deleted automatically when closing the browser. 

 HelpdeskOnline (while active, when logging on): Selecting Remember logon data 

and logging on will create a cookie containing the user name and encrypted password. 

When the user accesses Helpdesk online again, he will be logged in automatically. 

When the user logs off, the encrypted password will be removed from the cookie. 

In this case, the user name will be retained and automatically entered when the user 

accesses Helpdesk online again. 

This cookie will be preserved until the user logs off, deactivates Remember logon data 

and logs on again, or until it is actively deleted. 

 HelpdeskOnlineLanguage (permanently, when opening the logon page or 

changing the setting): Stores the language (see following section) to select it 

automatically when Helpdesk online is accessed again. 

This cookie will be preserved until it is actively deleted. 

 UserSettings (permanently, when logging on or changing the setting): Stores user 

settings to restore them when logging on to Helpdesk online again. 

 Access level for displaying requests in lists (all / own company / only own), see 

Views > Submitter on page 137. 

 Selection of Display only my products when creating a new request, see Product 

information on page 142. 

This cookie will be preserved until it is actively deleted. 

Saving the HelpdeskOnline, HelpdeskOnlineLanguage and UserSettings cookies 

requires that Helpdesk online internally uses an HTTPS connection in IIS. 
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10.4 Invocation and language selection 

Helpdesk online is accessible with most internet browsers supported by CAS genesisWorld 

Web via desktop computers, laptops, tablets and other mobile devices. 

The page layout is optimized for small screens on mobile devices. This depends on the 

device's resolution and is determined whenever Helpdesk online is accessed. 

Helpdesk online starts with the logon page unless users are already logged on or use a 

logon link (see next section). 

If you have selected additional languages in the Helpdesk area of the Management 

Console under Notifications and languages (see "11.2.7 Notification and languages" on 

page 178) and a CAS genesisWorld client with the required language resources is installed 

on the computer on which Helpdesk online runs, the user may also select the desired 

language here. 

 If cookies are enabled and a secure connection (HTTPS) is used, the selected language 

will be saved in a cookie (see "10.3 Cookies" on page 128). 

 If the user has already logged on and the language cookie is still present, the previous 

language selection will be retained. 

 When a user first logs on or has deleted the language cookie, Helpdesk online will 

default to the browser language, English, the database language, or the first available 

language, in this order, depending on availability: 

 By default, the browser language will be selected. 

 If the browser language isn't available, English will be selected. 

 If English isn't available, the database language will be selected. 

 If the database language isn't available, the first available language will be selected. 

10.5 Logging on, activating the account and logging off 

Most Helpdesk online features require logging on. 

 The FAQ search may be available without logging on: 

 You may enable this feature in the Management Console by selecting status options 

of FAQ items available without logging on (see "FAQ" on page 170). 

 The following features require users to log on: 

 Personal area 

 Request lists and detail view 

 Actions (changing the status, commenting on tickets and uploading files) 

 Creating new requests 
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 As user name, the address field E-mail (business) will be requested by default. You 

may change this setting in the Management Console under Helpdesk > Helpdesk 

online (see "User name" on page 155). 

 Users set their own Password when activating their accounts (see following page). 

Alternatively, you can enter a password for a company contact or individual contact in 

the Details tab (see "2.6 Setting up access for Helpdesk online" on page 37). 

Here you also select the contact's access level (Helpdesk online). If access hasn't been 

enabled, the contact will not be able to log on or activate the account. 

 Remember logon data: Store the user name and password in a cookie (see "10.3 

Cookies" on page 128). 

 The next time the user accesses Helpdesk online, he will be logged on automatically. 

 When the user logs off, the cookie will be preserved without the password. The next 

time the user accesses Helpdesk online, the user name will be entered automatically. 

The password must be reentered. 

 When the user unchecks the Remember logon data option and logs on again, the 

cookie will be deleted. 

 This feature requires that Helpdesk online internally uses an HTTPS connection in IIS. 

 Forgot your password: Here users enter their e-mail address to receive an e-mail with 

a link for resetting their password. If the e-mail address can be assigned to an address 

with access to Helpdesk online in CAS genesisWorld, the user will receive this e-mail. 

Users will also receive a confirmation e-mail after changing their password.  

To send the e-mails, the system e-mail account configured in the Rules area of the 

Management Console under Server settings will be used. 

If no system e-mail account has been configured, this feature won't be available. 
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Note 

The subject and content of the German e-mails for resetting the password and notifying 

users about the password change are stored in the PasswordResetMail.tpl and 

PasswordChangedMail.tpl  files under Config in the installation directory for 

Helpdesk online. For all other supported languages, e-mail templates with the same 

name and the file extension for the respective language are stored in this directory (e.g., 

English versions PasswordResetMail.tpl.en, PasswordChangedMail.tpl.en). 

Please do not directly edit these files. If you wish to make changes, copy the files to the 

.\Custom folder in the Helpdesk online installation directory and make the desired 

changes to the copies. If copies exist in the .\Custom folder, they will be used instead 

of the original files. 

The e-mail templates use variables for the salutation (@salutation@) and the link for 

resetting the password (@passwordresetlink@) which should always be included in 

the e-mail templates. 

 

 Activate account: Users whose account has been enabled without assigning a 

password can activate their account via the Activate account link. 

You can enable an account and select the desired access level via the Helpdesk online 

field in the Details tab of a company contact or individual contact (see "2.6 Setting up 

access for Helpdesk online" on page 37). 

Section "12.1 Helpdesk online account enabling notification" on page 195 describes 

setting up a notification rule for sending customers an activation link when their access 

is enabled by selecting an access level in the Helpdesk online field. 

Note 

The subject and content of the German e-mails for activating the customer's account 

and for confirming the activation are stored in the ActivationMail.tpl and 

AccountActivatedMail.tpl files under Config in the installation directory for 

Helpdesk online. For all other supported languages, e-mail templates with the same 

name and the file extension for the respective language are stored in this directory (e.g., 

English versions ActivationMail.tpl.en, AccountActivatedMail.tpl.en). 

Please do not directly edit these files. If you wish to make changes, copy the files to the 

.\Custom folder in the Helpdesk online installation directory and make the desired 

changes to the copies. If copies exist in the .\Custom folder, they will be used instead 

of the original files. 

The e-mail templates use variables for the salutation (@salutation@) and the link for 

resetting the password (@activationlink @) which should always be included in the 

e-mail templates. 
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 Blocked support entitlement: Contacts of blocked companies as well as blocked 

single contacts will not be able to log on to Helpdesk online (see "2.5 Blocking support 

entitlement" on page 36).  

 Logging on automatically: Users can skip the logon page and directly log on via the 

AutoLogin.aspx page using the LoginField, PWField and Language 

parameters (e.g., https://helpdesk.example.com/Helpdesk/AutoLogin.aspx? 

LoginField=jack.bauer@nomosys.co.uk&PWField=cas&Language=en). 

This page may also be called via POST. 

 LoginField: user name, which is the contact’s business e-mail address by default. 

 PWField: password, stored in the contact’s Password field. 

 Language: two letter ISO Code of any enabled language (see page 129). 

 Logging off: After successfully logging on, the user menu in the upper right corner will 

be added to the navigation bar at the top. Users can log off via the user menu. 

To work with Helpdesk online again, a user must log on again, even if the Remember 

logon data option has been selected. You can find more features of the user menu 

under "10.11 User menu" on page 144. 
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10.6 Personal area 

If you have entered a title and URL for a personal area in the Management Console under 

Helpdesk > Helpdesk online > Personal area, it will be displayed as the first or last item 

in the navigation, depending on your settings. 

This way, for instance, you can include an internet page with information about handling 

problems or links to a user documentation. 

 

With the Use as start page after logon option, the personal area will be displayed first. 

Without this option, the page will be displayed last (see "Personal area" on page 172). 
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10.7 FAQ search 

If the FAQ search has been activated in the Management Console, users may open it by 

clicking on the FAQ button in the navigation menu. Depending on your settings, the FAQ 

search may also be available without logging in to Helpdesk online. 

 

In the Helpdesk area of the Management Console, under Helpdesk online > FAQ, you 

determine the following FAQ search settings (see "FAQ" on page 170). 

 Status options for displaying the FAQ search with or without logging in 

 Search fields with option to limit them in Helpdesk online 

 Display fields and default sorting for the result list 

 Date field format: only date or date and time 

 Number of items when opening the FAQ search: You may configure the FAQ search 

to display the FAQ documents with the latest Date when it is opened. 

 Number of results per page when searching 

 Allow filtering in columns: When a search term is entered in the Filter field above a 

column, the result list will only display items where the search term matches in this 

column. 

 Allow grouping: When a column header is dragged into the grouping area above the 

result list, this column will be grouped by the items in the associated column. Dragging 

the column header back into the result list will remove the grouping. 
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 Show language selection (language filter): Multiple selection of languages entered 

in the Document language field of available FAQ documents. The No language item 

will also be available for displaying FAQ documents without a Document language. 

Via Select all, users may select all languages and the No language option. 

The following features are available for searching and in the result list: 

 Select a product, product version and feature area: When a product is selected, 

menus for entering the version and area will appear. The selection of a product, version 

and area limit the search results. If the user doesn't select a product, FAQ documents 

for all products will be found. If he selects a product but neither a version nor an area, 

FAQ documents for all versions and areas of the selected product will be found. 

 Link search terms with: Here the user selects whether all (AND) or at least one (OR) of 

the entered search terms must appear in the sought document. 

 Search: Here the user enters his search terms. If set up accordingly, he may also select 

which fields to search. When you are searching with AND, only entries in which each of 

the search terms appears in one of the searched fields will be found. When you are 

searching with OR, all entries in which a search term appears in one of the search fields 

will be found. The percent character % serves as a placeholder for a character string of 

arbitrary length. The placeholder character will automatically be inserted at the 

beginning and end of each search term. This way, search terms which are not whole 

words will also be found. 

If the user doesn't enter a search term, all FAQ documents with a status configured for 

display will be found. To display all FAQ documents for a given product, version or area, 

the user enters the desired selection with the associated menus and leaves the search 

field blank.  

 Opening the FAQ detail view: Clicking on an item in the result list will open the 

associated detail view: 

 

 Opening or downloading files: If a file has been stored with an FAQ document, users 

can open or download it by clicking on the link under Documents at the lower right. 
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Sending links for opening an FAQ item 

The FAQDetails.aspx page can also be opened directly via the following links in 

order to display a specific FAQ document. 

https://helpdesk.example.com/Helpdesk/FAQDetails.aspx?gguid={gguid} 

https://helpdesk.example.com/Helpdesk/FAQDetails.aspx?faqnumber={docnumber} 

Replace https://helpdesk.example.com/Helpdesk/ by your Helpdesk online 

system URL. Replace {gguid} or {docnumber} by the associated field value. 

Helpdesk online supports both formats (with GGUID and docnumber). 

If you wish to use the notification and action service to notify users about newly created or 

modified FAQ documents, only the first of the two links listed above will work. Other than 

inserting the URL of your Helpdesk online installation, the link may be typed in as listed 

above, with the {gguid} variable, including the curly brackets. 

Please also regard the instructions for setting up notifications in section "12 Notification 

and support account" on page 195. 
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10.8 Request lists 

After logging on, the first of the configured request lists opens. Via the lower navigation 

bar, users switch between request lists and change the list format 

 

As long as users are logged on, they may access this view by clicking on the Requests 

button in the upper navigation bar. 

The following features are available in request lists by default. Filtering and grouping can 

be turned off for each list in the configuration. 

 Sorting: Clicking a column header will sort the list by entries in this column. 

 Filtering: Entering a search term in the Filter field above a column will filter the list, so 

it only displays entries in which the search term appears in this column. 

 Grouping: Clicking a column header, dragging it to the grouping area above the list 

and dropping it there will group the list by entries in this column. Dragging the column 

header back into the result list will remove the grouping. 

 Views 

 Submitter: The access level specified for each contact in the Details tab determines 

whether the contact may see only his own requests, all requests from his company 

or all requests of all companies from the same company structure (see "2.6 Setting 

up access for Helpdesk online" on page 37). Via Views > Submitter, users may 

switch to lower access levels to hide requests from other companies or contacts. 

Additionally, requests from any address linked to the user's address via the Has 

ticket access link will be displayed starting with the All my company's requests 

access level (see "11.3.5 Links" on page 185). 

This setting will be preserved via a cookie (see UserSettings on page 128). 

 View: Via Views > View, users may change the list format. 

All formats entered in the configuration of a list will be available for selection here. 
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10.9 Detail view and actions 

Clicking a request's line in a request list opens the detail view. 

The following information about a request is displayed here if the associated fields have 

been entered. Empty fields are not displayed in the detail view. 

 Request, Solution and Notes 

 Number 

 Ticket type 

 Submitter and Customer 

 Status, Created on, Changed on and Priority 

 Product, Version and Area 

 Service agreement 

 Reference (Manufacturer), Reference (Submitter) 

 Documents: All documents linked to the request are displayed here. Clicking on the 

associated button will open or download the file. 

Clicking < will take the user back to the request list from which he opened the request. 

Via actions, requests can be edited in the detail view. 
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Available actions will appear in the lower navigation bar. 

An action can encompass the following steps. 

 Enter a comment (will be written in the notes field with date and time.) 

 Upload file(s) (will be linked to the request as documents and therefore appear in the 

dossier as well as in the request's detail view in Helpdesk online.) 

The maximum size is determined by the Maximum size of archive documents setting 

under Miscellaneous > Documents in the Management Console and may not exceed 

2 GB. Additionally, the MaxRequestLength and MaxAllowedContentLength IIS 

settings are considered here. If either value is smaller than the maximum size of archive 

documents setting, the maximum size is equal to the smaller one. 

Trying to upload a larger file will display the maximum size. 

 Change submitter 

 Change product version 

 Change priority 

 Change field values of the request; for example, change the status to complete a 

request, reopen a completed request or record another change of status. 

Each action will be written into the request's notes with a time stamp and the name of the 

portal user who has executed the action. 

Visualization of notes and editing of comments 

In the Mangement Console, you select one of two modes for notes visualization and 

editing of comments (see „Visualization of comments“ on page 156): 

 As chat (default): Formatting isn’t displayed and isn’t available when entering 

comments. The inidividual entries are visually grouped by author and point of time as 

dinstinguished by timestamps. 

An example of this display mode is shown on page 138. 

 As formatted content: Formatting is displayed and is available when entering 

comments. The individual entries in the notes field are grouped by author and point of 

time via timestamps only. 

An example for this display mode is shown on page 140. 
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Sending links for opening the detail view 

The TicketDetails.aspx page can also be opened directly via the following links 

display a request, replacing https://helpdesk.example.com/Helpdesk/ by your 

system's URL and {gguid} or {tsknumber} by the associated field value. 

https://helpdesk.example.com/Helpdesk/TicketDetails.aspx?gguid={gguid} 

https://helpdesk.example.com/Helpdesk/TicketDetails.aspx?ticketnumber={tsknumber} 

You can embed links to a ticket's detail view in e-mails regarding this ticket sent via ticket 

actions or by the notification and action service. How exactly links are embedded differs: 

 Ticket actions: Here, separate variables for links to the detail view and request for 

feedback are available in the e-mail editor under Response (see "Edit e-mail" on page 

31). This feature must be enabled by entering the link prefix in the Helpdesk area of 

the Management Console under Helpdesk online > General (see "Link" on page 155).  

 Notification and action service: Here you must insert the links as hyperlinks into the 

e-mails to send using the {gguid} variable (written in this fashion including the curly 

brackets). The Notification and action service only supports the {gguid} variable. The 

{tsknumber} parameter isn't supported here (see "12 Notification and support 

account" on page 195). 
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10.10 Creating a request 

When a request type is selected in the New request menu, a form opens for entering the 

new request of the selected request type. Exactly what can be entered here depends on 

the configuration of the request type. The following description includes optional entries. 

Note 

Users can filter any drop-down menus in the form like the customer, product and 

version selection by typing. Only menu options in which the entered search term 

appears will then be displayed. 

 

 

 This request is for: Via the Customer link, supervised customers can be assigned to 

partners in CAS genesisWorld (company to company). All customers assigned to the 

user's company this way are available for selection here. Additionally, any addresses 

linked directly to the user's address via the Has ticket access link are available (see 

"11.3.5 Links" on page 185). 

Customers blocked for support are never available for selection (see "2.5 Blocking 

support entitlement" on page 36).  

The customer selection will only appear if activated for the selected request type.  
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 Request information 

 Subject: Corresponds to the job field of the same name and is always mandatory. 

 Request: Corresponds to the job field of the same name and is always mandatory. 

 Additional information: Per request type, you may configurte up to two additional 

fields without associated job fields. In the error report example, the Reproduction 

instructions field has been configured as additional information field. The contents 

of these fields will be written into the notes when the ticket is created. 

Optionally, you can set both fields as mandatory. 

Additionally, one of both fields allows formatting if you have enabled this feature in 

the Management Console (see page 158)  

 Upload files: If configured accordingly in the request, users can upload files here. 

The maximum size is determined by the Maximum size of archive documents setting 

under Miscellaneous > Documents in the Management Console and may not exceed 

2 GB. Additionally, the MaxRequestLength and MaxAllowedContentLength IIS 

settings are considered here. If either value is smaller than the maximum size of archive 

documents setting, the maximum size is equal to the smaller one.  

When trying to upload a larger file, the maximum admissible size will be displayed. 

 Product information 

 All top level feature areas are available for selection as products in Helpdesk online. 

Additionnally, all subareas that have been linked with a product are available for 

selection as products (see "11.1 Settings in the Database area" on page 147). 

 With the Display only my products option, the Product menu will be filtered, such 

that only products for which the entered customer has an active product use will be 

available for selection (see "Start and end of maintenance" on page 58). 

This setting will be preserved via a cookie (see UserSettings on page 128). 

 When a product is selected, the Version and Area menus are displayed. Here users 

select the version in use and the affected feature area. 

 If there is at least one active product use for the selected customer and product, the 

Product use menu is displayed. If the selected customer has more than one active 

product use for the same product, the desired product use can be selected via the 

serial number. When a product use is selected, the version is entered automatically. 

 Request types with the Display only product uses and area setting require only the 

selection of a Product and Area, automatically selecting the appropriate Version 

and Product use (see "Requests" on page 156). With this setting, only products with 

existing product uses for the entered customer will be available for selection, such 

that customers without any product uses won't be able to select a product. 

 When the Enter parent product in the "Product" field option has been selected in 

the Management Console under Helpdesk > General, a product is also considered 
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as the customer's product if an active product use for another product which inherits 

the first product's versions exists for that customer. In this case, the Product use 

menu will also offer product uses for selection, whose products inherit the versions 

of the selected product. 

 Service agreement 

 The service agreement can not directly be selected in Helpdesk online. Depending 

on your settings, it will be entered automatically or selected indirectly by the user via 

the product use. 

 If the Select service agreement automatically option has been selected in the 

Management Console under Helpdesk > General, an existing service agreement 

will always be selected automatically if there is exactly one service agreement which 

matches the associated filter which you also enter in the Management Console 

under Helpdesk > General. If no filter has been defined there, service agreements 

are filtered by Maintenance start and Maintenance end like product uses, where an 

empty date field always satisfies the associated condition. In the Management 

Console, under Helpdesk > General, you also specify whether the customer's or the 

submitter's service agreement should be used when both differ. 

 Regardless of the Select service agreement automatically option, when a product 

use is selected, the associated service agreement is also entered automatically. Like 

for automatic selection, service agreements are filtered. An existing service 

agreement is only selected if it matches the filter. 

 Priority: Here users select the request's priority. 

When service agreements and response times are used, priority levels must be cleared 

in the service agreement to be available for selection. If submission permissions are 

also used and have been entered in the selected service agreeement, only priority 

which the user is permitted to submit will be available for selection. 

If no service agreement has been selected and response times are used, all priority 

levels that have been cleared for requests without a service agreement under Helpdesk 

> Service agreements will be available for selection. 

 The Response time depends on the priority and is taken from the selected service 

agreement. If no service agreement has been selected, the default response time for 

the selected priority for requests without a service agreement will be used. 

You enter it in the Management Console under Helpdesk > Service agreements. 

If the priority is displayed, the "Standard" suffix in the Priority field indicates that the 

default response time is used. 

 Reference (Submitter) and Reference (Manufacturer): If the request has already 

been recorded in other ticket systems, users may enter the associated numbers here. 
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10.11 User menu 

Clicking on the button labelled with the logged on user's name opens the user menu. 

 

The following options are available here. 

 Change password: Here the user changes his password. 

The minimum length will be checked if set in the Management Console (see "Activate 

password guideline for portal users" on page 155). 

 Log off: Here the user logs off. 

To continue working with Helpdesk online, he must log on again. 

If the Remember logon data option has previously been selected, the user name will 

be retained in the associated cookie such that it may be automatically entered when 

the user accesses the logon page again. 

The encrypted password will be deleted from the cookie. 

In order to log on again, the user must reenter his password. 
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10.12 Modifying the appearance 

The appearance of the individual Helpdesk online components is controlled via css files. 

You may find these in the css subdirectory of the installation directory of Helpdesk 

online (default C:\Inetpub\wwwroot\Helpdesk\css). 

Important notes for modifying the appearance 

Please do not modify files in the css folder. 

If you wish to modify the appearance of Helpdesk online, copy the css file(s) to modify 

to the Custom folder and modiy the copies as desired. 

If a version of a css file is found in the Custom folder, it will be loaded in addition to 

the associated original file. All elements defined in the css file in the Custom folder will 

be loaded instead of the elements of the same name in the original file. Elements that 

haven't been defined in the Custom file will still be loaded from the original file. If 

desired, you can delete unmodified elements from the copies. 

When you update to a more recent version of Helpdesk online, the contents of the 

Custom folder will be retained without changes. 

If the css files shipped by default should ever change due to an update, changes will 

only be adopted for elements that aren't overwritten by css files in the Custom folder. 

Please note that the css files have changed with version x9.  

Modifications you have created for older versions are no longer compatible with the 

new version and must be created again based on the new css files if required. 

 

 HelpdeskOnline.css: basic layout and components 

 Login.css: logon page 

 FAQList.css: FAQ search 

 GridView.css: request lists and FAQ list 

 DetailsView.css: request and FAQ item detail views 

 TicketCreate.css: new request form 

 Feedback.css: request for feedback 

 PasswordReminder.css: Forgot password page 

 ChangePassword.css: Change password page 
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10.13 Log file 

The log file for Helpdesk online is usually located in the following path on the computer 

on which the application is running: 

 C:\Windows\Temp\genesisWorld\itdesign\GWHelpdeskOnline.log 
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11 Management Console settings 

The following sections describe the Management Console settings for the Helpdesk 

module: 

 11.1 Settings in the Database area (page 147) 

 11.2 Settings in the Helpdesk area (page 148) 

 11.3 Settings in the Miscellaneous area (page 180) 

 11.4 Settings in the Time record area (page 187) 

11.1 Settings in the Database area 

In the Database area, you enter input helps for fields of requests (jobs) and other 

associated data records. Please note that the selection tree input help for the Area field of 

products is also used for requests (jobs) and FAQ items (documents). 

However, the available input help items can only be edited under Products: 

 

Via the Area field in the General tab of a product, you can assign a feature area to that 

product (see "5.1.1 General" on page 50). When you enter that area in a request or FAQ 

item, the product will also be entered automatically and vice versa. 

Area product assignments will be be converted when updating from a version before x9. 

In the Database area, you can also determine or change the types and status options used 

in Helpdesk for jobs (requests), projects, documents (FAQ items) and time records. 

To do this, first select the required data record type in the left hand side list. Then select 

the Type or Status field and click on the Input help button. 
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11.2 Settings in the Helpdesk area 

The following sections describe the settings in the Helpdesk area: 

 11.2.1 General (page 148) 

 11.2.2 Helpdesk online (page 154) 

 11.2.3 Hotline schedule (page 173) 

 11.2.4 Service agreements (page 174) 

 11.2.5 Tasks for tickets (page 176) 

 11.2.6 Groups (page 177) 

 11.2.7 Notification and languages (page 178) 

11.2.1 General 

Here you modify settings for tickets, for FAQ management, for notification, for time 

recording as well as for service agreements and product uses. 
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 Tickets: Here you specify default values for the ticket fields Type, Priority, Ticket type 

and Status as well as types for FAQ documents, support time records and projects. For 

support projects, you may also specify the subject prefix here. 

In addition, you make settings for the Responded on stamp, for ticket notes, for the 

FAQ search, for product uses and service agreements as well as for notifications and 

time records for tickets. 

You may edit the available options for all fields for which you may enter default values 

here in the Database module under Jobs (tickets), Documents (FAQ), Time records 

and Projects via the respective field list's Input help button. 

 Ticket types: Select here the job types to be used for tickets. When a ticket type is 

selected in a job, the Ticket tab is displayed in place of the General tab.  

In new tickets you create for other data records by clicking on the ticket icon, the 

first ticket type will automatically be selected. 

 Create tickets with priority: Select here the priority for new tickets. 

 Create tickets with ticket type: Select here the default value for the Ticket type 

field. 

 Status for accepted tickets: This status will be assigned to new tickets you create 

for other data records via the ticket icon. 

 Status for completed tickets: Select here the status to mark completed tickets.  

 "Error cause" field active for ticket type: In the default setting, the Error cause 

field displays the ticket type. Select here the ticket types for which an error cause 

may additionally be specified. 

 Do not set the "Responded on" field if status is changed to: In the default 

setting, a ticket's Responded on field will be set to the current point of time once 

the status is changed. In tickets created with an entry in the Status field, the 

Responded on field will be set directly when those tickets are created. 

Select here all status options whose assignment to a ticket is not supposed to create 

an entry in the Responded on field. 

For example, select the New status, if tickets created via Helpdesk online are created 

with this status in order to only set the Responded on field in such tickets when a 

support employee changes the status again. 

 Display serial number for product use: Here you control the display and storage 

format of the Product use ticket field in CAS genesisWorld Desktop and in CAS 

genesisWorld Web. In Helpdesk online, the serial number is displayed regardless of 

this option when selecting a product use. There, the new option only controls the 

storage format of the Product use field (with or without the serial number). 

 FAQ type: Select here the type for FAQ documents. When this type is selected in a 

document, the FAQ tab will be displayed instead of the General tab. 

 Time record type: Select here the type for time records in tickets. 
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 Project type: Select here the type for support projects under each of which all 

tickets for one customer will be collected. 

 Project subject: Specify here the prefix for support projects' subjects. The customer 

company will also be written in the subject. 

 Enter parent product in the "Product" field: With this option, when a product 

which adopts another product's versions is selected in a request, it is automatically 

replaced by the product whose versions it adopts. 

 Notes: Here you specify whether the Internal notes field is available in tickets. 

 Adopt notes from phone calls and e-mails: Here you determine whether, when a 

ticket is created for a phone call or an e-mail, the phone call notes or e-mail body 

will be transferred to the ticket's Notes or Internal notes field. 

 Create ticket to e-mail: Here you determine whether creating a ticket for an e-mail 

will enter the e-mail’s subject or body in the ticket’s Request field. Regardless of this 

setting, the e-mail subject will always be transferred to the ticket’s Subject field and 

the e-mail body will always be transferred to the ticket’s Notes or Internal notes 

field (see previous setting). 

 FAQ search: Here you modify FAQ search settings. 

Select Adopt product, version and area if these data should automatically be 

transferred to the FAQ search as a filter. 

Select Use MS SQL full text search to activate the full text search. When the SQL 

full text search is activated, it is initially assembled in the SQL server. All text fields in 

jobs and documents will be indexed. Depending on the number of data records to 

be indexed this may take up to several minutes. 

You can limit the number of hits for the purposes of accelerating search queries over 

large data pools with the Maximum hits setting. The number of hits will be 

displayed in the FAQ search. If more hits than the defined maximum were found, this 

is also indicated here. 

 Customer and submitter: Here you make settings for the customer and submitter in a 

ticket as well as for the customer links in product uses and service agreements. 

 Submitter link to ticket must exist: Here you specify whether a ticket must be 

linked to a submitter. This option is selected by default, such that the submitter link 

is mandatory. 

Deactivate this option to allow creating tickets for e-mails which have no primary 

address because the sender is unknown.  

This applies to manual ticket creation as well as automatic creation via a support 

account (see "12.6 Setting up a support e-mail account" on page 218).  

 Use the following e-mail address of the submitter as communication address: 

For tickets created without a submitter for inbound e-mails sent to the support 
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account (see "12.6 Setting up a support e-mail account" on page 218), the sender's 

e-mail address will be stored in the Communication field. 

Here you specify for tickets with a submitter link, from which address field the e-mail 

address should be entered in the ticket's Communication field.  

The default setting is Default e-mail  (as selected in the address). Alternatively, you 

may select an e-mail field. 

 Allow product uses for contact persons: Here you specify whether product uses 

may only be created for companies or also for contact persons. 

This option is deactivated by default. In this case, every product use created for a 

contact person will automatically be assigned to the associated company. 

 Allow tickets and service contracts for contact persons; adopt submitter as 

customer in ticket: Here you specify whether contact persons may be entered as 

customers in service agreements and tickets. With this setting, the submitter is also 

entered as customer when a ticket is created. 

This option is deactivated by default. This means that only companies may be 

entered as customers in service agreements and tickets. 

 Miscellaneous: Here you configure the automatic notification of the submitter about 

tickets newly created or modified in the Desktop Client or Web Client as well as the 

automatic time recording. 

 Select Display "Inform submitter about newly created ticket" prompt, if a 

prompt for notification should appear when a new ticket is created in CAS 

genesisWorld ("Do you wish to inform the submitter about the newly created ticket 

automatically?") 

If a user confirms the prompt when creating a ticket, the Notification change 

option will be set in the ticket. 

When the prompt is disabled, the Notification change option will not be set in new 

tickets and submitters will never be notified about them automatically. 

To set up notification by the notification and action service, you must specify a rule 

reacting to newly created jobs with this option (see "12.3 Notifying the submitter 

about changes in a ticket" on page 205). 

 Select Display "Inform submitter about changes" prompt if users should be 

prompted to confirm the submitter's notification when the notes or solution field 

changes in a ticket ("You have changed the notes or solution field. Do you wish the 

submitter to be informed automatically about the change?") 

If a user confirms the prompt when he saves a ticket, the Notification change field 

in the ticket will change (the field will switch between true and false during 

changes). 
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In the Desktop Client, when the prompt is disabled, the Notification change field 

will be changed with each modification made to the Notes or Solution field in a 

ticket, triggering a notification if an according rule has been set up. 

In the Web Client, no notification will ever be triggered without the prompt. 

To set up notification by the notification and action service, you must specify a rule 

reacting to changes in this field in jobs (see "12.3 Notifying the submitter about 

changes in a ticket" on page 205). 

 With the Only notify if an e-mail address is entered for the submitter option, if a 

change occurs that triggers an e-mail notification, the field E-mail (business) in the 

submitter's address will first be checked. If it is empty, a note will appear stating that 

no e-mail address has been entered. The ticket will not be marked for notification. 

If you turn the option off, the submitter's e-mail address will not be checked before 

a ticket is marked for notification. Changes about which the submitter could not be 

notified due to the lack of an e-mail address will appear in the action service's log. 

 Select Use automatic time recording for tickets to display the stop watch in the 

top right corner of the Ticket tab. By clicking on the associated button the ticket is 

saved and closed and a time record is created for it. 

 Use service agreements, response deadlines and submission permissions: Here you 

specify whether, and how, service agreements are used in ticket management. 

 Display service agreement: Here you specify whether the Service agreement field 

is displayed in the ticket. 

 Filter for service agreements: Here you specify filter conditions for the ticket's 

Service agreement field. The filter is also considered in Helpdesk online. 

If you don't specify a filter here, all service agreements available for the customer will 

be available for selection in the ticket form in CAS genesisWorld. 

Helpdesk online uses a default filter which will apply if you don't specify a filter here. 

A service agreement which is associated with a selected product use will then only 

be selected if it is already valid (Start of maintenance >= "Today") and not yet 

expired (End of maintenance < "Today"). If either of these date fields is empty, the 

associated condition is also considered to be fulfilled. If both date fields are left 

blank in a service agreement, it is indefinitely valid. 

 Use service agreement of customer for different customer: With this setting, 

when the submitter doesn't belong to the same company as the customer, all service 

agreements of the customer will be available for selection. 

 Use service agreement of submitter for different customer: With this setting, 

when the submitter doesn't belong to the same company as the customer, all service 

agreements of the submitter's company as well as service agreements of associated 

contacts will be available for selection. 
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 Select service agreement automatically: With this option, whenever there is only 

service agreement available for selection in a ticket, it will be selected automatically. 

 Response deadline from service agreement: Here you determine whether a 

response deadline depending on the priority will be displayed in tickets. 

With this option selected, the Response time tab will be displayed in service 

agreements. Here you can record response deadlines for tickets subject to the 

service agreement.  In addition, you may specify default values for tickets without a 

service agreement (see "11.2.4 Service agreements" on page 174.) 

 Submission permissions from service agreement: Here you determine whether 

the selection of priority levels available in a ticket may be limited depending on the 

submitter via the service agreement. 

With this option selected, the Contact persons tab will be displayed in service 

agreements. Here you select contact persons entitled to submit tickets and assign to 

each contact person the priority levels with which he may submit tickets. 

In tickets for service agreements with submission permissions, only priority levels for 

which the submitter has been approved in the service agreement will be selectable.  

In tickets for service agreements for which no submission permissions have been 

entered, all priority levels are always available. 
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11.2.2 Helpdesk online 

Here you modify settings for logging on, for new requests, for ticket actions, for request 

lists as well as for the FAQ search in Helpdesk online. 

 General (page 154) 

 Requests (page 156) 

 Lists (page 166) 

 Detail view (page 169) 

 FAQ (page 170) 

 Personal area (page 172) 

General 

In the General tab, you specify the displayed name of the service portal and enter the link 

for the service portal in order to use variables for links to the detail view of a ticket or to 

the request for feedback page in ticket actions. Moreover, you make general settings for 

logging on to Helpdesk online. 
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 Portal start page 

 Title: Here you enter the title of the service portal to display on the logon page 

(default setting Helpdesk online). 

 Link: Here you enter the internet link to your Helpdesk online installation, if you 

wish to use the associated variables in e-mails for ticket actions (see "Subject and 

body" on page 32). 

 Logon and registration 

 User name: Here you select an address field which serves as user name to log on to 

Helpdesk online. 

In the default setting, the E-mail (business) field is used. 

The field title is displayed on the logon page. 

You enter the associated password in the Details tab of the data record window for 

company contacts and individual contacts. 

Note 

When a user logs on to Helpdesk online via the specified user name, addresses stored in 

CAS genesisWorld are searched for an entry in which the given user name is stored in 

the associated field and the password as well as the tickets to display are taken from 

that address. 

Therefore, you should absolutely select a field as user name which stores only values 

unique to each address. Users with duplicate user names will not be able to log on. 

 

 Information for access lock: Enter here the note which appears if a contact who 

has been blocked for support tries to log on to Helpdesk online (see "2.5 Blocking 

support entitlement" on page 36). 

 Activate password guideline for portal users: Select this to activate password 

requirements, then select the desired requirements. 

 Minimum length 

 Require capital letters 

 Require lowercase letters 

 Require digits 

 Require special characters 

This setting is regarded when setting or changing the password for an address in the 

CAS genesisWorld Desktop client as well as in Helpdesk online when customers set 

or change their own passwords. 
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 Visualization of comments: Here you control the edit and display mode for comments 

in Helpdesk online. 

 Display comments as chat (without formatted content): This is the default 

setting. With this setting, formatting in the Notes field won’t be displayed in 

Helpdesk online and won’t be available when entering comments. In this mode, the 

notes will be displayed in Helpdesk online with a graphical grouping by author and 

point of time. 

 Display comments as formatted content: This setting is available after selecting 

the Allow formatting option for the Notes field of Jobs in the Database area of 

the Management Console. In this mode, formatting in ticket notes will be displayed 

and available when entering comments in Helpdesk online. 

The graphical grouping by author and point of time isn’t available in this mode. This 

information is given in the time stamp which is automatically inserted when 

someone enters a comment in Helpdesk online.  

Requests 

In the Requests tab, you define different kinds of requests, each with an individual 

preselection of the most important ticket fields, as well as ticket actions available to users 

of Helpdesk online. 
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 Requests: In the upper list, you enter request types which will be available for selection 

in the New request menu in Helpdesk online. For each request type, you specify which 

entries the Helpdesk online user can make for it. You also enter preselections for other 

ticket fields that the user can't see or edit in Helpdesk online. 

 Create new request: Here you create a new request type. 

 Edit request: Here you edit the selected request type. Alternatively, you can open a 

request type for editing by double-clicking on the associated list entry. 

 Duplicate request: Here you create a copy of the selected request type. 

 Delete request: Here you delete the selected request type. 

 Edit order: Use the arrow buttons to modify the order of request types. The request 

types are displayed in the same order in the New request menu in Helpdesk online. 

 

 Name: The request type is listed under this name in the New request menu in 

Helpdesk online. 

 Description: Enter here notes for the request type. The description is displayed in 

the header oft he associated online form when requests of this type are entered.  
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 Primary project: Specify here whether requests of the current type should be linked 

to the support project of the submitter's company (Use support project settings), 

or to another project linked to the submitter's company or one of its contacts (Use 

own project selection). 

 With the Use own project selection setting, all projects whose primary address is 

the submitter's company or an associated contact are added to the selection first. 

You can use the Filter to limit the selection, for example to only display projects 

whose end date is in the future or which have a certain type or status. 

 With the Define sorting for primary projects setting, you specify the order in 

which suitable projects are offered for selection in Helpdesk online. When the 

project selection is disabled for the current request type, the first project in the 

configured sorting is automatically entered. 

 Display: The Display tab in the request type configuration offers optional entries 

and information for selection: 

 The Additional information 1 and 2 fields serve for additional entries. They will 

be written into the ticket's notes field under the respective title defined here for 

requests of the current type. 

You may configure both of these fields as Mandatory. 

You may also Use the HTML editor for one of the two fields if formatting is 

allowed for the Notes field of jobs and has been enabled for comments in 

Helpdesk online in the General tab of the associated settings (see page 156). 

 With the Upload file option, you specify whether a file upload dialog should 

appear when a request is created. If desired, specify field values with which 

uploaded files should be created as documents in CAS genesisWorld under 

Document defaults. This way you ensure that the documents match the 

associated filter and will be displayed in Helpdesk online once uploaded. 

 With the Customer selection option, partners are offered all of their serviced 

customers for selection in addition to their own company when submitting a 

request. This requires that the companies of a partner's customers have been 

entered in CAS genesisWorld and are linked to the partner's company via the 

Partner/Customer link. 

 The Project option displays the project selection in the request. All projects 

defined under Primary project are offered for selection here. This option serves 

to enter project requests as opposed to support tickets. If you have set up 

requests of the current request type to be linked to the support project, this 

setting is usually not required because there is only one support project per 

submitting company. 

 Select the Priority option to allow the user to select a request's priority. 

Alternatively, you can specify the priority for new requests under Default values. 

If you activate selection of the priority in Helpdesk online under Display and also 
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specify the priority of new requests under Default values, the selected 

preselection will be entered in the Priority field in Helpdesk online when a 

request is entered.  

When response times are used, the selection in the Priority field will be limited 

by the service agreement or by the default settings for tickets without a service 

agreement (see "Priority" on page 18). 

 With the Product option, you activate the selection of a product and area. 

In Helpdesk online, all first level areas will be available for selection as products.   

Additionally, all subareas linked with a product in the Management Console will 

be available for selection as products (see "5.1.1 General" on page 50).  

You may also set each the Product and Area as a Mandatory field here. 

With the Display only product uses and area option, instead of selecting the 

product and version independently, both are selected via a product use. 

Please note that this setting requires that product uses have been entered for a 

customer in order to select a product in associated requests. 

 When you have activated response deadlines under Helpdesk > General > Use 

service agreements, response deadlines and submission permissions in the 

Management Console, you may display the valid response deadline in the request 

with the Respond until (read-only) option. 

The response deadline depends on the priority and is taken from the selected 

service agreement. 

If no service agreement has been selected, the response deadline is taken from 

the default settings for tickets without a service agreement. This is indicated by 

the (Standard) suffix in the Priority field. 

 The Reference (Submitter) and Reference (Manufacturer) fields serve to enter 

ticket numbers from the system of the submitter or manufacturer of the affected 

product. If, for example, a partner who operates an own Helpdesk system submits 

the request of a customer which he cannot solve on his own, he enters the ticket 

number from his system for reference in the Reference (Submitter) field. 

 Default values: In the Default values tab, you select field values with which 

requests of the current type are created. 
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 You may only select a value in the Type field if multiple ticket types are used. 

This may be used to tell tickets creted via Helpdesk online from such submitted 

through other channels. 

 You can use the entry in the Status field to tell new tickets created via Helpdesk 

online apart from tickets submitted through other channels. 

Specify a status which is only used in Helpdesk online for this (e.g., New).  

You may analyze the response duration by excluding this status from updates of 

the Responded on field (see "Do not set the "Responded on" field if status is 

changed to" on page 149). 

 Specify the request type in the Ticket type field. In the default setting, only the 

Question, Error and Improvement items will be available for selection here. 

You may create further items in the Database area of the Management Console 

under Jobs as input help items for the Ticket type field.  

 The Error cause field is available for selected items in the Ticket type field, in the 

default setting for the Error request type. Any other items in the Ticket type field 

will be repeated in the Error cause field, which can't be changed in this case. 

 Enter the default priority for requests of the current type in the Priority field. 
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If you have selected the Priority option in the Display tab, you specify here the 

preselection of the Priority menu in the request.  

When response times are used, the selection in the Priority field is limited by the 

service agreement or by the default settings for tickets without a service 

agreement (see "Priority" on page 18). Please note that not all values available 

here will always be available for selection in Helpdesk online as well in this case.  

 The Team, Employee, Responsible team and Responsible employee fields 

serve to preselect the responsibility. 

Enter here groups and, if desired, users, responsible for new requests of the 

current type. Please note that if you select nothing here, tickets will be created 

with the All (public) entry in the Participants field and will thus be visible for all 

employees who have at least reading access to jobs. 

 Filter: In the Filter tab, you may limit access to this request type by selecting users 

(addresses with access to Helpdesk online), for which it should be available via filter 

conditions. The request will then no longer be available for selection for other 

Helpdesk online users. 
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 Actions: In the lower list, you specify which actions will be available in a request's detail 

view in Helpdesk online. For each action, you specify via filters for which requests it will 

be available and enter changes in ticket fields made by the action. You also specify 

whether the user can enter a comment and upload a file when executing the action in 

Helpdesk online. 

 Create new action: Here you create a new action. 

 Edit action: Here you edit the selected action. Alternatively you can open an action 

for editing by double-clicking on the associated list entry. 

 Duplicate action: Here you create a copy of the selected action. 

 Delete action: Here you delete the selected action. 

 Change order: Use the arrow buttons to modify the order of actions. The actions 

are displayed in the same order in a request's detail view in Helpdesk online. 

 

 Name: The action will be listed under this name in a request's detail view in 

Helpdesk online. 

 Description: Enter notes for the action here. When the action is executed, the 

description will be displayed in the header of the associated online form. 

 Filter: Select here via entries of the Type, Ticket type and Status fields, for which 

requests the action is available. Via Filter for Helpdesk users, you may limit access 

to selected users (addresses with access to Helpdesk online). 
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 Change field values: Here you specify target values set by the action for each of the 

fields Type, Status, Ticket type, Error cause, Priority, Team, Employee, 

Responsible team and Responsible employee. 

Select the <No change> option for all fields that should not be changed by the 

action. 
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 More steps: Here you specify which entries the user can make when executing the 

action in Helpdesk online. 

 

 With the Show dialog to enter a comment option, the user can enter a 

comment when executing the action, which will then be written in the request's 

notes. 

Also select the Allow saving only for a filled-in commentary field option to 

make the comment mandatory.  

 With the Show dialog to upload files option, the user can upload an arbitrary 

number of files when executing the action, which will be stored as documents in 

CAS genesisWorld and linked with the request. If desired, specify field values with 

which uploaded files should be created as documents in CAS genesisWorld under 

Document defaults. This way you ensure that the documents match the 

associated filter and will be displayed in Helpdesk online once uploaded. 

Also select the Only allow saving if a file has been selected option to make the 

file upload mandatory. 

 With the Show dialog to change the submitter option, the user can change the 

request's submitter when executing the action. All active contacts of the logged 

on user's company will be available for selection. 
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 With the Show dialog to change the product version option, the user can 

change the product version when executing the action. For this, a product must 

have been specified in the request. 

 With the Show dialog to change the priority option, the user can change the 

request's priority when executing the action. When response times are used, the 

selection in the Priority field is limited by the service agreement or by the default 

settings for tickets without a service agreement (see "Priority" on page 18). 

When submission permissions are also used, only priority levels which the logged 

on user is permitted to submit will be available for selection. Please note that not 

the submission permissions of the entered submitter but those of the logged on 

user are considered here. 
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Lists 

In the Lists tab, you define list formats and list views. 

List formats determine the selection of fields and sorting of the associated list. A list view 

can use one or more list formats. If more than one list format has been assigned to a list 

view, Helpdesk online users can switch between the available list formats when the list 

view is selected. 

In the properties of a list view, you select the used list formats and determine, via a job 

filter, which tickets will be displayed. 

Additionally, a project filter is available here in order to define project request lists. 

With the default setting for the project filter in a new list, Use support project as 

filter, only support tickets will be displayed. 

 

 Available list formats for list views: Here you define list formats, each of which 

specifies the selection of fields and sorting of the associated lists. 

 Create new list format: Here you create a new list format. 

 Edit list format: Here you edit the selected list format. Alternatively you open a list 

format for editing by double-clicking on the associated list entry. 

 Duplicate list format: Here you copy the selected list format. 

 Delete list format: Here you delete the selected list format. 
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 Name: Name the list format here. The name serves to assign the list format to lists 

and will be displayed in the list format menu in Helpdesk online if more than one list 

format has been assigned to a list. 

 Field selection: Select the desired fields here. Use the arrow buttons above the 

Selected fields list to define the field order. Specify the desired width for each field 

in the Width field. Please note that these entries will be translated into relative 

values in Helpdesk online and the specified width can therefore differ from the 

actual value. 

 Click on the Sorting button to select an arbitrary number of sorting fields. Note that 

sorting fields don’t need to be visible. For each sorting field, you determine whether 

the sorting will be ascending or descending. Use the arrow buttons above the list of 

sorting fields in order to specify the sorting order. 

 Date fields: Specify here whether date fields are displayed with only the date or with 

the time of day as well. 
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 List views available online: Here you define list views, the properties of which specify 

the tickets to display via a filter as well as the list formats to use. 

 Create new list view: Here you create a new list view. 

 Edit list view: Here you edit the properties of the selected list view. Alternatively 

you open the properties of a list view by double-clicking on the associated list entry. 

 Duplicate list view: Here you copy the selected list view. 

 Delete list view: Here you delete the selected list view. 

 Change order: Use the arrow buttons to modify the order of list views. The list views 

will be displayed in the same order in the navigation bar in Helpdesk online. 

 

 Caption: Name the list view here. The list will be available for selection under this 

name in the navigation bar in Helpdesk online. 

 Filter: Enter here filter conditions for the requests to display. 

 Project filter: Lists with the default setting Use support project as filter display 

requests linked to a support project. Alternatively, you select projects for which 

requests should be displayed via filter conditions. 
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 Filter for Helpdesk users: Here you may limit access to this list to selected users 

(addresses with access to Helpdesk online). 

 List: Here you specify how many entries will be displayed per page and whether 

users can filter and group in the list in Helpdesk online. Enter 0 in the Number of 

entries per page field in order to always load all entries. 

 Allocated list formats: Here you select the list formats to use. If you have selected 

more than one list format, use the arrow buttons above the Allocated list to define 

the order in which list formats appear in the associated menu in Helpdesk online. 

Detail view 

In the Detail view tab, you specify whether a service agreement, if linked to a request, 

should be displayed in the request's detail view and whether users may download 

associated documents in a request's detail view. 

 

 Display service agreement informationen online: Determine here whether the detail 

view of a request should display the associated service agreement if there is one. 

 Make documents referring to requests available online: Specify here whether 

documents linked to a request should be available for download in the request's detail 

view. Additionally you can define a filter to only make linked documents available if 

they match the filter conditions. 
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FAQ 

In the FAQ tab, you configure the FAQ search in Helpdesk online. 

 

 FAQ status for search without logon: Here you determine, by selecting one or more 

status options, which FAQ documents will be available without logging on to Helpdesk 

online. If you do not select any status options here, the FAQ search will not be available 

without logging on. 

 FAQ status for search with logon: Here you determine, by selecting one or more 

status options, which FAQ documents will be available after logging on to Helpdesk 

online. All status options selected under FAQ status for search without logon are 

automatically selected here as well. If you don't select any status options in either FAQ 

status selection box, the FAQ search will not be available at all in Helpdesk online. 

 Fields available for search: Here you determine which fields of the FAQ documents 

are going to be searched. 

 Enable online selection of fields: Specify here whether users may select the fields 

to search in Helpdesk online. 

 Fields shown in hit list: Here you select the fields with which FAQ documents will be 

displayed. Use the arrow buttons above the Selected fields list to specify the order. 

Enter the desired width for each field in the Width field. 

Please note that these entries will be translated into relative values in Helpdesk online 

and the specified width can therefore differ from the actual value. 

 Default sort order in hit list: Here you select by which fields and in which order 

(ascending or descending) the FAQ list in Helpdesk online will be sorted by default. 
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 Date fields: Specify here whether date fields are displayed with only the date or with 

the time of day as well. 

 Initial FAQ search view: Here you determine whether the latest FAQ documents will 

be displayed when opening the FAQ search. 

To this end, enter the desired number of FAQ documents to display. The FAQ 

documents with the newest entry in the Date field will be displayed.  

Select 0 if no FAQ entries should be displayed when opening the FAQ search. 

 Number of hits after FAQ search: Specify here how many FAQ entries will be 

displayed at most after a search request. If less FAQ entries are found, only the found 

entries will be displayed. 

Select 0, if all entries should always be displayed. 

 Options available for the hit list: Here you determine whether users may filter and 

group in the result list of the FAQ search in Helpdesk online. 

 Language filter for FAQ entries: Here you specify whether a language selection will 

be displayed for the result list of the FAQ search. With this, the list may be filtered by 

the Document language field of FAQ documents. The filter will be available regardless 

of whether the Document language field is actually displayed in the result list. 

 Documents referring to FAQ document: Specify here whether documents linked to 

an FAQ document should be available for download in Helpdesk online. Additionally, 

you can define a filter in order to only make linked documents available which match 

the filter conditions. 
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Personal area 

In the Personal area tab, you can include any internet page as a separate section in the 

navigation of Helpdesk online. This way, you can display news of your company or a portal 

page like the CAS help page (http://hilfe.cas.de/index-en.html). 

 To do this, enter a Title and URL. 

You can enter the title in multiple languages via the button with the three dots. 

The URL can not be entered depending on the language. 

 Select Use as start page after logon if Helpdesk online should start with this view. 

With this setting, the personal area will be the first section. 

Without this setting, it will be the last section. 

 

http://hilfe.cas.de/index-en.html
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11.2.3 Hotline schedule 

You enter hotline schedules for calculating response deadlines. 

In a service agreement, you specify a hotline schedule for each priority level alongside the 

maximum response time. The actual deadline at which a response is due will be calculated 

from the duration and hotline schedule. 

Example 

A request is submitted on Friday at 16:30. A response deadline of one day and four 

hours is entered. With the hotline schedule displayed in the screen shot, a response is 

due Monday by 12:00. 

 

 

New: Here you create a new hotline schedule. The new hotline schedule will 

automatically be selected to edit. 

 Delete: Here you delete the selected hotline schedule. You are asked for confirmation 

prior to deletion. 

 Save: Here you save the selected hotline schedule. 

 Select schedule: If you work with different hotline schedules, select the desired hotline 

schedule in the left toolbar menu. 

 Change granularity: In the right toolbar menu, you select the smallest distinguishable 

interval: quarter hours, half hours or hours. 

 Enter schedule: Select a period with the mouse and click Working hours to signify 

support entitlement or click Free time to delete a marking you have entered. 
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11.2.4 Service agreements 

If you have selected the Use response deadline option under Helpdesk > General, you 

clear priority levels for requests without a service agreement and enter response deadlines 

and hotline hours for them here. 

In this case, you also select here the country and federal state whose holidays should be 

regarded when calculating the response deadline for requests without a service 

agreement. These are also the default settings for new service agreements. 

When response deadlines are used, you also preselect here the priority levels for new 

service agreements and enter presettings for response deadlines and hotline hours for 

them. 

Regardless of the Use response deadline option, you enter here presettings for the 

Maintenance rate field in new service agreements depending on the Maintenance 

interval selected by the user in the service agreement. You also specify here whether the 

maintenance amount should automatically be calculated when a service agreement is 

opened. 

You may enter different presettings for different kinds of service agreements, which you 

may distinguish via the Service level field. 

 

 Default settings for tickets without a service agreement: Here you select available 

priority levels for tickets without a service agreement and enter response deadlines and 

hotline hours for the selected priority levels. 

 Response deadlines and hotline hours: To clear a priority level and enter a 

response deadline and hotline hours for it, select the desired priority level from the 

Priority menu and click Add. As in the service agreement's Response times tab, a 

separate row for entering the response deadline and hotline hours will be inserted. 
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Enter the maximum response time as well as the applicable hotline hours. 

 Display hotline hours: Here you open a view of the selected hotline hours. 

 Remove priority level: Here you remove the priority level from the selection. It 

will no longer be available for requests without a service agreement. You may 

clear the priority level again at a later time. 

The entries for the job's Priority field are stored as input help items. You may edit it 

in the Database module of the Management Console. 

 Include holidays when calculating response deadlines: Specify here for which 

country and federal state public holidays should be accounted for in the response 

deadline. These are also the presettings for new service agreements. If and when 

support is available on public holidays, is specified in the hotline hours. 

 Default by service level: Here you specify presettings for new service agreements. 

Different types of agreements are distinguished via the Service level field. 

 Service level: Select here from the input help items for the Service level field the 

kind of service agreement for which you wish to enter presettings.  

 Response deadlines and hotline hours: You may enter presettings for response 

deadlines and hotline hours here as for tickets without a service agreeement. 

 Maintenance billing: Via the Maintenance interval menu you switch between the 

billing intervals stored for service agreements. Month, Quarter and Year are 

available for selection. Specify the desired maintenance rate in percent for the 

selected service level and billing interval. 

 With the Automatically calculate maintenance fee option, a service agreement's 

Maintenance charge and Contribution margin fields will automatically be updated 

when the Maintenance tab is opened and the user has sufficient permissions. 

Please note that this is a global setting and doesn’t depend on the service level. 
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11.2.5 Tasks for tickets 

Here you enter settings for tasks which you create for a ticket by clicking on the task icon 

next to the Request field in the Ticket tab. 

 

 Mapping of ticket types and task type/status: Here you enter presettings for type 

and status of tasks for tickets. You may specify a different type and status for each 

ticket type. 

 Transfer primary link to task: With this setting, the ticket for which a task is created 

will automatically be set as the new task's primary link. 
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11.2.6 Groups 

Here you configure the assigment of tickets to ticket and handover teams. 

 

 Include groups: Select here the groups that should be available as support teams or as 

responsible teams. 

 Teams: Select here the groups that should be available as support teams (first level 

support). 

 Responsible teams: Select here the groups that should be available as responsible 

teams (second level support). 

 Default team: Here you specify a preselection of the support team for each user. 

If a user for whom a support team has been preselected creates a ticket in CAS 

genesisWorld, his user name and the associated support team will be selected 

automatically. 

 Set first group as preselection group: Click this button to select the first available 

entry as preselection for every user. 
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11.2.7 Notification and languages 

Here you select the system e-mail account to use for ticket actions and Helpdesk online as 

well as the languages available for ticket actions and Helpdesk online. 

Moreover, you determine here for which service levels and priorities an internal 

notification should occur before a request’s response deadline is met and how many hours 

and minutes before that participants of the request should be notified. 

 

 E-mail account settings: Here you select the system e-mail account to use for ticket 

actions and Helpdesk online, which you set up under Server settings in the Rules area. 

 Language settings 

 Under Available languages, you select the languages to be used for ticket actions 

and Helpdesk online from all installed client languages. 

 All languages selected here will be available on the Helpdesk online logon page if 

a CAS genesisWorld client with the associated language resources has been 

installed on the computer on which Helpdesk online is operated. 

 The name and description of actions which are displayed to support employees in 

the client can be entered in all client languages selected here. 

 E-mail templates defined in actions can be entered in all languages selected here. 

When an action is executed, associated e-mail templates will be available in every 

language in which they have beeen entered. 

 E-mails sent via ticket actions default to the Default language for ticket actions. 

 Helpdesk online defaults to the browser language, English, database language, or 

first available language, in this order, depending on availability. If a user logs on 

again and the language cookie was saved and not deleted, the previous selection 

will be retained (see "10.4 Invocation and language selection" on page 129). 
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 Time of escalation for tickets: Here you determine for which service levels and 

priorities an internal notification should occur before a request’s response deadline is 

met and how many hours and minutes before that participants of the request should 

be notified. 

Via the Without service level option in the Service level menu, you can enter 

notification times for requests without a service agreement. 

The point of reference for the notification is always the response deadline of the 

respective request. 

The actual point of notification depends on the service agreement’s hotline time for the 

request’s priority. 

For tickets without a service agreement, the respective hotline time is also considered. 

Example 

If a request’s response deadline expires on Monday at 8:00 and a notification has been 

configured 5 hours before for the service level of the associated service agreement and 

the request’s priority, with a hotline time from 8:00 to 16:00 from Monday to Friday, the 

notification e-mail will be sent as soon as the previous Friday at 11:00. 

 

 Under Service level, select the desired service level first. 

For requests without a service agreement, select the Without service level option. 

 Via the check box in a Priority’s row, you determine whether users should be 

notified about expiring response deadlines of requests with that priority. 

 Then, under Time of escalation before the response deadline expires, enter the 

desired period before the deadline expires to determine the respective point of 

notification. 

 In order for the notification to occur, you must also configure a notification rule of 

the Deadline exceeded event type, which checks the Escalation time field, as 

described in section "12.5 Internal notification about expiring response deadlines" 

on page 215. 

 Another requirement is the configuration of the notification service under Rules > 

Server settings in the Management Console. You may learn more about this from 

the online help or the Administrator manual. 
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11.3 Settings in the Miscellaneous area 

The following sections describe the Helpdesk module settings in the Micellaneous area: 

 11.3.1 Activities (holidays for service agreements) (page 180) 

 11.3.2 Currencies (page 181) 

 11.3.3 Dashboards (page 182) 

 11.3.4 E-mail (page 183) 

 11.3.5 Links (page 185) 

 11.3.6 Products (page 186) 

11.3.1 Activities (holidays for service agreements) 

The country and federal state of a service agreement control which holidays are excluded 

when calculating the response deadlines of associated tickets. 

A fixed selection of countries with federal states is always available. You can view the list in 

your Settings in CAS genesisWorld under Calendar > Public holidays. 

You can add holidays for other countries and federal states by importing .hol files in the 

Miscellaneous area of the Management Console under Activities > Calendar. 

 

After restarting the server, these will be available in a service agreement’s Country field as 

well as in the associated presettings in the Management Console. 

Federal states can’t be added to the Federal state field. You can only add them as 

separate entries of the Country field. 



Helpdesk   Management Console settings 

181 

11.3.2 Currencies 

You may enter currencies in the Miscellaneous area, under Currencies.  

All list items will be available for selection in all currency fields in CAS genesisWorld. 

You also determine the system's Base currency here. 

This is the presetting for currency fields in CAS genesisWorld. 

To convert foreign currencies to the base currency in reports, in formula fields and in 

board views in CAS genesisWorld Web, enter conversion rates here. 

Enter the conversion rate from the base currency to any foreign currency to convert as 

Exchange ratio Euro to Currency, regardless of which currency you are using as base 

currency. For example, if you are using GBP as base currency and wish to convert CHF, edit 

CHF and enter the conversion rate for GBP to CHF (e.g., if 1 GBP = 1.2 CHF, enter 1.2). 

For the base currency itself, enter 1 as Exchange ratio Euro to Currency. 

 

Please note that you can no longer change the Base currency after selecting the 

Maintain different prices for products option under Miscellaneous > Products. 
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11.3.3 Dashboards 

Use customer dashboard reports to process and clarify information from data records. 

You can find the associated configuration in the Miscellaneous area of the Management 

Console, under Dashboards > Customer dashboard. 

In the Definition tab, you create customer dashboard definitions. 

In the Assignment tab, you assign your definitions to the desired data record windows.  

 

For details about the possibilities and configuration of customer dashboards, see the 

Report module user guide. 
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11.3.4 E-mail 

In the Miscellaneous area, under E-mail > Archived e-mails > Link archived e-mails, 

you configure the key for the subject line of e-mails that should be linked with the 

associated ticket automatically when they are archived. 

 

Proceed as follows to create a new linking rule for e-mails belonging to tickets: 

 Click New… to create a new linking rule. 

 Select Job as Data record type. 

 If you submit support inquiries to partners who are also using Helpdesk, enter a Prefix 

in the associated field to tell your system apart from your partner's. 

This way, you can avoid your partner's replies being accidentally associated with tickets 

in your system which happen to have the same number. 

 Select Number as Field. Alternatively, you may select a different matching field. 
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When creating and editing the rule, the Preview field will display the correct format for 

the key in the subject line. 

The correct format is also displayed in the Format column in the list of linking rules. 

With the example from the screenshot, an e-mail with the sequence "#CAS: 123#" in the 

subject would automatically be linked to the ticket with the number 123 when it was 

archived. 

Enter the key defined here in the subject of e-mails created for tickets via ticket actions 

(see "2.4 Ticket actions" on page 23), via e-mail templates (see "4 Using e-mail templates" 

on page 47) and via the notification service (see "12 Notification and support account" on 

page 195) in order to link these e-mails and responses to them with the associated ticket 

automatically when the e-mails are archived.  

Please note that a blank space is automatically inserted before the selected field. That 

blank space must also be entered in the subject line to assign an e-mail to the associated 

ticket. 
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11.3.5 Links 

In the Miscellaneous area, under Links, you can create the Has ticket access link to give 

Helpdesk online users access to tickets submitted by specific companies and individual 

contacts. 

Linking a Helpdesk online user's address to a company or individual contact via the Has 

ticket access link will display tickets submitted by the linked company or individual 

contact for that user in Helpdesk online in addition to the tickets he may see according to 

his access level (see "2.6 Setting up access for Helpdesk online" on page 37). 

Tickets submitted by linked addresses will be displayed in Helpdesk online starting with 

the Company requests access level. 

The user may also create requests for the linked address in Helpdesk online when the 

customer selection is active. 

To do this, first create the link under Miscellaneous > Links. 

The link must have the following properties: 

 

 Internal name: L2UEXTHDOACCESS 

 Data record type A: Addresses 

 Data record type B: Addresses 

 Type: directed 

 Cardinality: m:n 

 Link name: Has ticket access 

 Reversed link name: Grants ticket access 
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11.3.6 Products 

In the Miscellaneous area, under Products, you enter settings for products, product uses, 

tickets and service agreements. 

 

The following settings on this page relate to Helpdesk features: 

 Products for opportunities, items, product uses and tickets: Here you can see and 

change the product filter for opportunity product items, project items (with Project), 

receipt items (with Easy Invoice) as well as product uses and tickets. 

With the default filter, all products selected as Active will be available.  

 Maintain different prices for products: By default, you may only enter exactly one 

sales and purchase price in exactly one currency for each product. Here you activate or 

deactivate the entry of sales and purchase prices for products in different currencies. 

The price information entered for a product and currency will automatically be adopted 

to associated product uses created for service agreements with that currency. 

 Change set currency of the item at a later time: Here you determine whether the 

currency of an existing service agreement can be changed via the Tools menu. When 

changing the currency, you may retain prices, set the to zero or enter a conversion rate.  
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11.4 Settings in the Time record area 

The following sections describe the settings in the Time record area: 

 11.4.1 General (page 187) 

 11.4.2 Mandatory links (page 189) 

 11.4.3 Calendar (page 190) 

 11.4.4 Hourly rates (page 191) 

 11.4.5 Working hours (page 193) 

11.4.1 General 

 

 Duration of a person day: Here you specify how many hours and minutes should be 

subsumed under one person day. The default setting is 8 hours. 

 Granularity: Here you select the smallest recordable interval for the Actual and 

Charged fields. No smaller interval may be selected for Charged than for Actual. 

 1 second, 1 minute, 5 minutes, 10 minutes, 15 minutes, 30 minutes, 1 hour 

 Overlap check: Here you enable or disable the overlap check for time records. 

 Bill externally: Here you specify whether users may edit the external billing date. In 

this case, users are prompted to enter the desired billing date when externally billing 

time records via the context menu of the time record list. 

 Time window for the creation and editing of time records 

 Maximum to be recorded for future: Time records whose end time is further in 

the future than specified here may not be saved. 

 Maximum to be recorded for past: If the start of a time record to create is further 

in the past than specified here, it may not be saved. 
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 Change time records of the past: If the start of an existing time record is further in 

the past than specified here, changes made to it may not be saved. 

 No restriction for: Select here users to exempt from the specified restrictions. 

 Calculate total: Here you specify whether the total work time for a project, job or 

service agreement is calculated whenever time is recorded for it. Time records for 

associated tickets are considered for service agreements. The actual work time will be 

written in the Actual time field. The order value will be written in the Charged field.  

Note 

The fields are updated whenever time records for projects, jobs or tickets belonging to a 

service agreement are created or deleted. The fields are not updated when the link for 

an associated data record is changed (e.g., when a ticket is removed from a service 

agreement by resetting the service agreement selection in the ticket). 

With the Form Designer module, you can define business ratio fields that are updated 

automatically whenever the associated data record is opened. 

Additionally, you can create new project, job and/or service agreement fields of the float 

type as target fields in the Database area of the Management Console and enter them 

as target fields for the business ratio fields. If you do, you can use scheduled updates to 

update these fields regularly automatically (e.g., nightly or hourly) or update them 

manually via the context menu (requires the Actions: execute other right). 

Create the following business ratio fields for projects and/or jobs respectively: 

1. Linked data record type: Time records / Calculation: Actual / Sum 

2. Linked data record type: Time records / Calculation: Charged / Sum 

To save the results in target fields you have created for projects and/or jobs, select them 

under Save result in field for the respective business ratio fields. 

Under Data records, select the Only primary links link type. 

Under Formatting, select the Duration (person days) or Duration (24h/day) format. 

For service agreements, you need a two level business ratio field. First, create Actual/ 

Target business ratio fields with associated target fiels of the float type for jobs as 

described above. Then, create the following business ratio fields for service agreements: 

1. Linked data record type: Jobs / Calculation: (Actual target field) / Sum 

2. Linked data record type: Jobs / Calculation: (Charged target field) / Sum 

Then, enter the same settings as described above for projects and jobs (Save result in 

field, link type and format). 

 

 Time record type for travel time: Select here the time record type for recording the 

trips to and from the destination for appointments in CAS genesisWorld Web and CAS 

genesisWorld Desktop. 
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11.4.2 Mandatory links 

Here you define mandatory links for time record types. 

 

 Mandatory link: Select here the desired data record type. 

 Specify filter condition: Click on the filter icon to specify filter conditions. 

 Participant: If you select the P option, the time record's participant must also be a 

participant of the linked data record to save the time record. 

Groups are not resolved here. Only if a user has directly been entered as the 

participant of a data record, he can record time for it. 

 Information: Enter here a message to display when a user tries saving a time record 

which is not linked as specified here. 

Here you enter the message in different languages. 

Example 

To limit use of the time record type Support to tickets, select the data record type Job 

in the associated row. Limit time recording to tickets using the following filter condition: 

Type – is equal – Ticket. If desired, add filter conditions for more ticket types and for 

the desired status opens (e.g., Status – is not equal – Completed, to restrict time 

recording to tickets which have not yet been completed.) Select the P option if only a 

ticket's participants may record time for it. 

Enter an expressive message to display when the rule is violated in the Information 

field (e.g., "You may only create time records of the 'Support' type for your tickets.") 
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11.4.3 Calendar 

Here you configure the time record calendar's multiple recording feature. 

 

 Automatic time recording for appointments, phone calls and holiday: Here you 

select appointment, holiday and phone call types for which time should automatically 

be recorded when clicking on the associated button in the calendar. With teamWorks, 

holidays are distinguished by the Holiday type field, if there are no types for holidays. 

To lock the recording of certain types or holiday types, select the data record type for 

which you wish to modify the setting. Then carry over the entries for which time should 

not automatically be recorded to the right list. 

 Time record type and projects by participant […]: Select here projects in which 

leaves taken by their respective participants will be recorded. When a participant of a 

project selected here records a leave in the calendar, the time records will be booked 

on the project. 

 Search project: Here you select a project in the Search window. Via the list you may 

open, view and edit it. 

 Remove: Here you remove a project from the selection. 

 Time record type for holiday: Specify the type for holiday records here. 
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11.4.4 Hourly rates 

Here you specify global hourly rates. They are valid for all customers and projects for 

which you do not specify different hourly rates. 

Entering different hourly rates for specific customers and projects is described in section 

"6.1.6 Defining hourly rates for addresses and projects" on page 92. 

 

 Allow to enter internal hourly rates for addresses and projects: By default, you may 

only enter different external hourly rates for addresses and projects. Select this option 

in order to also enter different internal hourly rates for addresses and projects. 

 Save: Here you save changes made to the hourly rates in the database. 

Close the view without saving to revert changes. 

 Transfer hourly rates: Here you overwrite the displayed hourly rates, Internal or 

External (see below), with the hourly rates from the other view. This includes emptying 

fields that are empty in the other view. 

 After confirmation, the changes will be displayed in the view. 

 The changes will only be applied to the database when they are saved. 

 Close the view without saving to revert changes. 

 Select participants: Here you select the users and resources to display. Users and 

resources for which internal or external hourly rates have already been entered will 

automatically be selected when you open the view. When a user or resource is 

removed, associated hourly rates will be retained. 

  Internal and External: The Internal and External tabs are structured identically. 

 Internal: Here you specify internal hourly rates. Billing a time record internally will 

determine the internal hourly rate for the user/resource and activity (time record 

type) and multiply it with the Actual work time to calculate the Actual costs. 
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 External: Here you specify external hourly rates. Billing a time record externally will 

determine the external hourly rate for the user/resource and activity (time record 

type) and multiply it with the Charged order value to calculate the Actual turnover. 

 Entering hourly rates: The white table fields are provided for entering hourly rates 

valid for exactly one user or resource and one activity (time record type). The yellow 

fields are provided for entering hourly rates valid for users, resources and activities for 

which no other hourly rate was specified. 

 General hourly rate: Enter the general hourly rate in the first field of the table in the 

top left corner. It will be valid for all table fields and thereby for all users, resources 

and activities (time record types) for which no other hourly rate is specified. 

The general hourly rate will show up in all of these fields in italics. 

 Hourly rates for users and resources: Enter hourly rates for users and resources in 

the first column. Each of these will be valid for all table fields of the associated row 

and thereby for all activities (time record types) for which no other hourly rate is 

specified. 

The hourly rate will show up in all of these fields in italics.  

 Internal hourly rates for users and resources take precedence over internal hourly 

rates for activities (time record types). 

 External hourly rates for users and resources are only valid for activities (time 

record types) for which no other hourly rate was specified. 

 Hourly rates for activities (time record types): Enter hourly rates for activities 

(time record types) in the first row. Each of these hourly rates is valid for all table 

fields of the associated column and thereby for all users and resources for which you 

have not specified another hourly rate. The hourly rate for the type will show up in 

all of these fields in italics. 

The hourly rate will show up in all of these fields in italics.  

 Internal hourly rates for activities (time record types) are only valid for users and 

resources for which no other hourly rate was specified. 

 External hourly rates for activities (time record types) take precedence over 

external hourly rates for users and resources. 

 Hourly rates for a user/resource and activity (time record type): Enter hourly 

rates for specific users or resources and for specific activities (time record types) into 

the respective white table field in which the row for the user or resource and the 

column for the activity (time record type) intersect. 

Such hourly rates in white table fields take precedence over any other hourly rates 
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11.4.5 Working hours 

Here you record a log of working hours for employees and a log of availability hours for 

resources. 

 

 Views and Features for logged working hours: The following features consider the 

working hours you enter here. For employees for which you do not enter working hours 

here, the working hours you enter in your user settings in the Calendar tab are used 

instead. 

 Planner (interactive): This view displays working hours entered here in its Gantt 

view and in its workload view, and calculates the workload based on them. You must 

enter Resource availability hours here to display them in the view. 

 Time recording: In the time record calendar and in the data record window for time 

records, the working hours you enter here are considered. 

 Resource planning in the tree view: The tree view's resource planning view 

displays working hours entered here and calculates the workload based on them. 

 Report [Report module]: In Report views for time records, for which you have 

activated working hours calculation in the User data tab in the view's properties, the 

working hours you enter here are used. 

Note 

For users and resources for which you enter working hours here, the interactive planner 

view, the time record calendar, the tree view's resource planning view and report views 

will display no working hours before the first working hours period you enter. 

 

 Select user or resource: Select a user or resource in the menu to the top left to view 

the working or availability hours. 
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Create working hours period: Here you create a new working hours period. You will 

be prompted to enter the desired start date for the new working hours period. The day 

before the start date of the following working hours period will be automatically 

entered as end date. If no working hours period follows, the end date is left blank. Enter 

the working hours in the view's lower half (see "Edit working hours"). 

 Change start date: Here you change the start date of the selected working hours 

period. Alternatively, you may change the start date by double-clicking a list entry. 

 Delete working hours period: Here you delete the selected working hours period. You 

will be prompted to confirm the deletion. 

 Edit working hours: In the view's lower half, you enter the desired working or 

availability hours. 

 Granularity: Select the granularity in the menu at the top right of the lower toolbar 

(Hour, Half hour, Quarter hour, 5 minutes or Minute). 

 Working hours: Using your mouse, select the desired working hours in the week 

view and click Working hours to enter them. 

 Free time: To remove working hours you have already entered, select them using 

your mouse and click Free time. 

Please note that working hours entered for public holidays will only be applied when 

the public holiday is on a week day with working hours. For example, if no working 

hours are entered for Sundays, public holidays on a Sunday are also considered free, 

even if working hours have been entered for public holidays.  

The working hours you enter will be transferred directly to the list of working hours 

periods and saved. 

 Save working hours template: Here you save the working hours you have entered in a 

template to transfer them to other users or resources. 

 Select working hours template: In the left menu of the lower toolbar, you may select 

a template to transfer the working hours stored in it to the list entry you have selected 

in the upper list. Changes made to the displayed working hours will be saved in the 

user's working hours as well as in the template. 

 Delete working hours template: Here you delete the selected working hours 

template. You will be prompted to confirm the deletion. Deleting a working hours 

template has no effect on working hours created from that template. 
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12 Notification and support account 

The following sections describe how to set up rules to notify customers about their 

Helpdesk online account activation, to notify submitters about new and changed tickets, 

for the request for feedback about completed tickets and for the notification of the team 

about requests whose response deadline is about to expire. 

Additionally, setting up a support e-mail account is described. For e-mails sent to this 

account which can't be associated with an existing ticket via an archiving rule, new tickets 

will automatically be created. 

 12.1 Helpdesk online account enabling notification (page 195) 

 12.2 Notifying the submitter about a new ticket (page 201) 

 12.3 Notifying the submitter about changes in a ticket (page 205) 

 12.4 Setting up a request for feedback (page 209) 

 12.5 Internal notification about expiring response deadlines (page 215) 

 12.6 Setting up a support e-mail account (page 218) 

The sections about external notifications also describe how you mark e-mails sent due to 

the rule with the ticket number and optional prefix in the subject line, such that these e-

mails and replies to them will automatically be filed with the respective request (see 

"11.3.4 E-mail" on page 183).  

You can enter the desired rules under Rules in the Management Console or in the Rules 

tab of the Settings window in CAS genesisWorld (Administrator rights required). 

The notification service must be configured under Rules > Server settings in the 

Management Console. You may learn more about this from the online help or the 

Administrator manual. 

12.1 Helpdesk online account enabling notification 

Proceed as follows to notify customers about enabling of their Helpdesk online accounts. 

Via the link included in the notification, the customer may request an activation link which 

will be sent with another e-mail in order to confirm the customer's identity. He can then 

enter his password to activate his account. 

To enable an account, select the associated Helpdesk online access level in the address 

record's Helpdesk online field. You can do this for any company or individual contact in 

the Details tab or for multiple contacts via an Action (see section "2.6 Setting up access 

for Helpdesk online" on page 37 for details). 

In both cases, the contacts will be notified via the rule you are about to create. 

Execute the following steps to created that rule: 

 Click New to create a new rule. 
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 Enter a meaningful name (e.g., Helpdesk online account activation). 

 Click Filter and Team. 

 Select filter conditions for each access level, connected with or, embraced by brackets: 

Helpdesk online – is identical with – [Access level] (see screenshot). 

 Make sure that contacts who have already activated their accounts won't be requested 

to activate their account again. To do this, connect another condition with and: Assign 

Helpdesk online password – is identical with –  

 

 Click OK to confirm. 

 In the Event type menu, select Data record change. 

 Select the Creating new data record event. 

 Select the Changing data record event. 

 Click on the Setting button next to the Any change to the following fields option. 

 Select the Helpdesk online field, then click OK to confirm. 
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The following settings should be visible in the Event tab: 

 

 Switch to the Action tab. 

 In the Action menu, select Notification. 
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 If desired, click on the Selection button next to the Sender field to change the e-mail's 

sender or recipient of replies. 

 Click on the Selection button next to the Variable recipients field. 

 Under E-Mail addresses from fields, select the E-mail (business) field. 

 Select the Archive e-mail to monitored adddress after sending. 

 

 Click OK to confirm. 

 Remove yourself from the permanent recipients if you do not wish to receive copies of 

all notifications about new requests. To do this, click on the button with the icon of a 

red cross next to the Permanent recipients section. 

 Enter the subject line and body text for the e-mail in the lower section. 
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 Insert the following link to the activation page: 

https://helpdesk.example.com/Helpdesk/Activation.aspx 

Replace https://helpdesk.example.com/Helpdesk/ by your Helpdesk online 

system URL. 

On the activation page, customers can confirm their identities via e-mail after which 

they may enter their password to finalize the activation. 

The following settings should be visible in the Action tab:  

 

 Confirm the creation of the new rule by clicking OK. 

 Confirm the activation of the new rule by clicking Yes. 
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Notes 

The notification and action service must be correctly set up and running in order to 

send e-mails. 

The rule will be triggered whenever a contact with access to Helpdesk online is created 

or an appropriate access level is selected for an existing contact. 

When the customer activates his account in Helpdesk online, the Helpdesk online 

password entered field will be set in the associated address data record. 

The filter by this field in the notification rule makes sure that rule won't be triggered 

again when the access level is changed via the Helpdesk online field. 

If desired, you may notify customers with active access to Helpdesk online when the 

access level is changed. To do this, filter as described above, but with Assign Helpdesk 

online password – is identical with – . Don't test for created data records but only 

for changes of the Helpdesk online field. 
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12.2 Notifying the submitter about a new ticket 

You set up a rule for notification of the submitter about a new ticket as follows. 

The message will only be created after the user's confirmation (see notes at the end of this 

section). 

 Click New to create a new rule. 

 Enter a meaningful name (e.g., New ticket). 

 Select the Job data record type. 

 Click Filter and Team. 

 Select the filter condition Notification change – is identical with –  

 

 Click OK to confirm. 

 In the Event type menu, select Data record change. 

 Select the Creating new data record event. 
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The following settings should be visible in the Event tab: 

 

 Switch to the Action tab. 

 In the Action menu, select Notification. 

 If desired, click on the Selection button next to the Sender field to change the e-mail's 

sender or recipient of replies. 

 Click on the Selection button next to the Variable recipients field. 

 Under E-Mail addresses from linked addresses, select Only the following link types. 

 Select the Ticket (submitter) link type: 
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 Click OK to confirm. 

 Remove yourself from the permanent recipients if you do not wish to receive copies of 

all notifications about new requests. To do this, click on the button with the icon of a 

red cross next to the Permanent recipients section. 

 Enter the subject line and body text for the e-mail in the lower section. 

If e-mails sent via the rule and replies to them should be linked with the associated 

ticket when the e-mails are archived, enter the key defined in the Management Console 

into the subject line (see "11.3.4 E-mail" on page 183). 

Please note that a blank space must be entered before the key field (e.g., when no 

prefix was defined and Number was selected as field, the key is "# Number#"). 
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 If you are using Helpdesk online, you can embed a link to the new ticket's detail view in 

the e-mail. To do this, enter the desired link text and connect it with one of the two 

following links using the e-mail editor's hyperlink fuction. 

https://helpdesk.example.com/Helpdesk/TicketDetails.aspx?gguid={gguid} 

Replace https://helpdesk.example.com/Helpdesk/ by your Helpdesk online 

system URL. 

The following settings should be visible in the Action tab:  

 

 Confirm the creation of the new rule by clicking OK. 

 Confirm the activation of the new rule by clicking Yes. 
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Notes 

The notification and action service must be correctly set up and running in order to 

send e-mails. 

The rule will be triggered whenever a user creates a ticket and confirms the prompt "Do 

you wish to inform the submitter about the newly created ticket automatically?" Then 

the Notification change option, by which the rule filters, will be set in the ticket. 

If you turn off the Display "Inform submitter about changes" prompt option under 

Helpdesk > General in the Management Console, the Notification change option will 

never be set in a new ticket. 

In this case, the rule described in this section (new job with Notification change = 

true) will never be triggered. 

12.3 Notifying the submitter about changes in a ticket 

You create a rule for notifying the submitter about changes in his ticket as follows. 

 Click New to create a new rule. 

 Enter a meaningful name (e.g., Ticket changed). 

 Select the Job data record type. 

 In the Event type menu, select Data record change. 

 Select the Changing data record event. 

 Click on the Setting button next to the Any change to the following fields option. 

 Select the Notification change field, then click OK to confirm. 

.  
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The following settings should be visible in the Event tab: 

 

 Switch to the Action tab. 

 In the Action menu, select Notification. 

 If desired, click on the Selection button next to the Sender field to change the e-mail's 

sender or recipient of replies. 

 Click on the Selection button next to the Variable recipients field. 

 Under E-Mail addresses from linked addresses, select Only the following link types. 

 Select the Ticket (submitter) link type: 
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 Click OK to confirm. 

 Remove yourself from the permanent recipients if you do not wish to receive copies of 

all notifications about new requests. To do this, click on the button with the icon of a 

red cross next to the Permanent recipients section. 

 Enter the subject line and body text for the e-mail in the lower section. 

If e-mails sent via the rule and replies to them should be linked with the associated 

ticket when the e-mails are archived, enter the key defined in the Management Console 

into the subject line (see "11.3.4 E-mail" on page 183).  

Please note that a blank space must be entered before the number (e.g., when no prefix 

was defined and Number was selected as field, the key is "# Number#"). 
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 If you are using Helpdesk online, you can embed a link to the ticket's detail view in the 

e-mail. To do this, enter the desired link text and connect it with the following link 

using the e-mail editor's hyperlink fuction. 

https://helpdesk.example.com/Helpdesk/TicketDetails.aspx?gguid={gguid} 

Replace https://helpdesk.example.com/Helpdesk/ by your Helpdesk online 

system URL. 

The following settings should be visible in the Action tab:  

 

 Confirm the creation of the new rule by clicking OK. 

 Confirm the activation of the new rule by clicking Yes. 
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Notes 

The notification and action service must be correctly set up and running in order to 

send e-mails. 

The rule will be triggered whenever a user confirms the prompt "You have changed the 

notes or solution field. Do you wish the submitter to be informed automatically about 

the change?" Then the Notification change switch, by which the rule filters, will be set 

in the ticket. 

If you turn off the Display "Inform submitter about changes" prompt option under 

Helpdesk > General in the Management Console, the Notification change option will 

always be set in a ticket, whenever one of the fields Notes and Solutions changes. 

The rule described in this section (change of Notification change in a job) will then be 

triggered whenever either of these two fields changes. 

 

12.4 Setting up a request for feedback 

You set up the automatic request for feedback as follows. 

 Click New to create a new rule. 

 Enter a meaningful name (e.g., Request for feedback). 

 Select the Job data record type. 

 In the Event type menu, select Data record change. 

 Select the Changing data record event. 

 Select the Specific change of a field value option and click on the Setting button 

next to it. 

 Select Status – is identical with – Completed (if you have selected another status for 

completed tickets under Helpdesk > General, enter that status here. You can only 

check for exactly one target status in a rule. If you have selected more than one status 

option as completion status and wish to send a request for feedback for each of these 

options, you must enter a separate rule for each completion status): 

 

 If the specified job status is also used for jobs which are not completed tickets, enter a 

filter condition under Filter and Team (e.g., Type – is identical with – Ticket). 
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The following settings should be visible in the Event tab: 

 

 Switch to the Action tab. 

 In the Action menu, select Notification. 

 If desired, click on the Selection button next to the Sender field to change the e-mail's 

sender or recipient of replies. 

 Click on the Selection button next to the Variable recipients field. 

 Under E-Mail addresses from linked addresses, select Only the following link types. 

 Select the Ticket (submitter) link type: 
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 Click OK to confirm. 

 Remove yourself from the permanent recipients if you do not wish to receive copies of 

all requests for feedback. To do this, click on the button with the icon of a red cross 

next to the Permanent recipients section. 

 Enter the subject line and body text for the e-mail in the lower section. 

 If e-mails sent via the rule and replies to them should be linked with the associated 

ticket when the e-mails are archived, enter the key defined in the Management Console 

into the subject line (see "11.3.4 E-mail" on page 183). 

Please note that a blank space must be entered before the key field (e.g., when no 

prefix was defined and Number was selected as field, the key is "# Number#"). 

 Enter a link text and embed the following hyperlink: 
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https://helpdesk.example.com/Helpdesk/feedback.aspx?gguid={gguid} 

Replace https://helpdesk.example.com/Helpdesk/ by your Helpdesk online 

system URL. 

The following settings should be visible in the Action tab: 

 

 Confirm the creation of the new rule by clicking OK. 

 Confirm the activation of the new rule by clicking Yes. 

Notes 

The notification and action service must be correctly set up and running in order to 

send e-mails. The rule will be triggered whenever a user saves a ticket after closing it by 

selecting the status checked by the rule. 
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Alternatively, you can send a link to the request for feedback via a ticket action (see 

"Edit e-mail" on page 31). 

You can edit the available options via the input help for the Satisfaction job field in the 

Database area of the Management Console. 

 

12.4.1 Request for feedback in Helpdesk online 

The link in the notification about the request for feedback leads to a page in Helpdesk 

online where the user can specify his satisfaction. 
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After clicking Enter feedback the user will receive a confirmation. 
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12.4.2 Satisfaction in CAS genesisWorld 

In CAS genesisWorld, the answer is displayed in the ticket's Satisfaction field. 

If the user has also entered a comment, it will be displayed in the ticket's notes. 

 

12.5 Internal notification about expiring response deadlines 

You set up a rule for the internal notification of a ticket's participants about a response 

deadline that is about to expire as follows. 

 Click New to create a new rule. 

 Enter a meaningful name (e.g., Ticket escalation). 

 Select the Job data record type. 

In the default setting (without any filters), the internal notification occurs for all tickets for 

which a notification has been configured in the Helpdesk area of the Management 
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Console under Notification and languages, depending on the service level and priority. 

(see "11.2.7 Notification and languages" on page 178). 

 If the internal notification should only occur for a subset of these tickets, click Filter 

and team to filter by field values and participants and/or click Filter by links to filter 

by links and enter the respectively desired filter conditions. 

 Under Event type, select the Deadline exceeded event. 

 Select the Escalation time field. 

The following settings should be visible in the Event tab:  

 

 Switch to the Action tab. 

 In the Action menu, select Notification. 

By default, the e-mail account used by the notification service will be specified as sender. 

 If desired, click on the Selection button next to the Sender field to change the e-mail's 

sender or recipient of replies. 
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 Remove yourself from the permanent recipients if you do not wish to receive copies of 

all notifications triggered by the rule. To do this, click on the button with the icon of a 

red cross next to the Permanent recipients section. 

 Enter the subject line and body text for the e-mail in the lower section. 

 Under Attachments, select the GBT file of the data record concerned in order to 

attach a link file for opening the ticket. 

The following settings should be visible in the Action tab: 

 

 Confirm the creation of the new rule by clicking OK. 

 Confirm the activation of the new rule by clicking Yes. 
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Notes 

The notification and action service must be correctly set up and running in order to 

send e-mails. 

The rule will be triggered at the point of time before the expiration of the response 

deadline that has been configured for the ticket's service level and priority (see "11.2.7 

Notification and languages" on page 178.) 

 

12.6 Setting up a support e-mail account 

The following section describes setting up a support e-mail account. 

This account is set up to automatically archive inbound e-mails in CAS genesisWorld. 

If possible, the archived e-mail will be associated with an existing ticket via an archiving 

rule based on its subject. You may enter archiving rules for e-mails in the Miscellaneous 

area of the Management Console under E-mail (see "11.3.4 E-mail" on page 183). 

For each e-mail sent to this account which can't be associated with an existing ticket, a 

new one will automatically be created. 

Like when manually creating a ticket for an archived e-mail, the e-mail subject will be 

transferred to the ticket's Subject field. The e-mail body will be transferred to the ticket's 

Internal notes or Notes field, depending on your settings. Additionally, the e-mail subject 

or body will be entered as the new ticket's Request, also depending on your settings.  

The e-mail's sender will be entered in the Communication field.  

If the e-mail address has been entered for an address record in CAS genesisWorld, that 

address will also be linked as Submitter. The associated company or, if the address is an 

individual contact or if company contacts are allowed as customers, the same address will 

then also be entered as Customer and as primary address. In this case, the new ticket will 

also be linked to the associated support project via a primary link. If that project doesn't 

already exist, it will be created with a primary link to the customer address. 

Notes 

Please note that tickets can only be created without an address link if this has been 

enabled in the Management Console (see "Submitter link to ticket must exist" on 

page 150). 

To send automatic notifications as described in sections 12.2 and 12.3 of this chapter to 

recipients for which no address record exists in CAS genesisWorld, instead of the 

submitter link, select the Communication field under E-mail addresses from fields as 

recipient. 

When a submitter’s address is linked to a ticket, their e-mail address will automatically 

be entered in this field. 
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When you set up a support account, you may also select a Team to which the tickets 

created this way wull be assigned. This way, separate support accounts for different 

support teams are possible. Additionally, you specify here the status for the new tickets. 

Optionally, you also select a status for existing tickets for which a new inbound e-mail is 

archived. 

 Rights and licenses: Users must have a Helpdesk license assigned to configure support 

accounts. In addition, users also need the Helpdesk: Is allowed to register own e-

mail accounts right. This right is activated in the Management Console > User 

management area > Properties window > Other rights tab. 

 Setting up a support account in the CAS genesisWorld Desktop Client: The support 

account is set up, like any e-mail account, in the E-mail tab of the Settings window.  

Activate the Automatic update and notify option and the Logon to server 

automatically option so that tickets can be created for new e-mails automatically. 

 

 After creating the new e-mail account, double-click its list item to open the account 

properties and activate the Support account option in the General tab: 
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 Click Templates and select an archiving template. 

 Archived e-mails can automatically be marked as read. 

 Select the support team to which to assign tickets created via this support account. 

 Determine the status presetting for new tickets. 

 If the status of an existing ticket should automatically be changed when an e-mail is 

archived for that ticket, select the Change the status for existing tickets option. Then, 

determine the desired status. 

 Click OK to confirm your configuration of the new support e-mail account. 
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